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Overview 
This guide contains installation and setup information for the staff at your company who maintain the 
hardware and software required to install Deltek PM Compass. 

 
 

Attention: For more complex topics related to the PM Compass deployment, including HTTP 
compression, reverse proxies, and integrated security, see the Deltek PM Compass Advanced 
Administration Guide. 
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If You Need Assistance 
If you need assistance installing, implementing, or using PM Compass, Deltek makes a wealth of 
information and expertise readily available to you. 

Customer Services 
Deltek has always maintained close relationships with client firms, helping with their problems, listening to 
their needs, and getting to know their individual business environments. A full range of customer services 
has grown out of this close contact, including the following: 

 Extensive self-support options through the Deltek Support Center. 

 Phone and email support from Deltek Customer Success analysts 

 Technical services 

 Consulting services 

 Custom programming 

 Classroom, on-site, and web-based training 

You can find out more about these and other services from the Deltek Support Center. 

Deltek Support Center 
The Deltek Support Center is a support Web site for Deltek customers who purchase an Ongoing Support 
Plan (OSP).  

The following are some of the many options that the Deltek Support Center provides: 

 Search for product documentation, such as release notes, install guides, technical information, 
online help topics, and white papers 

 Ask questions, exchange ideas, and share knowledge with other Deltek customers through the 
Deltek Support Center Community 

 Access Cloud-specific documents and forums 

 Download the latest versions of your Deltek products 

 Search Deltek’s knowledge base 

 Submit a support case and check on its progress 

 Transfer requested files to a Deltek Customer Success analyst 

 Subscribe to Deltek communications about your products and services 

 Receive alerts of new Deltek releases and hot fixes 

 Initiate a chat to submit a question to a Deltek Customer Success analyst online 

 
Attention: For more information, see the online help on the Deltek Support Center site. 

https://deltek.custhelp.com/
https://deltek.custhelp.com/app/Site_Help
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Access Deltek Support Center 

To access the Deltek Support Center:  
1. Go to http://support.deltek.com/.  

2. Enter your Deltek Support Center Username and Password. 

3. Click Login. 

 

Note: If you forget your username or password, you can click the Need Help? button on the login 
screen for help. 

http://support.deltek.com/
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Downloading Deltek Products using Deltek 
Software Manager 
You can use Deltek Software Manager (DSM) to download complete Deltek products, hot fixes, 
cumulative updates, and sub-releases. You can access DSM through the Deltek Support Center or use 
Deltek Software Manager Lite to download Deltek products. 

Accessing DSM Lite 
To access Deltek Software Manager Lite: 

1. In your Web browser, go to https://dsm.deltek.com/DeltekSoftwareManagerLite.  

2. Enter your Deltek Support Center Username and Password and click Logon. 

3. When the Deltek Software Manager Lite page displays, select a product from the drop-down list. 

4. Click the product type that you want to download.  

What to Download 
Download the following: 

 The PM Compass installer (DeltekPMCompass85CumulativeUpdate<version>.exe)  

 The Deltek PM Compass Sample Databases.zip file 

 The Deltek PM Compass API installer 

 The Deltek Open Plan AddIn installer 

 All available documentation 

 

Accessing DSM from within the Deltek Support Center 
To access DSM from within the Deltek Support Center: 

1. In your Web browser, go to https://deltek.custhelp.com.  

2. Enter your Deltek Support Center Username and Password and click Login. 
3. When the Deltek Support Center page displays, click Product Downloads. 

4. On the Deltek Software Manager screen, click Launch Deltek Software Manager. 
5. Click Settings at the top right of the dialog box to use the Settings dialog box to specify the folder 

where you want to download Deltek products and click OK.  

 

Note: Check the latest Cumulative Update Release Notes for information on compatible and tested 
Cobra and Open Plan products. 

Note: When you log on for the first time, DSM asks you to select a default folder where 
Deltek products are to be downloaded. 

You can change this folder anytime in the Settings dialog box. 

https://dsm.deltek.com/DeltekSoftwareManagerLite
https://deltek.custhelp.com/
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6. In the left pane, expand the Deltek product that you want to download, if it is not already 
expanded, and select the file to download. 

7. In the table, select the option that corresponds to the Deltek product that you want to download.  

The right pane displays a message stating that the product has been added to the download 
queue. 

 
8. Click Download at the bottom of the left pane to download the product to the folder that you 

selected.  

Subscribe to a Product Version in DSM 
You can subscribe to a product in DSM so that you get an email every time an update is posted. You 
must subscribe to each version for which you want to receive email notifications. For example, you must 
subscribe separately to PM Compass 8.1 and PM Compass 8.2 if you want email notifications for both 
versions of the product. 

To subscribe to a product in Deltek Software Manager (DSM): 
1. Log into DSM. 

2. Click Settings in the top right corner of the window. 

 
3. Scroll down to the product and version for which you want notifications and select the Email 

option. 

 
4. Click OK. 

When an update is posted, you will receive an email with the product name and release details and a 
Download link that launches Deltek Software Manager with the release pre-selected. 

DSM Documentation and Troubleshooting 
 To view the online help for Deltek Software Manager, click here. 

 To view a tutorial on how to use Deltek Software Manager, click here.  

 To view more information on troubleshooting Deltek Software Manager, click here. 

Note: To view the items in the download queue, click View Download Queue at the bottom 
of the left pane. 

Select to receive 
product update 

email notifications 

https://dsm.deltek.com/DeltekSoftwareManager/Help/
https://deltek.custhelp.com/app/answers/detail/a_id/50668
https://deltek.custhelp.com/app/answers/detail/a_id/52469
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License Information  
When you download PM compass installation files from the DSM Lite or the DSM, an email containing the 
installation password and your license information are sent to your email address. Instructions on how to 
enter the license information are documented in Post-Installation Steps. 

Note: When you click a link, you will be asked to log into DSM if you are not already logged in. 
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Before You Begin Deployment 
Before you begin deployment, it is important to understand the following: 

 Hardware and Software Requirements 

 Logical Tiers 

 Database Requirements  

 Reporting Services 

Hardware and Software Requirements 
This section covers the hardware and software requirements for deploying PM Compass. 

 

Deltek Cobra and Open Plan 
Before upgrading, you must have Cobra and Open Plan upgraded to a supported version. 

 
Deltek recommends that you make a backup of your production database before installing PM Compass.  

To install a test version of PM Compass into a database that is not a production database, you have two 
options: 

 Copy the production database to a new database and confirm that Cobra and Open Plan are 
working correctly when connected to the new database. Then, install PM Compass into the new 
database. This method has the advantage of retaining all security, saved reports, projects, and 
other relevant data. 

 Install PM Compass into a new database and then restore the Cobra projects into the database.  

If you upgrade Cobra or Open Plan after the PM Compass installation, download the sub-release 
integration installer for either Cobra or Open Plan, and install the integrations. 

Logical Tiers Overview 
PM Compass uses multitier architecture. Various components of the PM Compass application are 
distributed to logical tiers for performance and scalability. Multiple tiers can exist on the same server. 

The logical tiers are as follows:  

 Client Tier: This is PM Compass’ user interface layer. It presents data to the Application/Web 
server tier. PM Compass uses the ClickOnce deployment technology to check for new updates 
on the Web/Application server each time the application is launched, the necessary client files are 
automatically installed into the local user’s profile (%USERPROFILE%\Local Settings\Apps\2.0\... 
). 

Attention: Prior to proceeding with the installation, see “Appendix A: System Requirements” in this 
guide for a comprehensive overview of the software and hardware requirements. 

Note: Check the latest Cumulative Update Release Notes for information on compatible and tested 
Cobra and Open Plan products. 
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 Web/Application Server Tier: This tier performs PM Compass' functional process logic. After a 
request is sent by the client tier, this tier processes that request (such as retrieving stored data or 
performing a specific function) and then returns the result to the client tier. This tier also uses IIS 
to host the Deltek PM Compass and EPM Security Administrator applications.  

 Process Server Tier: This tier allows the user to schedule processes and profiles to run 
automatically in the background. All reports and all scheduled alerts are examples of processes 
that can run on the Process server. 

 Report Server Tier: This tier handles all reporting requests. It uses Microsoft SQL Server 
Reporting Services. 

 Database Tier: This tier consists of Database servers where the PM Compass data is stored and 
retrieved. This can either be an Oracle database or a SQL Server database. PM Compass 
requires Open Plan and Cobra data stored in the same database as PM Compass. Your Oracle 
Database server should be on a separate server. All connections to your Database server are 
made from the Web/Application or Report server. 

Logical Tier Model  
The diagram below provides information about the logical tiers and technologies utilized at each tier of a 
Deltek PM Compass deployment. Logical tiers do not necessarily require a separate server for each tier. 
For example, a single-server deployment includes each of the tiers below installed and configured on the 
single server. 

 
Logical Tier Model 
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Database Requirements  
PM Compass data can be stored in a SQL Server database or an Oracle database. If you are not 
integrating with an existing Cobra or Open Plan database and are not upgrading an existing installation, 
you must create a new blank database before performing the installation. The installation will provide 
database script options for applying the PM Compass schema into the blank database. During the 
installation, you will be asked to provide the server and database name for the various components. If 
your database is not set to auto expand, make sure that there is enough space to accommodate the 
objects and data that PM Compass will be introducing. 

PM Compass database is Unicode and uses case-insensitive indexes. When you are upgrading an 
existing Open Plan database to PM Compass, ensure that the database is Unicode-enabled and uses 
case-insensitive indexes. 

 

Sample Database 
The PM Compass installation includes a backup of a sample database. This sample database serves as 
a valuable resource for learning how to use PM Compass and troubleshooting issues. If a Customer 
Success Analyst requests it, you can attempt to recreate an issue in the sample database. This process 
assists the analyst in determining whether the problem is data-related or if there is indeed an issue within 
PM Compass. 

 

SQL Server Reporting Services 
PM Compass reporting requires SQL Server Reporting Services and a Microsoft SQL Server database 
even if you are storing your Cobra and PM Compass data in Oracle. The database component of 
Microsoft SQL Server Reporting Services requires certain settings.  

 
 Oracle Database: When PM Compass data is stored in an Oracle database, the sample 

database should be restored into the SQL Server database used by the SQL Reporting Services. 
When you perform the Report tier installation, the backup file containing the sample database is 
copied onto the Report server into the PM Compass installation location.  

Attention: For more information on other deployments and the following topics, see the Deltek PM 
Compass Advanced Administration Guide: 

 Load Balancing 

 Reverse Proxy 

 Secure Socket Layer 

Attention: For more information, see “Appendix H: Unicode and Case-Insensitive Prerequisites for 
Cobra and Open Plan Databases” in this guide. 

Attention: For more information, see “Using the Sample Database” in this guide. 

Note: Review “Appendix C: Microsoft SQL Server Reporting Services” in this guide to make sure the 
report server database configuration is correct. 
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At the end of the Web/Application tier installation, you have the option to restore the sample 
database from the backup file on the Report server. If you choose to restore the sample 
database, even though you are on Web/Application server, the process restores the sample 
database into the SQL Server database engine used by the Report server. 

 Microsoft SQL Server Database: When PM Compass data is stored in a Microsoft SQL Server 
database, the sample database can be restored into your SQL Server database engine. When 
you perform the Database tier installation, the backup file containing the sample database is 
copied onto the Database server into the PM Compass installation location.  

At the end of the Web/Application tier installation, you have the option to restore the sample 
database from the backup file located on the Database server. Even though you are performing 
the restore from the Web/Application server, the process to restore the sample database is being 
performed remotely on the Database server. 
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Permissions Required for Installing PM Compass 
When performing the PM Compass installation, there are certain rights and privileges required for the 
person performing the installations on the server tiers. 

Tier Permissions Required 

Web/Application Tier The Domain Service Account utilized by the individual performing the 
installation must be: 

 A member of the Local Administrator group on the server  

 A member of the System Administrator role in SQL Server if the 
PM Compass SQL Server Sample Database Restore Utility will be 
used after the installation completes to restore a Sample PM 
Compass database and it’s corresponding Snapshot database. 

 A member of the System Administrator group in SQL Server 
Reporting Services on the Report Server. 

 A Content Manager role in SQL Server Reporting Services on the 
Report server 

 
When proceeding with the Web/Application tier installation, you will 
encounter prompts to input credentials and connection details for the 
database. These credentials must possess the necessary privileges as 
outlined in the Database Requirements section. 

Process Server Tier The Domain Service Account utilized by the individual performing the 
installation must be part of the Local Administrator group on the server.  

Report Server Tier The Domain Service Account utilized by the individual performing the 
installation must be: 

 A member of the Local Administrator group on the server  

 A member of the System Administrator group  

 A Content Manager Roles in SQL Server Reporting Services on 
the Report server 

 
When proceeding with the Web/Application tier installation, you will 
encounter prompts to input credentials and connection details for the 
database. These credentials must possess the necessary privileges as 
outlined in the Database Requirements section. 

Attention: For more information, see “How to Give Your Account 
Proper Rights and Privileges in Reporting Services” under “Appendix 
C: Microsoft SQL Server Reporting Services” in this guide. 

Attention: For more information, see “How to Give Your Account 
Proper Rights and Privileges in Reporting Services” under “Appendix 
C: Microsoft SQL Server Reporting Services” in this guide. 
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Tier Permissions Required 

Database Server Tier The Domain Service Account utilized by the individual performing the 
installation must be part of the Local Administrator group on the server.  

When proceeding with the Web/Application tier installation, you will 
encounter prompts to input credentials and connection details for the 
database. These credentials must possess the necessary privileges as 
outlined in the Database Requirements section. 

Domain Service Account Versus Default Local Account  
Using a Domain Service Account has the advantage of access to network share, printers and allows you 
to control the account with group policies. For each of the installations, you should login as the Domain 
Service Account. If you do not login as a Domain Service Account, the PM Compass installer will create a 
default local account to run the various PM Compass processes: 

 Running the application pool on the Web Server*. 

 Running the Process Server service*. 

 Accessing the Report Server Web Service. 

 Accessing the SQL Server database.  

If the servers are in a domain, Deltek recommends that you run the installation using the Domain Service 
Account. PM Compass will not create the default PM Compass local account if you perform the 
installation using a Domain account. Login to the server with that domain account before you launch the 
installation.  

If you intend to integrate with Microsoft Project, you will need to use a Domain Service Account with 
access to network share of the Microsoft Project files and access rights to the Microsoft Project Server.  

 
If you choose to use a local account, you will need to run the installer on the Report server and Web 
server so that it will create the local DeltekPMCompass account on both servers. This will ensure that it 
will have access on both servers (same username/same password that will support pass-through 
authentication). During the installation, you will be asked for a password for the local account. You must 
make sure the password you enter meets the password policy for your local account. If you enter a 
password that does not meet the password policy, the installation will continue but you will get errors 
when loading reports and when you try to use the product.  

 

File Share Requirements 
PM Compass must access files on a server. For each of these file folders, the PM Compass Domain 
Service Account User must have read/write access. Some of the folders, for example the Import/Export 
folders, the end users need at least read access.  

During the installation, you will be prompted to enter the shared UNC for some of these various folders. 
The remaining UNC files will be required for the post-installation configuration. 

Attention: For more information, see “Appendix N: Integrating with Microsoft Project” in this guide. 

Attention: For detailed steps to change the password or change the user to a Domain Service 
Account user, see “Appendix K: Configuring the Account Running the Services” in this guide. 
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For all fields, you can create a central UNC path, for example, \\<servername>\DeltekPMCompass\ , 
and then create subfolders for each of the various files. While it is possible to use the same folder for 
each of these settings, it is helpful to create separate folders for each of the following to simplify the 
management of the content, and to locate the needed files.  

You should create these folders before starting the installation and apply the proper access rights. The 
table below contains the various folders, the necessary access rights, along with a link to the detailed 
information about where and how this folder will be used. 

Folder End User Access Related Topics 

Link files (such as Word 
documents and spreadsheets) 
to workflows, projects, and so on 

Read and write access  “Install the Web/Application 
Server” in this guide 

 “Link Center” and “File Folders 
Tab of the System Settings Form” 
in the PM Compass Help System 

Export data such as schedule 
data and work authorizations to 
a file 

Read access  “Install the Web/Application 
Server” in this guide 

 “General Import and Export 
Overview” in the PM Compass 
Help System 

Import schedule data from a 
CSV file 

Read and write access  “Install the Web/Application 
Server” in this guide 

 “General Import and Export 
Overview” in the PM Compass 
Help System 

.MPP files for integration with 
Microsoft Project 

Read and write access  “Install the Web/Application 
Server” in this guide 

 “Configure PM Compass for 
Microsoft Project Integration” in 
the PM Compass Help System 

MSP integration process logs (if 
integrating with MSP) 

Read access  “Install the Web/Application 
Server” in this guide 

 “Appendix N: Integrating with 
Microsoft Project” in this guide 

 “Configure PM Compass for 
Microsoft Project Integration” in 
the PM Compass Help System 

Primavera integration process 
logs (if integrating with 
Primavera) 

Read access  “Install the Web/Application 
Server” in this guide 

 “Log File Location for Primavera 
P6 Logs” in the PM Compass 
Help System 
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Folder End User Access Related Topics 

Cobra process log files such as 
integration process logs 

Read access  “Configure Cobra to Write 
Process Logs to a File” in this 
guide 

Cobra report template files Read access 

Write access is required 
to modify report templates 

 “Configure the Cobra Report 
Templates Folder Location” in this 
guide 

A shared folder for Open Plan 
Citrix users 

No access   “Install the Web/Application 
Server” in this guide 

The installer will copy the PM 
Compass Web client ClickOnce 
Bypass files to a shared folder that the 
Open Plan client (running on a Citrix 
server) will use to launch the PM 
Compass client from (instead of from a 
browser). 

A folder for a shared 
databases.enc 

No access By configuring a shared location for the 
database connection information, you 
can avoid the necessity of 
synchronizing changes across your 
servers. 

For more information, see “Configure a 
Shared Location for Databases.enc” in 
the Deltek PM Compass Advanced 
Administration Guide. 
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Configuring the Databases 
This section covers topics about configuring the databases. 

Connecting to the SQL Server Database 
You must create a Microsoft SQL Server logon account, which can either be an existing Windows 
account or a Microsoft SQL Server username. The account requires the db_owner role membership in 
the Login Properties and User Mapping dialog box for the following databases:  

 PM Compass database (if using SQL Server to store project data) 

 ReportServer 

 ReportServerTempDB 

 

Prerequisites 
Perform the following steps before proceeding with the installation. 

1. Enable the TCP/IP and shared memory network protocols in the SQL Server configuration 
manager on the Microsoft SQL Server. All network protocols are installed by the SQL Server 
setup but may not be enabled. 

 
2. Configure your SQL Server to listen on a port other than TCP 1433 and enable the SQL Server 

Browser service to enable PM Compass to connect to your Database server. 

Do one of the following: 

 Enable the SQL Server Browser service on the Database server. 

Attention: For more information, see “How to Give Your Account Proper Access Rights and 
Privileges in Report Services” under “Appendix C: Microsoft SQL Server Reporting Services” in this 
guide. 

Attention: For more information, see the following Microsoft articles: 

 "How to Enable or Disable a Server Network Protocol (SQL Server Configuration 
Manager)"  

 “Configure a Firewall for Report Server Access” 

 “Configure a Windows Firewall for Database Engine Access” 

http://msdn.microsoft.com/en-us/library/ms191294.aspx
http://msdn.microsoft.com/en-us/library/ms191294.aspx
https://msdn.microsoft.com/en-us/library/bb934283.aspx
https://msdn.microsoft.com/en-us/library/ms175043.aspx
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 Verify the name of your SQL Server instance. During the installation of Microsoft SQL Server, 
Microsoft gives you the option to install database engine to the default instance (named 
MSSQLSERVER) or to a named instance that you specify. 

 
 If you do not know the name of your SQL Server instance or you are unable to connect to 

your Database server after installation, see the following Microsoft article: “How to Determine 
Whether the Database Engine Is Installed and Started”. 

 If you plan to use a dedicated SQL Server username and password, verify that the SQL 
Server configuration settings for server authentication are set to SQL Server and Windows 
Authentication mode also known as Mixed Mode. If you are unable to connect to your SQL 
Server database and you have already performed the steps in the first two bullets, you should 
verify that the SQL Server security settings are properly configured. 

 

Storing PM Compass Data on an Oracle Database 
If you intend to store your Cobra data on an Oracle database, take note of the following requirements: 

 Install the Oracle database Standard or Enterprise editions. 

Deltek Recommendation: If you disable the SQL Server browser service on your Database 
server and are not using TCP port 1433, Deltek strongly recommends that you use the SQL 
Server Client Network Utility (part of the Windows operating system) on the PM Compass 
server to tell it how to connect to the Database server using the correct port without having to 
specify the port number each time you make a connection. 

Background Information: When you make connections to the SQL server, the PM Compass 
server tries to connect using TCP port 1433. If SQL Server was installed using a different 
port, the SQL Server browser service on the Database server directs the connection to the 
correct port number. If this service is disabled, the PM Compass server does not know how to 
connect unless you specify the port number each time you make a connection (for example, 
DBServerA,2325). 

For more information, refer to KB article 89576 on the Deltek Support Center site. 

Note:  
 When connecting to the Default SQL Server Database Engine instance, use the 

name of your Database server. SQL Server automatically maps the default instance 
of the Database engine to the Server Name when accepting connections. 

 When connecting to a named instance of SQL Server database engine, specify the 
name of the SQL Server along with instance in the connection in the format of 
SERVERNAME\INSTANCENAME. 

 For instance, if your SQL Server is named SQLSERVER1 and you installed an 
instance named SQL2019, your server connection information would be 
SQLSERVER1\SQL2019. 

Attention: For more details, see the following Microsoft article: 
https://msdn.microsoft.com/en-us/library/ms188670(v=SQL.105).aspx. When performing the 
steps, ensure that you select the SQL Server and Windows Authentication mode option. 

https://msdn.microsoft.com/en-us/library/ms366339.aspx.
https://msdn.microsoft.com/en-us/library/ms366339.aspx.
https://deltek.custhelp.com/app/answers/detail/a_id/89576
https://msdn.microsoft.com/en-us/library/ms188670(v=SQL.105).aspx
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 Contact your Oracle DBA to obtain the Oracle Server name/SID and the user credentials for the 
PM Compass database schema. Your DBA will need the following information in order to 
configure the account: 

A user ID with the following grants: 

GRANT CONNECT, RESOURCE TO <USER> 

GRANT CREATE TABLE TO <USER> 

GRANT CREATE VIEW TO <USER> 

GRANT CREATE TRIGGER TO <USER> 

GRANT CREATE ANY CONTEXT TO <USER> 

GRANT EXECUTE ON DBMS_RANDOM TO <USER>; 

 
 Install the .NET framework in the following tiers: 

 Web/Application server 

 Process server 

 Report server 

 Install the 64-bit and the 32-bit Administrator version of the Oracle client in the following tiers: 

 Web/Application server 

 Process server 

 Install a 64-bit Administrator version of the Oracle client on the Report tier. 

 The Oracle Server name/SID defined in tnsnames.ora must be the same on your PM Compass 
Application server, Report server, and Process server tiers. 

Note: Although granting rights to the Resource Role includes the CREATE TABLE and 
CREATE TRIGGER grants, you must still explicitly run all of the grant statements above to 
ensure that all functions of PM Compass (including database upgrade procedures) run 
correctly. 

The PM Compass installation queries the session_privs and user_role_privs tables to 
validate that all of these grants have been applied. 
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Pre-Installation Checklists 
This chapter includes a separate checklist for each of the following tiers: 

 Database tier 

 Report tier 

 Web/Application tier 

 Process server tier 

Database Tier 
PM Compass does not require any installation to be performed on the Oracle database server. Any 
connections that are needed are made to the database when you run the installer on your 
Web/Application server.  

Deltek provides several deployment models. For all models, Deltek assumes that your Oracle database 
server is a separate machine. No installations are performed on this machine. All connections to your 
Database server are made from the Web/Application or Report server. 

Step Related Topics 

1 Connect to the SQL Server database. “Connecting to the SQL Server Database” in 
this guide 

2 If you do not have Cobra, Open Plan or PM 
Compass, you must create a database before 
starting the installation. 

“Storing PM Compass Data in an Oracle 
Database” in this guide 

3 If you already have Cobra and/or Open Plan, 
review Appendix H for specific checks and 
possible changes that must be performed to 
ensure your existing database is compatible 
with PM Compass. 

“Appendix H: Unicode and Case-Insensitive 
Prerequisites for Cobra and Open Plan 
Databases” in this guide 

4 Confirm Cobra and Open Plan are the correct 
versions. 

“Cobra and Open Plan” under “Hardware 
and Software Requirements” in this guide 

Report Tier 
You must install the Report tier before the Application tier. 

Step Related Topics 

1 Verify the Report server operating system, 
software, and hardware requirements. 

“Appendix A: System Requirements” in this 
guide 

2 Verify that your SQL Server database engine and 
reporting services installations meet the system 
requirements. 

“Appendix A: System Requirements” in this 
guide 
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Step Related Topics 

3 Verify that you have at least 2 GB of disk space 
available for this installation. 

 

4 Configure Reporting Services with native mode. 
PM Compass only supports native mode. 

“How to Configure Microsoft SQL Server 
Reporting Services” under “Appendix C: 
Microsoft SQL Server Reporting Services” in 
this guide 

If reporting services are already configured, you 
need to know the Web Service URL and the 
name of the Report server databases during the 
installation. 

“SQL Server Reporting Services” in this 
guide 

5 Verify that the Domain Service Account has the 
proper rights and privileges in reporting services. 

“How to Give Your Account Proper Rights 
and Privileges in Reporting Services” under 
“Appendix C: Microsoft SQL Server 
Reporting Services” in this guide 

6 If you experience connection errors to your 
Report server and have verified the previous 
steps, check that access is not blocked by 
Windows or your firewall. 

“Configure a Firewall for Report Server 
Access” 

7 Ensure that you have the following information 
prior to starting your installation: 

 Reporting Database server\SQL instance 
name 

 Report server database name 

 Report server Web Service URL 

You can see this information in the Reporting 
Services Configuration Manager when you select 
Database in the left pane. 

“Database Requirements” in this guide 

“How to Connect to the Report Server” under 
“Appendix C: Microsoft SQL Server 
Reporting Services” in this guide 

8 Enable Microsoft .NET Framework and apply the 
supported version. 

“Appendix A: System Requirements” in this 
guide 

Web/Application Tier 
Step Related Topics 

1 Verify the Web/Application server(s) operating 
system, software, and hardware requirements. 

“Appendix A: System Requirements” in this 
guide 

2 Verify that the Domain Service Account 
performing the installation is a member of the 
local Windows System Administrators group. 

“Domain Service Account vs. Default Local 
Account” in this guide 

https://learn.microsoft.com/en-us/sql/reporting-services/report-server/configure-a-firewall-for-report-server-access?view=sql-server-ver16&redirectedfrom=MSDN
https://learn.microsoft.com/en-us/sql/reporting-services/report-server/configure-a-firewall-for-report-server-access?view=sql-server-ver16&redirectedfrom=MSDN
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Step Related Topics 
This same Domain Service Account is used to 
run the PM Compass application in IIS on the 
server, Windows Services, and integrating PM 
Compass with other products.  

You will need to use this account when you 
perform PM Compass upgrades. 

3 Verify that you have at least 2 GB of disk space 
available for this installation. 

 

4 Enable Microsoft .NET Framework and apply the 
supported version. 

“Appendix A: System Requirements” in this 
guide 

5 If you have implemented Transport Layer 
Security (TLS), you will need to perform 
additional steps. 

“Appendix S: Secure Transport Layer 
Security (TLS)” in this guide 

6 Install Microsoft Internet Information Services 
(IIS) with ASP .NET enabled. 

“Appendix B: Microsoft Internet Information 
Server (IIS) Installation on Windows Server” 
in this guide 

7 Verify that you can connect to the SQL Server 
from your PM Compass application server. 

“Connecting to the SQL Server Database” in 
this guide 

8 Verify that the Domain Service Account 
performing the installation has proper access to 
the report tier. 

“Required Rights for Report Server” under 
“Appendix C: Microsoft SQL Server 
Reporting Services” in this guide 

9 Ensure that you have one of the following: 

 If using Windows Authentication, verify 
that the Domain Service Account 
performing the installation has proper 
access to the database. 

 If you use a SQL Server username and 
password to access the databases, 
ensure that it is already created and 
correctly configured. 

“Prerequisite Report Server and SQL Server 
Database Credentials” under “Appendix C: 
Microsoft SQL Server Reporting Services” in 
this guide 

10 For Oracle Users only: 

 The Oracle client on the Web/Application 
and Process servers must be 64-bit; 
however, you also need to install a 32-bit 
Oracle client for the Cobra Web Service. 

 Verify that the Oracle Server name/SID 
defined in tnsnames.ora is the same on 
your PM Compass Application server, 
Report server, and Process server tiers. 

“Storing PM Compass on an Oracle 
Database” in this guide 
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Step Related Topics 

11 Note the PM Compass installation location on 
your Web server. You will need this information 
for the Process server tier. 

 

12 Note the shared UNC folders created to store 
files on the server. 

“File Share Requirements” in this guide 

Process Server Tier 
Step Related Topics 

1 Verify the Process Server operating system, 
software, and hardware requirements. 

“Appendix A: System Requirements” in this 
guide 

2 Verify that the Domain Service Account 
performing the installation is a member of the 
local Windows System Administrators group. 

“Domain Service Account vs. Default Local 
Account” in this guide 

3 Verify that you have at least 2 GB of disk space 
available for this installation. 

 

4 If you have implemented Transport Layer 
Security (TLS), you will need to perform 
additional steps. 

“Appendix S: Secure Transport Layer 
Security (TLS)” in this guide 

5 Verify that you can connect to the SQL Server 
from your PM Compass server. 

“Connecting to the SQL Server Database” in 
this guide 

6 Enable Microsoft .NET Framework and apply the 
supported version. 

“Appendix A: System Requirements” in this 
guide 

7 Verify the location (path) of the existing 
databases.enc file on your Web server. During 
the installation, you will need to provide this 
information.  

The default location of this file is: C:\Program 
Files\Deltek\PM Compass\. 

“Configure a Shared Location for 
Databases.enc” in the Deltek PM Compass 
Advanced Administration Guide 

8 For Oracle Users only: 
 The Oracle client on the Web/Application 

and Process servers must be 64-bit; 
however, you also need to install a 32-bit 
Oracle client for the Cobra Web Service. 

 Verify that the Oracle Server name/SID 
defined in tnsnames.ora is the same on 
your PM Compass Application server, 
Report server, and Process server tiers. 
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Step Related Topics 

9 If you are integrating with Deltek Open Plan, 
Microsoft Project, or Oracle Primavera P6, make 
sure that you review the integration and 
configuration requirements. 

“Appendix M: Integrating with Open Plan” in 
this guide 

“Appendix N: Integrating with Microsoft 
Project” in this guide 

“Appendix O: Integrating with Primavera P6” 
in this guide 



Installation Steps (PM Compass New Installs) 

Installation Guide 23 

 

Installation Steps (PM Compass New Installs) 
This chapter includes sections on the installation steps for different deployment models. 

Installation/Deployment Models 
When you install PM Compass, you are asked to select an installation model. There are three different 
models used to deploy PM Compass. The model you choose depends on your organization’s needs with 
regard to size, cost considerations, security requirements, and fault tolerance. The following table 
provides information about each model. The installation steps for each model are included in this 
document. Once you decide which model you want to install, click the Installation Steps hyperlink to take 
you to the installation instructions for that model. 

Deployment Model Overview When Would I Use This 
Model? 

One-Server (Single Server) 
One-Server Installation Steps 

Install PM Compass tiers (Web, 
Application, Process, Report, 
and Database server) on the 
same server.  

Optionally install database on a 
different server. 

Infrastructure security is not a 
concern with this model because 
all application usage is internal 
to the organization. 

Deployment needs are simple. 
For example, you are installing 
PM Compass on a test server. 

All users are at a single location 
and will only access PM 
Compass in the office or over a 
Virtual Private Network (VPN) 
connection into the corporate 
network. 

Small organization (fewer than 
25 employees) 

If your Web/Application server, 
Report server, and database tier 
are all on the same server, you 
must use this installation model. 

Two-Server (Two-Tier) 
Configuration 1 
Two-Server Installation Steps 

Install the database and report 
components on one or more 
servers and the Web/Application 
and Process Server components 
on a separate server. 

In this configuration the PM 
Compass client application 
needs a direct connection to the 
Report server to run and view 
reports. 

Infrastructure security is not a 
concern with this model because 
all application usage is internal 
to the organization. 

Your organization has one SQL 
Server license. 

All users are at a single location 
and will only access PM 
Compass in the office or over a 
Virtual Private Network (VPN) 
connection into the corporate 
network. 

Since the Database server is 
also on the Report server, it is 
not suitable for use in an 
environment with users 
accessing the application over 
the Internet without a VPN 
connection.  
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Deployment Model Overview When Would I Use This 
Model? 
Small to medium organization 
that may not have a technical 
staff. 

If your Report server is on the 
same server as your database 
tier, you must use this 
installation model. 

Two-Server (Two-Tier) 
Configuration 2 
Two-Server Installation Steps 

Install the database component 
on a server and the 
Web/Application server, Process 
server, and Report server 
components on a separate 
server. 

Reporting services are installed 
on a server separate from the 
database engine. 

Your organization has additional 
Microsoft SQL Server licenses, 
and you split the Report server 
(Web Service) from the 
Database server hosting the 
Report server database. 

Users are accessing the 
application over the internet. 

Small to medium organization 
that may not have a technical 
staff. 

If your Web/Application server 
and your Report server are on 
the same server, you must use 
this installation model. 

Three or More Servers 
Three or More Servers 
Installation Steps 

Install any of the following: 

 A single Database 
server 

 One or more Report 
servers 

 One or more 
Web/Application servers 

 One or more Process 
servers 

You have a large organization 
with many PM Compass users. 

Have a need for additional 
Report, Web/Application, or 
Process servers for load 
balancing, performance, 
security, or fault tolerance 
reasons. 

Organizations with proficient 
firewall management. 

Having each tier on a separate 
server enhances performance 
and scalability. In addition, it is 
easy to add additional servers 
after deployment.  

Require load balancing multiple 
servers for better performance. 

Load Balancing 
If you select three or more server installations, you can configure load balancing according to your 
vendor’s (for example, Microsoft Windows Server) recommendations. Make sure that you set the affinity 



Installation Steps (PM Compass New Installs) 

Installation Guide 25 

 

to Single or Sticky (terminology depends on the vendor). This ensures that user sessions are maintained 
on the same server as long as a user remains logged on. 

 Configure Database Session State for PM Compass: Session state information is typically 
stored in memory on the Web server in the IIS Application Pool process serving the application 
(w3wp.exe). Database session state is normally not a consideration unless you will be load 
balancing multiple front-end PM Compass Web/Application servers and you would like to isolate 
your user’s session information from a failure or error on one Web server where their session 
information may be lost. 

One benefit of storing the session state in the database is that, when there is a Web Server 
failover, the work that was being performed at the time is not lost.  

 
 Configure a Shared Location for Databases.enc: If your PM Compass deployment includes 

multiple Web/Application servers, or even just a dedicated Process server, configuring a shared 
location for the database connection information and credentials (databases.enc file) to eliminate 
the need to synchronize changes made to the databases.enc file across your servers.  

 
 Loading Reports onto Load Balanced SSRS Web Service Servers: In a load balanced 

environment with multiple SSRS servers, they all share a common URL, making it unclear which 
Web server you are connected to. To ensure all SSRS Servers are updated with the latest PM 
Compass reports, you need to run a batch file that updates each SSRS Server individually by its 
NetBIOS or host name. 

 

One Server Installation Steps 
One-server deployment is suitable for demonstration purposes or for small organizations. When you 
choose the one-server deployment model, you install all PM Compass tiers (Web, Application, Process, 
Report, and Database servers) on the same server.  

The one-server deployment model allows you to use an existing database on a separate server. If your 
Oracle database is on a Unix platform, you cannot run the PM Compass installation database tier 
installation on your Unix server. During the installation of PM Compass on the Web/Application tier, you 
can use any of the options on the Script Options screen to connect to the database and apply the 
necessary scripts. 

The steps in this section will guide you in installing PM Compass tiers on a single server. The method you 
use to create your PM Compass database file during installation depends on whether you are installing 
PM Compass for the first time or upgrading from a previous Deltek product. 

To install PM Compass on one server: 
1. Log into the server as the Domain Service Account user.  

Attention: For more information, see “Configure Database Session State for PM Compass” 
in the Deltek PM Compass Advanced Administration Guide. 

Attention: For more information, see “Configure a Shared Location for Databases.enc” in the 
Deltek PM Compass Advanced Administration Guide. 

Attention: For more information, see “Loading Reports onto Load Balanced SSRS Web 
Service Servers” in the Deltek PM Compass Advanced Administration Guide. 
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If your server is not part of a domain, log in as a local account.  

 
2. Double-click the DeltekPMCompass85CumulativeUpdate<version>.exe file that you 

downloaded to run the installation. 

3. On the Prerequisites screen, click Next. 
This screen displays the items that the installation checks. If the criteria are not met for the 
particular tier, the wizard may display a message, or the setup may exit. 

4. On the Deltek PM Compass Installation Wizard screen, click Next. 
5. On the Select Destination screen, specify the location where you want to install PM Compass and 

its components, and click Next.  
6. On the Number of Deltek PM Compass Servers screen, select the One Server option, and click 

Next. 

 
7. During installation, PM Compass utilizes an account to execute application processes on the 

server. Setup prompts you to provide the password under one of two conditions. 

 If you are logged in using a Domain Service Account, the Specify Service/Identify Account 
Password screen displays. Do one of the following:  

 Enter the password for the Domain Service Account and click Next. 
 If you do not want to use a domain account, select Use Default Local Account 

(DeltekPMCompass), and click Next.  

 

Attention: For more information, see “Domain Service Account vs. Default Local Account” in 
this guide. 

Attention: For more information, see “Domain Service Account vs. Default Local Account” in 
this guide. 
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 If you are logged in as a local (non-domain) account, or if you selected Use Default Local 

Account (DeltekPMCompass) on the Specify Service/Identity Account Password screen, 
the Password screen displays. 

 

 

Warning: You must specify a secure password for the account that meets the password 
policy. Setup does not save this password nor log it anywhere, so you must keep a record. 
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After you enter your password and click Next, you must enter it again to verify that you have 
entered it correctly and click Next. 

8. On the Database Platform screen, select Oracle or Microsoft SQL Server, and click Next.  
9. The next screen depends on whether you selected Oracle or Microsoft SQL Server. Refer to 

the section below that corresponds to your selected database. 

Oracle Database 
The setup checks for supported versions of the Oracle Client driver. If it finds a supported 
version, setup continues. If not, the wizard displays a message informing you that no supported 
Oracle driver has been found, and the setup exits when you click OK. To resolve this, install the 
supported Oracle client driver version and run the wizard again. 

 
On the Oracle Connection Information screen, enter the necessary information in the appropriate 
fields, and click Next. 

Attention: For more information, see “Storing PM Compass Data on an Oracle Database” in 
this guide. 
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 Service name/SID: Enter the unique name of your Oracle database instance as defined in 

your tnsnames.ora file. 

 Username: Enter the Oracle user schema with rights to modify the tables in the Oracle 
database.  

 Password: Enter the password associated with the Oracle Username. 

The following validations are performed: 

 SID is found in tnsnames.ora. 

 Username/password are correct. 

 The versions of Cobra and Open Plan (if installed) are supported. 

 The database has Unicode and case incentive indexes enabled. 

If any of these validations fail, the wizard displays a message, and the setup exits. 

 
Microsoft SQL Server Database 
On the Database Server (MSSQL) Setup Connection Information screen, enter the necessary 
information in the appropriate fields, and click Next. 

Attention: For steps to resolve Cobra and Open Plan database prerequisite requirements, 
see “Appendix H: Unicode and Case-Insensitive Prerequisites for Cobra and Open Plan 
Databases” in this guide. 
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 Database Server: Enter the name of the Database server and the database instance. 

 Select Windows Integrated or enter the SQL Login and SQL Password. 

 SQL Login: Enter a Microsoft SQL Database Server Login that is mapped to the 
db_owner role in the database. If you use the SQL Login and SQL Password 
fields, make sure that server security is configured to support Mixed Mode Security. 

 
 SQL Password: Enter the password associated with this SQL Login. 

 Database Name: If you have an existing Cobra database, enter your Cobra database name. 
If this is a new installation, enter the name of the new database you created to store your 
data.  

The following validations are performed: 

 Username/password are correct. 

 The database name is valid, and the user has access. 

 The versions of Cobra and Open Plan (if installed) are supported. 

 The version of SQL Server is supported. 

If any of these validations fail, the wizard displays a message, and the setup exits. 

10. Choose whether PM Compass integrates with the Microsoft Project scheduling tool. 

 

Note: Security best practice recommends not using the default SYSADMIN account (sa) for 
your SQL Server connection. 
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 If you are using Microsoft Project as a PM Compass scheduling tool, enter the UNC share 
location for the MSP Files and Process Logs folders, and click Next. 

 If you are not using Microsoft Project as a PM Compass scheduling tool, leave the UNC 
Share Path fields blank, and click Next.  

 

 

 
11. Choose whether PM Compass integrates with the Primavera P6 scheduling tool. 

 
12. If you are integrating PM Compass with Primavera P6, specify the Primavera P6 UNC share 

location where you want to store the process logs onto the Primavera P6 Integration Process 
Logs UNC Share Path screen. If the location for MSPLogs is already specified, the screen may 
not display. 

Attention: To manually configure the system after the installation, see “Appendix N: 
Integrating with Microsoft Project” in this guide. 

Attention: For information about the permissions required for these folders, see “File Share 
Requirements” in this guide. 
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13. On the Shared Network Folder screen, specify the UNC share location where you want to store 

links, general export files, and MPP export files. For example, 
\\<servername>\DeltekPMCompass\. 

 
14. On the Default Files Folders screen, the wizard displays the default Links, General Export, and 

MPP Export folder locations. You can edit these locations in PM Compass after the installation 
(Administration » System Settings » File Folders tab). 

Attention: For information about the permissions required for these folders, see “File Share 
Requirements” in this guide. 
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15. On the Script Options screen, select your database script option and click Next. 

 

 
The options available on this screen depends on whether you are using a new or existing 
database. Refer to the section below that corresponds to your database. 

New Database 
If you have a new PM Compass database, or you are applying PM Compass for the first time to 
your Cobra or Open Plan database, your options are: 

Note: The PM Compass installation does not automatically back up your database before applying 
any scripts. Make a backup of your database before selecting any of the options on this screen. 
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 Automatically run scripts during the installation — creates the PM Compass tables: 
Select this option to create the PM Compass database tables automatically during 
installation. If you select this option, you do not need to run any scripts after the installation. 

 Create batch file (CreatePMCompassTables.bat) to run scripts manually: Select this 
option to create the PM Compass database tables manually after installation using a batch 
file. The batch file is named CreatePMCompassTables.bat and located in the <PM 
Compass Installation Directory>\Databases\Scripts folder. For example: C:\Program 
Files\Deltek\PMCompass\Scripts. 

 I will manually run the scripts to create the PM Compass tables. No batch file will be 
created: Select this option to manually create the PM Compass database tables after 
installation using the scripts located in the <PM Compass Installation 
Directory>\Databases\Scripts folder. For example: C:\Program 
Files\Deltek\PMCompass\Scripts. 

 

 
Existing Database 
If you have an existing PM Compass database, your options are: 

 Automatically run upgrade scripts during the installation: Select this option to upgrade 
the PM Compass database tables automatically during installation. If you select this option, 
you do not need to run any scripts manually after the installation. 

 Create batch file (UpgradePMCompassDB.bat) to run scripts manually: Select this 
option to upgrade the PM Compass database tables manually after installation using a batch 
file. The batch file is named UpgradePMCompassDB.bat and located in the <PM Compass 
Installation Directory>\Databases\Scripts folder. For example: C:\Program 
Files\Deltek\PMCompass\Scripts. 

If you select this option, the wizard displays a message reminding you to run the batch file 
and pointing you to the location of the file. 

 I will manually run the upgrade scripts. No batch file will be created: Select this option to 
manually upgrade the PM Compass database tables after installation using the scripts 
located in the <PM Compass Installation Directory>\Databases\Scripts folder. For example: 
C:\Program Files\Deltek\PMCompass\Scripts. 

 
16. If the SQL Report Database Server Setup Connection screen is displayed, specify the connection 

to the SQL Report Database server. 

Attention: For more information, see “Run Scripts Manually on a SQL Database” under 
“Appendix G: Using Microsoft SQL Server with PM Compass” in this guide. 

Note: Database conversion log files are saved into the <PM Compass Installation 
Directory>\Logs\ScriptLogs folder. For more information, see “Conversion Log” under 
“Check the Log Files  After Installation” in this guide. 

Attention: For more information, see “Run Scripts Manually on a SQL Database” under 
“Appendix G: Using Microsoft SQL Server with PM Compass” in this guide. 
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After you enter the required information and click Next, the setup connects to the Report server. If 
an error is encountered, a dialog box displays asking for the Report server and Report server 
URL information. 

Enter the necessary information in the appropriate fields, and click Next. 

 

 
17. On the Load Reports screen, click Next. 

Attention: For more information, see “Configure Microsoft SQL Server Reporting Services” 
under “Appendix C: Microsoft SQL Server Reporting Services” in this guide. 

If you are unfamiliar with the Reporting Services configuration settings, see “Connect to the 
Report Server” in the same appendix. 
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18. If your Web server contains multiple web sites, the Specify Web Site screen displays. Select the 

website to which you will install PM Compass, and click Next. 
19. On the Cobra Web Service URL screen, click Next. 

By default, the wizard installs the Cobra Web Service on each Web/Application and Process 
server. Deltek strongly advises against making any changes to this. 

 
20. Choose whether PM Compass will be available for Citrix users. 

 

Attention: For additional information when deploying with Citrix, see "Using PM Compass 
with Citrix or Remote Desktop (ClickOnce Bypass)" in the Deltek PM Compass Advanced 
Administration Guide. 
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Click Yes if you are using Open Plan in a Citrix environment. The installer will copy the PM 
Compass Web client ClickOnce Bypass files to a shared folder. The Open Plan client, running on 
a Citrix server, will then use this folder to launch the PM Compass client instead of launching it 
from a browser. 

 
On the Path to shared Citrix folder screen, enter the path to the shared Citrix folder, and click 
Next. 

 
21. On the Start Copying Files screen, review the installation settings, and click Next. 

During the installation, the setup also loads the report.rdl files onto the Reporting Services Web 
Service. If the upload fails, the wizard displays an error message. Click OK to continue with the 
installation. 

 
22. On the Deltek PM Compass Installation Wizard Complete screen, click Finish.  

If prompted, you can restart your computer after installing PM Compass. 

Attention: For steps to reload reports manually after installation, see “Appendix E: Load 
Standard PM Compass Reports” and “Log Files Generated During the Report-Loading 
Process” in this guide. 
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Two Server Installation Steps 
Use this model if you have a small to medium-sized organization that may not have a technical staff. 
There are two methods for installing PM Compass across two servers. 

Configuration Description 

Configuration 1 Install the database and report components on one server, while placing 
the Web/Application and Process server components on a separate 
server. This configuration is commonly adopted by organizations with a 
single SQL Server license. It is suitable when all users are located at a 
single site and access PM Compass either within the office or via a VPN 
connection to the corporate network. In this model, infrastructure security 
is less critical, as all application usage remains internal to the organization. 
Small to medium-sized organizations without extensive technical staff 
often choose this method. 

The topics that cover this method are: 

 Configuration 1 (Part 1) — Database and Report Installation for 
Two-Server Deployment 

 Configuration 1 (Part 2) — Web/Application and Process Server 
Installation for Two-Server Deployment 

In a two-server deployment with Configuration 1, the Database and Report 
servers are on the same server. In this configuration, the PM Compass 
client application requires a direct connection to the Report server to run 
and view reports. However, since the Database server is also on the 
Report server, this setup is not suitable for use in an environment where 
users access the application over the Internet. 

Configuration 2 Install the database and report components on one server, while placing 
the Web/Application and Process server components on a separate 
server. This configuration is commonly used by organizations with a single 
SQL Server license. It is suitable when all users are located at a single site 
and will access PM Compass either within the office or via a VPN 
connection to the corporate network. In Configuration 2, reporting services 
are installed on a server separate from the database engine. If you choose 
to split the Report server (Web Service) from the Database server hosting 
the Report Server database, you will need a Microsoft SQL Server license 
for the report server. 

Note: If you encountered any errors during the installation, contact the Deltek Support Center and 
send the installation log file. For the log file location, see “Temporary Log Files and the Log Files 
Folder” in this guide. 

Note: If you prefer to restore the sample database later, you can restore it onto your Report 
Server database engine (Oracle) or Microsoft SQL Server database server (SQL Server) 
using the Deltek PM Compass Sample Database Restore Wizard. For more information, see 
“Appendix I: How to Run the Deltek PM Compass Sample Database Restore Wizard” in this 
guide. 
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Configuration Description 
The topics that cover this method are: 

 Configuration 2 (Part 1) — Database Server Installation for Two-
Server Deployment (Optional) 

 Configuration 2 (Part 2) — Web/Application, Report, and Process 
Server Installation for Two-Server Deployment 

Configuration 1 (Step 1) — Database and Report Server Installation for 
Two-Server Deployment 
Follow this procedure to install the Database and Report server tier on a server. 

 

To install the Database and Report servers for a two-server deployment: 
1. Log into the server that will serve as the Database and Report server as the Domain Service 

Account user.  

If your server is not part of a domain, log in as a local account.  

 
2. Double-click the DeltekPMCompass85CumulativeUpdate<version>.exe file that you 

downloaded to run the installation.  

3. On the Prerequisites screen, click Next. 
This screen displays the items that the installation checks. If the criteria are not met for the 
particular tier, the wizard may display a message, or the setup may exit. 

4. On the Welcome to Deltek PM Compass Installation Wizard screen, click Next. 
5. On the Select Destination screen, specify the location where you want to install PM Compass and 

its components, and click Next. 
6. On the Number of Deltek PM Compass Servers screen, select the Two Servers option, and click 

Next. 

Note: You must review the Pre-Installation Checklists before you begin your installation. 

Attention: For more information, see “Domain Service Account vs. Default Local Account” in 
this guide. 
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7. On the Two-Tier – Role of Server screen, select the Database/Report only option for 

Configuration 1, and click Next. 

 
8. During installation, PM Compass utilizes an account to execute application processes on the 

server. Setup prompts you to provide the password under one of two conditions. 

 If you are logged in using a Domain Service Account, the Specify Service/Identify Account 
Password screen displays. Do one of the following:  

 Enter the password for the Domain Service Account and click Next. 
 If you do not want to use a domain account, select Use Default Local Account 

(DeltekPMCompass), and click Next.  
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 If you are logged in as a local (non-domain) account, or if you selected Use Default Local 

Account (DeltekPMCompass) on the Specify Service/Identity Account Password screen, 
the Password screen displays. 

 

 

Attention: For more information, see “Domain Service Account vs. Default Local Account” in 
this guide. 

Warning: You must specify a secure password for the account that meets the password 
policy. Setup does not save this password nor log it anywhere, so you must keep a record. 
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After you enter your password and click Next, you must enter it again to verify that you have 
entered it correctly, and click Next. 

9. On the Database Platform screen, select Oracle or Microsoft SQL Server, and click Next.  
The next screen depends on whether you selected Oracle or Microsoft SQL Server. Refer to 
the section below that corresponds to your selected database. 

Oracle Database 
The setup checks for supported versions of the Oracle Client driver. If it finds a supported 
version, setup continues. If not, the wizard displays a message informing you that no supported 
Oracle driver has been found, and the setup exits when you click OK. To resolve this, install the 
supported Oracle client driver version and run the wizard again. 

 
On the Oracle Connection Information screen, enter the necessary information in the appropriate 
fields, and click Next. 

 
 Service name/SID: Enter the unique name of your Oracle database instance as defined in 

your tnsnames.ora file. 

 Username: Enter the Oracle user schema with rights to modify the tables in the Oracle 
database.  

 Password: Enter the password associated with the Oracle Username. 

The following validations are performed: 

 SID is found in tnsnames.ora. 

 Username/password are correct. 

 The versions of Cobra and Open Plan (if installed) are supported. 

 The database has Unicode and case incentive indexes enabled. 

Attention: For more information, see “Storing PM Compass Data on an Oracle Database” in 
this guide. 
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If any of these validations fail, the wizard displays a message, and the setup exits. 

 
Microsoft SQL Server Database 
On the Database Server (MSSQL) Setup Connection Information screen, enter the necessary 
information in the appropriate fields, and click Next. 

 
 Database Server: Enter the name of the Database server and the database instance. 

 Select Windows Integrated or enter the SQL Login and SQL Password. 

 SQL Login: Enter a Microsoft SQL Database Server Login that is mapped to the 
db_owner role in the database. If you use the SQL Login and SQL Password 
fields, make sure that server security is configured to support Mixed Mode Security. 

 
 SQL Password: Enter the password associated with this SQL Login. 

 Database Name: If you have an existing Cobra database, enter your Cobra database name. 
If this is a new installation, enter the name of the new database you created to store your 
data.  

The following validations are performed: 

 Username/password are correct. 

 The database name is valid, and the user has access. 

 The versions of Cobra and Open Plan (if installed) are supported. 

 The version of SQL Server is supported. 

Attention: For steps to resolve Cobra and Open Plan database prerequisite requirements, 
see “Appendix H: Unicode and Case-Insensitive Prerequisites for Cobra and Open Plan 
Databases” in this guide. 

Note: Security best practice recommends not using the default SYSADMIN account (sa) for 
your SQL Server connection. 
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If any of these validations fail, the wizard displays a message, and the setup exits. 

10. On the Specify Report Server and Report Server URL Information screen, enter the necessary 
information in the appropriate fields, and click Next. 
This screen displays if the setup is unable to determine the Report server information. 

 

 
11. On the Start Copying Files screen, review the installation settings, and click Next.  
12. On the Deltek PM Compass Installation Wizard Complete screen, click Finish.  

If prompted, you can restart your computer after installing the Database and Report server tiers. 

 
Proceed to Configuration 1 (Part 2): Web/Application and Process Server Installation for Two-Server 
Deployment. 

Configuration 1 (Step 2) — Web/Application and Process Server 
Installation for Two-Server Deployment 
Follow this procedure to install the Web/Application and Process server tiers on a server. This is the 
second of two steps for the two-server deployment model, where the Database/Report servers are on one 
server, and the Web/Application and Process server tiers are on another server. 

Attention: For more information, see “Configure Microsoft SQL Server Reporting Services” 
under “Appendix C: Microsoft SQL Server Reporting Services” in this guide. 

If you are unfamiliar with the Reporting Services configuration settings, see “Connect to the 
Report Server” in the same appendix. 

Note: If you encountered any errors during the installation, contact the Deltek Support Center and 
send the installation log file. For the log file location, see “Temporary Log Files and the Log Files 
Folder” in this guide. 
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To install the Web/Application and Process servers for a two-server deployment: 
1. Log into the server that will serve as the Web/Application and Process server as the Domain 

Service Account user. 

2. Double-click the DeltekPMCompass85CumulativeUpdate<version>.exe file that you 
downloaded to run the installation.  

3. On the Prerequisites screen, click Next. 
This screen displays the items that the installation checks. If the criteria are not met for the 
particular tier, the wizard may display a message, or the setup may exit. 

4. On the Welcome to Deltek PM Compass Installation Wizard screen, click Next. 
5. On the Select Destination screen, specify the location where you want to install PM Compass and 

its components, and click Next. 
6. On the Number of Deltek PM Compass Servers screen, select the Two Servers option, and click 

Next. 

 
7. On the Two-Tier – Role of Server screen, select the Web/Application/Process option for 

Configuration 1, and click Next. 
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8. During installation, PM Compass utilizes an account to execute application processes on the 

server. Setup prompts you to provide the password under one of two conditions. 

 If you are logged in using a Domain Service Account, the Specify Service/Identify Account 
Password screen displays. Do one of the following:  

 Enter the password for the Domain Service Account and click Next. 
 If you do not want to use a domain account, select Use Default Local Account 

(DeltekPMCompass), and click Next.  

 

  

Attention: For more information, see “Domain Service Account vs. Default Local Account” in 
this guide. 
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  If you are logged in as a local (non-domain) account, or if you selected Use Default Local 
Account (DeltekPMCompass) on the Specify Service/Identity Account Password screen, 
the Password screen displays. 

  

 
After you enter your password and click Next, you must enter it again to verify that you have 
entered it correctly and click Next. 

9. On the Database Platform screen, select Oracle or Microsoft SQL Server, and click Next.  
10. The next screen depends on whether you selected Oracle or Microsoft SQL Server. Refer to 

the section below that corresponds to your selected database. 

Oracle Database 
The setup checks for supported versions of the Oracle Client driver. If it finds a supported 
version, setup continues. If not, the wizard displays a message informing you that no supported 
Oracle driver has been found, and the setup exits when you click OK. To resolve this, install the 
supported Oracle client driver version and run the wizard again. 

 
On the Oracle Connection Information screen, enter the necessary information in the appropriate 
fields, and click Next. 

Warning: You must specify a secure password for the account that meets the password 
policy. Setup does not save this password nor log it anywhere, so you must keep a record. 

Attention: For more information, see “Storing PM Compass Data on an Oracle Database” in 
this guide. 
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 Service name/SID: Enter the unique name of your Oracle database instance as defined in 

your tnsnames.ora file. 

 Username: Enter the Oracle user schema with rights to modify the tables in the Oracle 
database.  

 Password: Enter the password associated with the Oracle Username. 

The following validations are performed: 

 SID is found in tnsnames.ora. 

 Username/password are correct. 

 The versions of Cobra and Open Plan (if installed) are supported. 

 The database has Unicode and case incentive indexes enabled. 

If any of these validations fail, the wizard displays a message, and the setup exits. 

 
Microsoft SQL Server Database 
On the Database Server (MSSQL) Setup Connection Information screen, enter the necessary 
information in the appropriate fields, and click Next. 

Attention: For steps to resolve Cobra and Open Plan database prerequisite requirements, 
see “Appendix H: Unicode and Case-Insensitive Prerequisites for Cobra and Open Plan 
Databases” in this guide. 
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 Database Server: Enter the name of the Database server and the database instance. 

 Select Windows Integrated or enter the SQL Login and SQL Password. 

 SQL Login: Enter a Microsoft SQL Database Server Login that is mapped to the 
db_owner role in the database. If you use the SQL Login and SQL Password 
fields, make sure that server security is configured to support Mixed Mode Security. 

 
 SQL Password: Enter the password associated with this SQL Login. 

 Database Name: If you have an existing Cobra database, enter your Cobra database name. 
If this is a new installation, enter the name of the new database you created to store your 
data.  

The following validations are performed: 

 Username/password are correct. 

 The database name is valid, and the user has access. 

 The versions of Cobra and Open Plan (if installed) are supported. 

 The version of SQL Server is supported. 

If any of these validations fail, the wizard displays a message, and the setup exits. 

11. Choose whether PM Compass integrates with the Microsoft Project scheduling tool. 

 

Note: Security best practice recommends not using the default SYSADMIN account (sa) for 
your SQL Server connection. 
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 If you are using Microsoft Project as a PM Compass scheduling tool, enter the UNC share 
location for the MSP Files and Process Logs folders, and click Next. 

 If you are not using Microsoft Project as a PM Compass scheduling tool, leave the UNC 
Share Path fields blank, and click Next.  

 

 

 
12. Choose whether PM Compass integrates with the Primavera P6 scheduling tool. 

 
13. If you are integrating PM Compass with Primavera P6, specify the Primavera P6 UNC share 

location where you want to store the process logs onto the Primavera P6 Integration Process 
Logs UNC Share Path screen. If the location for MSPLogs is already specified, the screen may 
not display. 

Attention: To manually configure the system after the installation, see “Appendix N: 
Integrating with Microsoft Project” in this guide. 

Attention: For information about the permissions required for these folders, see “File Share 
Requirements” in this guide. 
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14. On the Shared Network Folder screen, specify the UNC share location where you want to store 

links, general export files, and MPP export files. For example, 
\\<servername>\DeltekPMCompass\. 

 
15. On the Default Files Folders screen, the wizard displays the default Links, General Export, and 

MPP Export folder locations. You can edit these locations in PM Compass after the installation 
(Administration » System Settings » File Folders tab). 

Attention: For information about the permissions required for these folders, see “File Share 
Requirements” in this guide. 
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16. On the Script Options screen, select your database script option and click Next. 

 

 
The options available on this screen depends on whether you are using a new or existing 
database. Refer to the section below that corresponds to your database. 

 

Note: The wizard displays this screen if you have a Web/Application or Process server in 
your deployment. 

Note: The PM Compass installation does not automatically back up your database before applying 
any scripts. Make a backup of your database before selecting any of the options on this screen. 
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New Database 
If you have a new PM Compass database, or you are applying PM Compass for the first time to 
your Cobra or Open Plan database, your options are: 

 Automatically run scripts during the installation — creates the PM Compass tables: 
Select this option to create the PM Compass database tables automatically during 
installation. If you select this option, you do not need to run any scripts after the installation. 

 Create batch file (CreatePMCompassTables.bat) to run scripts manually: Select this 
option to create the PM Compass database tables manually after installation using a batch 
file. The batch file is named CreatePMCompassTables.bat and located in the <PM 
Compass Installation Directory>\Databases\Scripts folder. For example: C:\Program 
Files\Deltek\PMCompass\Scripts. 

 I will manually run the scripts to create the PM Compass tables. No batch file will be 
created: Select this option to manually create the PM Compass database tables after 
installation using the scripts located in the <PM Compass Installation 
Directory>\Databases\Scripts folder. For example: C:\Program 
Files\Deltek\PMCompass\Scripts. 

 

 
Existing Database 
If you have an existing PM Compass database, your options are: 

 Automatically run upgrade scripts during the installation: Select this option to upgrade 
the PM Compass database tables automatically during installation. If you select this option, 
you do not need to run any scripts manually after the installation. 

 Create batch file (UpgradePMCompassDB.bat) to run scripts manually: Select this 
option to upgrade the PM Compass database tables manually after installation using a batch 
file. The batch file is named UpgradePMCompassDB.bat and located in the <PM Compass 
Installation Directory>\Databases\Scripts folder. For example: C:\Program 
Files\Deltek\PMCompass\Scripts. 

If you select this option, the wizard displays a message reminding you to run the batch file 
and pointing you to the location of the file. 

 I will manually run the upgrade scripts. No batch file will be created: Select this option to 
manually upgrade the PM Compass database tables after installation using the scripts 
located in the <PM Compass Installation Directory>\Databases\Scripts folder. For example: 
C:\Program Files\Deltek\PMCompass\Scripts. 

 
17. If the SQL Report Database Server Setup Connection screen is displayed, specify the connection 

to the SQL Report Database server. 

Attention: For more information, see “Run Scripts Manually on a SQL Database” under 
“Appendix G: Using Microsoft SQL Server with PM Compass” in this guide. 

Note: Database conversion log files are saved into the <PM Compass Installation 
Directory>\Logs\ScriptLogs folder. For more information, see “Conversion Log” under 
“Check the Log Files  After Installation” in this guide. 

Attention: For more information, see “Run Scripts Manually on a SQL Database” under 
“Appendix G: Using Microsoft SQL Server with PM Compass” in this guide. 
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After you enter the required information and click Next, the setup connects to the report server. If 
an error is encountered, a dialog box displays asking for the Report server and Report Server 
URL information. 

Enter the necessary information in the appropriate fields and click Next. 

 

 
18. On the Load Reports screen, click Next. 

Attention: For more information, see “Configure Microsoft SQL Server Reporting Services” 
under “Appendix C: Microsoft SQL Server Reporting Services” in this guide. 

If you are unfamiliar with the Reporting Services configuration settings, see “Connect to the 
Report Server” in the same appendix. 
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19. If your Web server contains multiple web sites, the Specify Web Site screen displays. Select the 

website to which you will install PM Compass and click Next. 
20. On the Cobra Web Service URL screen, click Next. 

By default, the wizard installs the Cobra Web Service on each Web/Application and Process 
server. Deltek strongly advises against making any changes to this. 

 
21. Choose whether PM Compass will be available for Citrix users. 

 

Attention: For additional information when deploying with Citrix, see "Using PM Compass 
with Citrix or Remote Desktop (ClickOnce Bypass)" in the Deltek PM Compass Advanced 
Administration Guide. 
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Click Yes if you are using Open Plan in a Citrix environment. The installer will copy the PM 
Compass Web client ClickOnce Bypass files to a shared folder. The Open Plan client, running on 
a Citrix server, will then use this folder to launch the PM Compass client instead of launching it 
from a browser. 

 
On the Path to shared Citrix folder screen, enter the path to the shared Citrix folder, and click 
Next. 

 
22. On the Start Copying Files screen, review the installation settings, and click Next. 

During the installation, the setup also loads the report .rdl files onto the Reporting Services Web 
Service. If the upload fails, the wizard displays an error message. Click OK to continue with the 
installation. 

 
23. On the Deltek PM Compass Installation Wizard Complete screen, click Finish.  

If prompted, you can restart your computer after installing the Web/Application and Process 
server tiers on the server. 

Attention: For steps to reload reports manually after installation, see “Appendix E: Load 
Standard PM Compass Reports” and “Log Files Generated During the Report-Loading 
Process” in this guide. 
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Configuration 2 (Step 1) — Database Server Installation for Two-Server 
Deployment (Optional) 
This installation step is optional: 

 Oracle: Skip this step and proceed to Configuration 2 (Step 2). 

 SQL Server 

To install the Database server for a two-server deployment: 
1. Log into the server as the Domain Service Account user.  

If your server is not part of a domain, log in as a local account.  

 
2. Double-click the DeltekPMCompass85CumulativeUpdate<version>.exe file that you 

downloaded to run the installation.  

3. On the Prerequisites screen, click Next. 
This screen displays the items that the installation checks. If the criteria are not met for the 
particular tier, the wizard may display a message, or the setup may exit. 

4. On the Welcome to Deltek PM Compass Installation Wizard screen, click Next. 
5. On the Select Destination screen, specify the location where you want to install PM Compass and 

its components, and click Next. 
6. On the Number of Deltek PM Compass Servers screen, select the Two Servers option, and click 

Next. 

Note: If you encountered any errors during the installation, contact the Deltek Support Center and 
send the installation log file. For the log file location, see “Temporary Log Files and the Log Files 
Folder” in this guide. 

Note: If you prefer to restore the sample database later, you can restore it onto your Report 
Server database engine (Oracle) or Microsoft SQL Server database server (SQL Server) 
using the Deltek PM Compass Sample Database Restore Wizard. For more information, see 
“Appendix I: How to Run the Deltek PM Compass Sample Database Restore Wizard” in this 
guide. 

Attention: For more information, see “Domain Service Account vs. Default Local Account” in 
this guide. 
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7. On the Two-Tier – Role of Server screen, select the Database only option in Configuration 2, 

and click Next. 

 
8. On the Start Copying Files screen, review the installation settings, and click Next.  
9. On the Deltek PM Compass Installation Wizard Complete screen, click Finish.  

If prompted, you can restart your computer after installing the database tier on the server. 

 

Note: If you encountered any errors during the installation, contact the Deltek Support Center 
and send the installation log file. For the log file location, see “Temporary Log Files and the 
Log Files Folder” in this guide. 
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Proceed to Configuration 2 (Part 2): Web/Application, Report, and Process Server Installation for Two-
Server Deployment to install the Web/Application, Report, and Process Servers on the second server. 

Configuration 2 (Step 2) — Web/Application, Report, and Process Server 
Installation for Two-Server Deployment 
Follow this procedure to install the Web/Application, Report, and Process server tiers on a server.  

To install the Web/Application, Report, and Process servers for a two-server deployment: 
1. Log into the server that will serve as the Database and Report server as the Domain Service 

Account user.  

If your server is not part of a domain, log in as a local account.  

 
2. Double-click the DeltekPMCompass85CumulativeUpdate<version>.exe file that you 

downloaded to run the installation.  

3. On the Prerequisites screen, click Next. 
This screen displays the items that the installation checks. If the criteria are not met for the 
particular tier, the wizard may display a message, or the setup may exit. 

4. On the Welcome to Deltek PM Compass Installation Wizard screen, click Next. 
5. On the Select Destination screen, specify the location where you want to install PM Compass and 

its components, and click Next. 
6. On the Number of Deltek PM Compass Servers screen, select the Two Servers option, and click 

Next. 

 
7. On the Two-Tier – Role of Server screen, select the Web/Application/Report/Process option for 

Configuration 1, and click Next. 

Attention: For more information, see “Domain Service Account vs. Default Local Account” in 
this guide. 
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8. During installation, PM Compass utilizes an account to execute application processes on the 

server. Setup prompts you to provide the password under one of two conditions. 

 If you are logged in using a Domain Service Account, the Specify Service/Identify Account 
Password screen displays. Do one of the following:  

 Enter the password for the Domain Service Account and click Next. 
 If you do not want to use a domain account, select Use Default Local Account 

(DeltekPMCompass), and click Next.  

 

  

Attention: For more information, see “Domain Service Account vs. Default Local Account” in 
this guide. 
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 If you are logged in as a local (non-domain) account, or if you selected Use Default Local 
Account (DeltekPMCompass) on the Specify Service/Identity Account Password screen, 
the Password screen displays. 

  

 
After you enter your password and click Next, you must enter it again to verify that you have 
entered it correctly and click Next. 

9. On the Database Platform screen, select Oracle or Microsoft SQL Server, and click Next.  
10. The next screen depends on whether you selected Oracle or Microsoft SQL Server. Refer to 

the section below that corresponds to your selected database. 

Oracle Database 
The setup checks for supported versions of the Oracle Client driver. If it finds a supported 
version, setup continues. If not, the wizard displays a message informing you that no supported 
Oracle driver has been found, and the setup exits when you click OK. To resolve this, install the 
supported Oracle client driver version and run the wizard again. 

 
On the Oracle Connection Information screen, enter the necessary information in the appropriate 
fields, and click Next. 

Warning: You must specify a secure password for the account that meets the password 
policy. Setup does not save this password nor log it anywhere, so you must keep a record. 

Attention: For more information, see “Storing PM Compass Data on an Oracle Database” in 
this guide. 
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 Service name/SID: Enter the unique name of your Oracle database instance as defined in 

your tnsnames.ora file. 

 Username: Enter the Oracle user schema with rights to modify the tables in the Oracle 
database.  

 Password: Enter the password associated with the Oracle Username. 

The following validations are performed: 

 SID is found in tnsnames.ora. 

 Username/password are correct. 

 The versions of Cobra and Open Plan (if installed) are supported. 

 The database has Unicode and case incentive indexes enabled. 

If any of these validations fail, the wizard displays a message, and the setup exits. 

 
Microsoft SQL Server Database 
On the Database Server (MSSQL) Setup Connection Information screen, enter the necessary 
information in the appropriate fields, and click Next. 

Attention: For steps to resolve Cobra and Open Plan database prerequisite requirements, 
see “Appendix H: Unicode and Case-Insensitive Prerequisites for Cobra and Open Plan 
Databases” in this guide. 
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 Database Server: Enter the name of the Database server and the database instance. 

 Select Windows Integrated or enter the SQL Login and SQL Password. 

 SQL Login: Enter a Microsoft SQL Database Server Login that is mapped to the 
db_owner role in the database. If you use the SQL Login and SQL Password 
fields, make sure that server security is configured to support Mixed Mode Security. 

 
 SQL Password: Enter the password associated with this SQL Login. 

 Database Name: If you have an existing Cobra database, enter your Cobra database name. 
If this is a new installation, enter the name of the new database you created to store your 
data.  

The following validations are performed: 

 Username/password are correct. 

 The database name is valid, and the user has access. 

 The versions of Cobra and Open Plan (if installed) are supported. 

 The version of SQL Server is supported. 

If any of these validations fail, the wizard displays a message, and the setup exits. 

11. Choose whether PM Compass integrates with the Microsoft Project scheduling tool. 

 

Note: Security best practice recommends not using the default SYSADMIN account (sa) for 
your SQL Server connection. 
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 If you are using Microsoft Project as a PM Compass scheduling tool, enter the UNC share 
location for the MSP Files and Process Logs folders, and click Next. 

 If you are not using Microsoft Project as a PM Compass scheduling tool, leave the UNC 
Share Path fields blank, and click Next.  

 

 

 
12. Choose whether PM Compass integrates with the Primavera P6 scheduling tool. 

 
13. If you are integrating PM Compass with Primavera P6, specify the Primavera P6 UNC share 

location where you want to store the process logs onto the Primavera P6 Integration Process 
Logs UNC Share Path screen. If the location for MSPLogs is already specified, the screen may 
not display. 

Attention: To manually configure the system after the installation, see “Appendix N: 
Integrating with Microsoft Project” in this guide. 

Attention: For information about the permissions required for these folders, see “File Share 
Requirements” in this guide. 
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14. On the Shared Network Folder screen, specify the UNC share location where you want to store 

links, general export files, and MPP export files. For example, 
\\<servername>\DeltekPMCompass\. 

 
15. On the Default Files Folders screen, the wizard displays the default Links, General Export, and 

MPP Export folder locations. You can edit these locations in PM Compass after the installation 
(Administration » System Settings » File Folders tab). 

Attention: For information about the permissions required for these folders, see “File Share 
Requirements” in this guide. 
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16. If you have an existing PM Compass database, the utility displays the Database Upgrade Script 

Options screen. Select a database script option and click Next. 
 Automatically run upgrade scripts during the installation: Select this option to upgrade 

the PM Compass database tables automatically during installation. If you select this option, 
you do not need to run any scripts manually after the installation. 

 Create batch file (UpgradePMCompassDB.bat) to run scripts manually: Select this 
option to upgrade the PM Compass database tables manually after installation using a batch 
file. The batch file is named UpgradePMCompassDB.bat and is located in the <PM 
Compass Installation Directory>\Databases\Scripts folder.  

For example: C:\Program Files\Deltek\PMCompass\Scripts. 

If you select this option, the setup displays a message reminding you to run the batch file and 
pointing you to the location of the file. 

 I will manually run the upgrade scripts. No batch file will be created: Select this option to 
manually upgrade the PM Compass database tables after installation using the scripts 
located in the <PM Compass Installation Directory>\Databases\Scripts folder. For example: 
C:\Program Files\Deltek\PMCompass\Scripts. 

 
Setup is ready to connect to the Report Server. PM Compass checks the Reporting Services 
Configuration Settings. Since this option is only for installing the Web/Application and Process 
server tiers, it does not have the connection information for your Report server.  

The PM Compass installation connects to the Report server and checks if it is the recommended 
version. If it is not the recommended version, a warning message informs you that the setup is 
unable to validate all the specified information and to see the installation log for more details. 
Click OK to continue with the installation. 

17. If the SQL Report Database Server Setup Connection screen is displayed, specify the connection 
to the SQL Report Database server. 

Attention: For more information, see Running Scripts Manually on SQL Databases. 
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After you enter the required information and click Next, the setup connects to the Report server. If 
an error is encountered, a dialog box displays asking for the Report server and Report Server 
URL information. 

Enter the necessary information in the appropriate fields, and click Next. 

 
18. On the Load Reports screen, select or clear the Load Reports checkbox. 
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If you have multiple Web/Application servers connected to the same Report Server, you only 
need to load the reports the first time you run the installer on your first Web/Application server. 
You can clear the Load Reports checkbox on the subsequent Web/Application server installations 
since it reloads the same reports each time you run the installer on the additional Web/Application 
servers. 

19. If your Web server contains multiple web sites, the Specify Web Site screen is displayed. Select 
the web site to which you will install PM Compass and click Next.  

 
20. On the Cobra Web Service URL screen, click Next. 

By default, the wizard installs the Cobra Web Service on each Web/Application and Process 
server. Deltek strongly advises against making any changes to this. 

Note: This screen does not display if you do not have multiple web sites on your server. 
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21. Choose whether PM Compass will be available for Citrix users. 

 
Click Yes if you are using Open Plan in a Citrix environment. The installer will copy the PM 
Compass Web client ClickOnce Bypass files to a shared folder. The Open Plan client, running on 
a Citrix server, will then use this folder to launch the PM Compass client instead of launching it 
from a browser. 

 
On the Path to shared Citrix folder screen, enter the path to the shared Citrix folder, and click 
Next. 

Attention: For additional information when deploying with Citrix, see "Using PM Compass 
with Citrix or Remote Desktop (ClickOnce Bypass)" in the Deltek PM Compass Advanced 
Administration Guide. 
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22. On the next screen, PM Compass displays a message informing you that you will have the option 

to restore a PM Compass sample database once the setup is complete. Click OK to continue. 

23. On the Start Copying Files screen, review the installation settings, and click Next. 
During the installation, the setup also loads the report .rdl files onto the Reporting Services Web 
Service. If the upload fails, the wizard displays an error message. Click OK to continue with the 
installation. 

 
24. On the Ready to Install screen, click Install. 
25. On the Deltek PM Compass Installation Wizard Complete screen, click Finish.  

If prompted, you can restart your computer after installing the Web/Application, Report, and 
Process server tiers on the server. 

 

 

Attention: For steps to reload reports manually after installation, see “Appendix E: Load 
Standard PM Compass Reports” and “Log Files Generated During the Report-Loading 
Process” in this guide. 

Note: If you encountered any errors during the installation, contact the Deltek Support Center and 
send the installation log file. For the log file location, see “Temporary Log Files and the Log Files 
Folder” in this guide. 

Note: If you prefer to restore the sample database, you can restore it onto your Report Server 
database engine (Oracle) or Microsoft SQL Server database server (SQL Server) using the Deltek PM 
Compass Sample Database Restore Wizard. For more information, see “Appendix I: How to Run the 
Deltek PM Compass Sample Database Restore Wizard” in this guide. 
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Install on Three or More Servers Steps 
The Three or More Servers installation model is designed for large organizations with large processing 
requirements and load balancing needs. Firms deploying this model must have proficient firewall 
management.  

In order to install PM Compass to run on three or more servers, you will log into each of the servers and 
run the installation tier from that server. During the installation, you will be asked which tier you are 
installing:  

 Database Server: This installation is only run if you are storing your data on a SQL Server 
database. If you intend to store your data on an Oracle database, skip this step.  

 Report Server: This installation will be performed on a server where SQL Server Reporting 
Services (SSRS) is to be installed. The server will be used to generate reports and dashpart 
reporting. If you are an Oracle user, the sample database backup will be copied to this server.  

 Process Server: PM Compass has a Process server that looks for scheduled requests and 
performs actions such as completing a change request. You can have one or more Process 
servers to manage these requests.  

 Web/Application Server: The PM Compass application is run on a server with IIS installed. The 
application server takes requests from the client and makes requests for the following: 

 The Process server 

 The Cobra engine 

 The Open Plan engine  

Typically, you disable the Process Server services on this server to free up resources for the application 
and the Cobra and Open Plan engines. This server can be load balanced using software or hardware.  

 

 

Step 1: Install the Database Tier (Optional) 
This installation step is optional. 

 Oracle: Do not run any PM Compass installations on the Oracle Database server. Any 
connections that are needed are made to the database when you run the installer on your 
web/application server. 

NEXT STEP: See Step 2: Install the Report Server. 
 SQL Server: You do not need to perform this installation if your database tier is on its own server 

unless you plan to use the sample database.  

Attention: For more information, see the Deltek PM Compass Advanced Administration Guide. 

Note:  
 The Database, Web/Application, and Report servers must all be on different servers. 

 To implement the three or more servers deployment model, follow distinct installation 
procedures for each server: install the Web and Application tier on one server, the Report tier 
on a second server, and the Database tier on a third server. 
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 If you are not using a Domain Service Account, you must run this installation to create a local 
account named DeltekPMCompass to match the default local account created by the installer on 
the Web/Application and Process server tiers. 

 You must ensure that the password is the same for the local DeltekPMCompass account on each 
of the servers. 

 You must add the account to the db_owner role in the ReportServer, ReportServerTempDB, and 
your PM Compass database.  

  

To install the Database tier for a three or more-server deployment: 
1. Log into the Database server as the Domain Service Account user. 

If your server is not part of a domain, log in as a local account.  

 
2. Double-click the DeltekPMCompass85CumulativeUpdate<version>.exe file that you 

downloaded to run the installation.  

3. On the Prerequisites screen, click Next. 
This screen displays the items that the installation checks. If the criteria are not met for the 
particular tier, the wizard may display a message, or the setup may exit. 

4. On the Welcome to Deltek PM Compass Installation Wizard screen, click Next. 
5. On the Select Destination screen, specify the location where you want to install PM Compass and 

its components, and click Next. 
6. On the Number of Deltek PM Compass Servers screen, select the Three or More Servers 

option, and click Next. 

Attention: For more information, see “How to Give Your Account Proper Rights and Privileges in 
Reporting Services” under “Appendix C: Microsoft SQL Server Reporting Services” in this guide. 

Attention: For more information, see “Domain Service Account vs. Default Local Account” in 
this guide. 
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7. On the Select Server Role screen, select the Database Server option, and click Next. 

 
8. On the Start Copying Files screen, review the installation settings, and click Next. 
9. On the Deltek PM Compass Installation Wizard Complete screen, click Finish.  

If prompted, you can restart your computer after installing the database tier on the server. 

 
Proceed to Step 2: Install the Report Server. 

Note: If you encountered any errors during the installation, contact the Deltek Support Center and 
send the installation log file. For the log file location, see “Temporary Log Files and the Log Files 
Folder” in this guide. 
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Step 2: Install the Report Server 
Before you run the Report server installation, ensure that you have SQL Server Reporting Services 
(SSRS) installed and configured.  

 
If you already have SSRS installed, verify that its configuration aligns with the information provided in this 
guide. 

 
Once you have confirmed proper SSRS installation and configuration, and you know how to connect to 
the Web Service, proceed with installing the Report server tier. 

To install the Report server for a three or more-server deployment: 
1. Log into the Report server as the Domain Service Account user. 

2. Double-click the DeltekPMCompass85CumulativeUpdate<version>.exe file that you 
downloaded to run the installation.  

3. On the Prerequisites screen, click Next. 
This screen displays the items that the installation checks. If the criteria are not met for the 
particular tier, the wizard may display a message, or the setup may exit. 

4. On the Welcome to Deltek PM Compass Installation Wizard screen, click Next. 
5. On the Select Destination screen, specify the location where you want to install PM Compass and 

its components, and click Next. 
6. On the Number of Deltek PM Compass Servers screen, select the Three or More Servers 

option, and click Next. 

Attention: For more information, see “Appendix C: Microsoft SQL Server Reporting Services” in this 
guide. 

Attention: For more information, see “Configure Microsoft SQL Server Reporting Services” under 
“Appendix C: Microsoft SQL Server Reporting Services” in this guide. 

If you are unfamiliar with the Reporting Services configuration settings, see “Connect to the Report 
Server” in the same appendix. 
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7. On the Select Server Role screen, select the Report Server option, and click Next. 

 
8. Setup displays a message asking if you have an Oracle database. 

 Select Yes to verify the Oracle version and client installation. 

 Select No to continue. 

9. During installation, PM Compass utilizes an account to execute application processes on the 
server. Setup prompts you to provide the password under one of two conditions. 

 If you are logged in using a Domain Service Account, the Specify Service/Identify Account 
Password screen displays. Do one of the following:  

 Enter the password for the Domain Service Account, and click Next. 
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 If you do not want to use a domain account, select Use Default Local Account 
(DeltekPMCompass), and click Next.  

 

  
  If you are logged in as a local (non-domain) account, or if you selected Use Default Local 

Account (DeltekPMCompass) on the Specify Service/Identity Account Password screen, 
the Password screen displays. 

  

Attention: For more information, see “Domain Service Account vs. Default Local Account” in 
this guide. 
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After you enter your password and click Next, you must enter it again to verify that you have 
entered it correctly and click Next. 

10. On the Specify Report Server and Report Server URL Information screen, enter the necessary 
information in the appropriate fields, and click Next. 
This screen displays if the setup is unable to determine the Report server information. 

 

 
11. On the Start Copying Files screen, review the installation settings, and click Next.  
12. On the Deltek PM Compass Installation Wizard Complete screen, click Finish.  

If prompted, you can restart your computer after installing the Report server tier on the server. 

 
Proceed to Step 3: Install the Web/Application Server to install the Web/Application Server on a different 
server. 

Step 3: Install the Web/Application Server 
Follow this procedure to install the Web/Application server. 

Warning: You must specify a secure password for the account that meets the password 
policy. Setup does not save this password nor log it anywhere, so you must keep a record. 

Attention: For more information, see “Configure Microsoft SQL Server Reporting Services” 
under “Appendix C: Microsoft SQL Server Reporting Services” in this guide. 

If you are unfamiliar with the Reporting Services configuration settings, see “Connect to the 
Report Server” in the same appendix. 

Note: If you encountered any errors during the installation, contact the Deltek Support Center and 
send the installation log file. For the log file location, see “Temporary Log Files and the Log Files 
Folder” in this guide. 
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To install the Web/Application Server for a three or more-server deployment: 
1. Log into the Web/Application server as the Domain Service Account user. 

2. Double-click the DeltekPMCompass85CumulativeUpdate<version>.exe file that you 
downloaded to run the installation.  

3. On the Prerequisites screen, click Next. 
This screen displays the items that the installation checks. If the criteria are not met for the 
particular tier, the wizard may display a message, or the setup may exit. 

4. On the Welcome to Deltek PM Compass Installation Wizard screen, click Next. 
5. On the Select Destination screen, specify the location where you want to install PM Compass and 

its components, and click Next. 
6. On the Number of Deltek PM Compass Servers screen, select the Three or More Servers 

option, and click Next. 

 
7. On the Select Server Role screen, select the Web/Application Server option, and click Next. 
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8. During installation, PM Compass utilizes an account to execute application processes on the 

server. Setup prompts you to provide the password under one of two conditions. 

 If you are logged in using a Domain Service Account, the Specify Service/Identify Account 
Password screen displays. Do one of the following:  

 Enter the password for the Domain Service Account and click Next. 
 If you do not want to use a domain account, select Use Default Local Account 

(DeltekPMCompass), and click Next.  

 

  

Attention: For more information, see “Domain Service Account vs. Default Local Account” in 
this guide. 
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  If you are logged in as a local (non-domain) account, or if you selected Use Default Local 
Account (DeltekPMCompass) on the Specify Service/Identity Account Password screen, 
the Password screen displays. 

  

 
After you enter your password and click Next, you must enter it again to verify that you have 
entered it correctly and click Next. 

9. On the Database Platform screen, select Oracle or Microsoft SQL Server, and click Next.  
10. The next screen depends on whether you selected Oracle or Microsoft SQL Server. Refer to 

the section below that corresponds to your selected database. 

Oracle Database 
The setup checks for supported versions of the Oracle Client driver. If it finds a supported 
version, setup continues. If not, the wizard displays a message informing you that no supported 
Oracle driver has been found, and the setup exits when you click OK. To resolve this, install the 
supported Oracle client driver version and run the wizard again. 

 
On the Oracle Connection Information screen, enter the necessary information in the appropriate 
fields, and click Next. 

Warning: You must specify a secure password for the account that meets the password 
policy. Setup does not save this password nor log it anywhere, so you must keep a record. 

Attention: For more information, see “Storing PM Compass Data on an Oracle Database” in 
this guide. 
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 Service name/SID: Enter the unique name of your Oracle database instance as defined in 

your tnsnames.ora file. 

 Username: Enter the Oracle user schema with rights to modify the tables in the Oracle 
database.  

 Password: Enter the password associated with the Oracle Username. 

The following validations are performed: 

 SID is found in tnsnames.ora. 

 Username/password are correct. 

 The versions of Cobra and Open Plan (if installed) are supported. 

 The database has Unicode and case incentive indexes enabled. 

If any of these validations fail, the wizard displays a message, and the setup exits. 

 
Microsoft SQL Server Database 
On the Database Server (MSSQL) Setup Connection Information screen, enter the necessary 
information in the appropriate fields, and click Next. 

Attention: For steps to resolve Cobra and Open Plan database prerequisite requirements, 
see “Appendix H: Unicode and Case-Insensitive Prerequisites for Cobra and Open Plan 
Databases” in this guide. 



Installation Steps (PM Compass New Installs) 

Installation Guide 82 

 

 
 Database Server: Enter the name of the Database server and the database instance. 

 Select Windows Integrated or enter the SQL Login and SQL Password. 

 SQL Login: Enter a Microsoft SQL Database Server Login that is mapped to the 
db_owner role in the database. If you use the SQL Login and SQL Password 
fields, make sure that server security is configured to support Mixed Mode Security. 

 
 SQL Password: Enter the password associated with this SQL login. 

 Database Name: If you have an existing Cobra database, enter your Cobra database name. 
If this is a new installation, enter the name of the new database you created to store your 
data.  

The following validations are performed: 

 Username/password are correct. 

 The database name is valid, and the user has access. 

 The versions of Cobra and Open Plan (if installed) are supported. 

 The version of SQL Server is supported. 

If any of these validations fail, the wizard displays a message, and the setup exits. 

11. Choose whether PM Compass integrates with the Microsoft Project scheduling tool. 

 

Note: Security best practice recommends not using the default SYSADMIN account (sa) for 
your SQL Server connection. 
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 If you are using Microsoft Project as a PM Compass scheduling tool, enter the UNC share 
location for the MSP Files and Process Logs folders, and click Next. 

 If you are not using Microsoft Project as a PM Compass scheduling tool, leave the UNC 
Share Path fields blank, and click Next.  

 

 

 
12. Choose whether PM Compass integrates with the Primavera P6 scheduling tool. 

 
13. If you are integrating PM Compass with Primavera P6, specify the Primavera P6 UNC share 

location where you want to store the process logs onto the Primavera P6 Integration Process 
Logs UNC Share Path screen. If the location for MSPLogs is already specified, the screen may 
not display. 

Attention: To manually configure the system after the installation, see “Appendix N: 
Integrating with Microsoft Project” in this guide. 

Attention: For information about the permissions required for these folders, see “File Share 
Requirements” in this guide. 
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14. On the Shared Network Folder screen, specify the UNC share location where you want to store 

links, general export files, and MPP export files. For example, 
\\<servername>\DeltekPMCompass\. 

 
15. On the Default Files Folders screen, the wizard displays the default Links, General Export, and 

MPP Export folder locations. You can edit these locations in PM Compass after the installation 
(Administration » System Settings » File Folders tab). 

Attention: For information about the permissions required for these folders, see “File Share 
Requirements” in this guide. 
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16. On the Script Options screen, select your database script option and click Next. 

The options available on this screen depends on whether you are using a new or existing 
database. Refer to the section below that corresponds to your database. 

 
New Database 
If you have a new PM Compass database, or you are applying PM Compass for the first time to 
your Cobra or Open Plan database, your options are: 

 Automatically run scripts during the installation — creates the PM Compass tables: 
Select this option to create the PM Compass database tables automatically during 
installation. If you select this option, you do not need to run any scripts after the installation. 

 Create batch file (CreatePMCompassTables.bat) to run scripts manually: Select this 
option to create the PM Compass database tables manually after installation using a batch 
file. The batch file is named CreatePMCompassTables.bat and located in the <PM 
Compass Installation Directory>\Databases\Scripts folder. For example: C:\Program 
Files\Deltek\PMCompass\Scripts. 

 I will manually run the scripts to create the PM Compass tables. No batch file will be 
created: Select this option to manually create the PM Compass database tables after 
installation using the scripts located in the <PM Compass Installation 
Directory>\Databases\Scripts folder. For example: C:\Program 
Files\Deltek\PMCompass\Scripts. 

 

Note: The PM Compass installation does not automatically back up your database before applying 
any scripts. Make a backup of your database before selecting any of the options on this screen. 

Attention: For more information, see “Run Scripts Manually on SQL Databases” under  
“Appendix G: Run Scripts Manually on a SQL Database” in this guide. 
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Existing Database 
If you have an existing PM Compass database, your options are: 

 Automatically run upgrade scripts during the installation: Select this option to upgrade 
the PM Compass database tables automatically during installation. If you select this option, 
you do not need to run any scripts manually after the installation. 

 Create batch file (UpgradePMCompassDB.bat) to run scripts manually: Select this 
option to upgrade the PM Compass database tables manually after installation using a batch 
file. The batch file is named UpgradePMCompassDB.bat and located in the <PM Compass 
Installation Directory>\Databases\Scripts folder. For example: C:\Program 
Files\Deltek\PMCompass\Scripts. 

If you select this option, the wizard displays a message reminding you to run the batch file 
and pointing you to the location of the file. 

 I will manually run the upgrade scripts. No batch file will be created: Select this option to 
manually upgrade the PM Compass database tables after installation using the scripts 
located in the <PM Compass Installation Directory>\Databases\Scripts folder. For example: 
C:\Program Files\Deltek\PMCompass\Scripts. 

 
17. If the SQL Report Database Server Setup Connection screen displays, specify the connection to 

the SQL Report Database server. 

 

Note: Database conversion log files are saved into the <PM Compass Installation 
Directory>\Logs\ScriptLogs folder. For more information, see “Conversion Log” under 
“Check the Log Files After Installation” in this guide, 

Attention: For more information, see “Run Scripts Manually on SQL Databases” under  
“Appendix G: Run Scripts Manually on a SQL Database” in this guide. 
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After you enter the required information and click Next, the setup connects to the Report server. If 
an error is encountered, a dialog box displays asking for the Report server and Report Server 
URL information. 

Enter the necessary information in the appropriate fields and click Next. 

 

 
18. If your web server contains multiple web sites, the Specify Web Site screen displays. Select the 

website to which you will install PM Compass and click Next. 
19. On the Cobra Web Service URL screen, click Next. 

By default, the wizard installs the Cobra Web Service on each Web/Application and Process 
server. Deltek strongly advises against making any changes to this. 

Attention: For more information, see “Configure Microsoft SQL Server Reporting Services” 
under “Appendix C: Microsoft SQL Server Reporting Services” in this guide. 

If you are unfamiliar with the Reporting Services configuration settings, see “Connect to the 
Report Server” in the same appendix. 
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20. On the Start Copying Files screen, review the installation settings, and click Next. 

During the installation, the setup also loads the report .rdl files onto the Reporting Services Web 
Service. If the upload fails, the wizard displays an error message. Click OK to continue with the 
installation. 

 
21. On the Ready to Install screen, click Install. 
22. On the Deltek PM Compass Installation Wizard Complete screen, click Finish.  

If prompted, you can restart your computer after installing the Web/Application tier on the server. 

 

 
Proceed to Step 4: Install the Process Server to install the Process Server on a different server. 

Step 4: Install the Process Server 
Follow this procedure to install the Process server. 

Attention: For steps to reload reports manually after installation, see “Appendix E: Load 
Standard PM Compass Reports” and “Log Files Generated During the Report-Loading 
Process” in this guide. 

Note: If you encountered any errors during the installation, contact the Deltek Support Center and 
send the installation log file. For more information on the log file location, see “Temporary Log Files 
and the Log Files Folder” in this guide. 

Note: If you prefer to restore the sample database, you can restore it onto your Report Server 
database engine (Oracle) or Microsoft SQL Server database server (SQL Server) using the Deltek PM 
Compass Sample Database Restore Wizard. For more information, see “Appendix I: How to Run the 
Deltek PM Compass Sample Database Restore Wizard” in this guide. 
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To install the Process server for a three or more-server deployment: 
1. Log into the Process server as the Domain Service Account user. 

2. Double-click the DeltekPMCompass85CumulativeUpdate<version>.exe file that you 
downloaded to run the installation.  

3. On the Prerequisites screen, click Next. 
This screen displays the items that the installation checks. If the criteria are not met for the 
particular tier, the wizard may display a message, or the setup may exit. 

4. On the Welcome to Deltek PM Compass Installation Wizard screen, click Next. 
5. On the Select Destination screen, specify the location where you want to install PM Compass and 

its components, and click Next. 
6. On the Number of Deltek PM Compass Servers screen, select the Three or More Servers 

option, and click Next. 

 
7. On the Select Server Role screen, select the Process Server option, and click Next. 
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8. Setup displays a message asking if you have an Oracle database. 

 Select Yes to verify the Oracle version and client installation. 

 Select No to continue. 

9. If IIS is enabled on the Process server, PM Compass displays a warning message stating that IIS 
is not required. Click OK. 

10. During installation, PM Compass utilizes an account to execute application processes on the 
server. Setup prompts you to provide the password under one of two conditions. 

 If you are logged in using a Domain Service Account, the Specify Service/Identify Account 
Password screen displays. Do one of the following:  

 Enter the password for the Domain Service Account and click Next. 
 If you do not want to use a domain account, select Use Default Local Account 

(DeltekPMCompass), and click Next.  

 

Attention: For more information, see “Domain Service Account vs. Default Local Account” in 
this guide. 
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  If you are logged in as a local (non-domain) account, or if you selected Use Default Local 

Account (DeltekPMCompass) on the Specify Service/Identity Account Password screen, 
the Password screen displays. 

  

 
After you enter your password and click Next, you must enter it again to verify that you have 
entered it correctly and click Next. 

11. On the Path to Folder of Existing Databases.enc screen (for Weblink), click Browse to locate the 
Web server containing databases.enc, and click Next. 

Warning: You must specify a secure password for the account that meets the password 
policy. Setup does not save this password nor log it anywhere, so you must keep a record. 
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The default location (if using the hidden administrative share) is: \\<web/application 
server>\C$\Program Files\Deltek\EPMSA\. 

 
12. Setup displays a message that you need to copy databases.enc from the Web/Application server 

when changes are made to the file. Click OK. 

The databases.enc file resides on the Web/Application servers. During the installation of any 
dedicated Process server, this file is copied from the Web/Application server to those servers. 
Weblink maintains a list of databases that are displayed on the Web/Application server when 
logging into PM Compass. In addition, it provides instructions to the dedicated Process server on 
how to connect to the Database and Report servers. 

Launch the Weblink utility on the Web/Application server. 

 
The default location of the databases.enc file on the Web/Application servers as well as the 
dedicated Process server is "<C:\Program Files\Deltek\EPMSA>." 

Note: If you make changes in Weblink and you are not using a shared databases.enc file, 
you must copy the databases.enc file from the server where you used Weblink to all other 
Web/Application Server and Process Server servers and restart the Deltek PM Compass 
Process Server service on each server. This ensures that each server is using the same 
configuration. 

If you have multiple servers and you want to automate the process, Deltek has a script that 
you can use. Refer to KB article #85452. Deltek recommends that you test the script before 
using it on your production servers. 

For more information about shared databases.enc, see “Configure a Shared Location for 
Databases.enc” in the Deltek PM Compass Advanced Administration Guide. 
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13. On the Cobra Web Service URL screen, if you modified the Cobra Web Service installed by PM 

Compass to use a dedicated server, replace the localhost entry with the name of your Cobra 
Web Service server. Otherwise, accept the entry or leave the field blank and click Next. 

 

 
14. On the Start Copying Files screen, review the installation settings and click Next. 
15. On the Deltek PM Compass Installation Wizard Complete screen, click Finish.  

If prompted, you can restart your computer after installing the Process server tier on the server. 

 

Note: Deltek does not recommend creating a folder share to the PM Compass folder 
containing the databases.enc file on the Web server. Deltek recommends that you use the 
hidden administrative share to access the drive and folder. 

For example, \\WebServerName\C$\Program Files\Deltek\PMCompass. 

Note: By default, the wizard installs the Cobra Web Service on each Web/Application and 
Process server. Deltek strongly advises against making any changes to this. 

Note: If you encountered any errors during the installation, contact the Deltek Support Center 
and send the installation log file. For more information on the log file location, see “Temporary 
Log Files and the Log Files Folder” in this guide. 

 Repeat this procedure for any server where you want to install additional Process 
servers. 

 To add and configure dedicated Process servers in PM Compass, see “Step 2” in the 
Web/Application Server Post-Installation Checklist. 
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Installing Cumulative Updates/HotFix  
The PM Compass Cumulative Update installer includes the full PM Compass installation along with the 
integration installers for both Cobra and Open Plan. 

To install the cumulative update: 
1. From the Deltek Software Manager, download the cumulative update from the HotFix section.  

2. On each Application and Web server, launch the 
DeltekPMCompass85CumulativeUpdate<version>.exe. 

Install the Cobra and Open Plan Integration Files 
If you need to install the Cobra and Open Plan integration files, run the PM Compass installer and select 
the Cobra and Open Plan integration versions you want to install on the Confirm Installation Features 
screen. The installation wizard automatically selects the recommended Cobra and Open Plan integration 
files for installation, based on the data found in your PM Compass database tables. 

If there is no PM Compass CU release, but a Cobra integration file is available, download it from DSM 
and run the installer manually. 

Download the Integration File 
Use these instructions to download the integration file from DSM. 

To download the integration file: 
1. Using your browser, go to https://dsm.deltek.com.  

2. Click Launch Deltek Software Manager.  
3. Log in using your Deltek Support Center credentials.  

4. In the left pane of the Deltek Software Manager, expand your Deltek product.  

5. Expand the Sub-Release folder for your product, and select the update to download.  

6. Click Download at the bottom of the screen. 

Install the Integration File 
You must run the executable (.exe) file on all of the Web/Application Server and Process Server 
machines. 

To install the integration file: 
1. Run the executable file. 

2. On the Welcome screen, click Next. 
3. On the Ready to Install screen, click Install. 
4. On the Finish screen, click Finish. 

https://dsm.deltek.com./
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Install the Open Plan Add-in 
If you are using Open Plan in the change management process, you must install the Open Plan Add-in on 
every client/desktop (not the PM Compass server) that will use change management. 

 For a multi-user installation, the Open Plan Add-in must be installed on the file server where the 
Open Plan multi-user installation is located. 

 For all other installation types (complete or Citrix, which is a complete installation), the Open Plan 
Add-in must be installed on the server where the Open Plan client is installed. 

 
Follow this procedure to install or upgrade the Open Plan Add-In. The Open Plan Add-In installation 
program will detect and upgrade any existing versions. 

To install or upgrade the Open Plan Add-in: 
1. Launch the DeltekOpenPlanAddinForPMC85.exe file.  

 
2. On the Welcome to the Deltek Open Plan Add-In Wizard screen, click Next. 

 
3. On the Setup Type screen, select whether your PM Compass server uses https or http. 

Attention: To ensure that each desktop has the correct version of Open Plan installed before 
installing the PM Compass Change Request Add-In, see “Client Software Requirements” in this 
guide. 

Note: Before running this installation, you must close Open Plan. If Open Plan is running, a 
message will appear asking if you want the setup to close it. Click Yes to allow the setup to 
close Open Plan. If you click No, you need to save your work and close Open Plan manually 
before proceeding with the installation. 

Note: Due to enhanced security in Windows Server, Deltek recommends using the Run as 
Administrator option when launching installation executables, even if the logged-in user has 
local administrative rights. To do this, right click the installation executable file in Windows 
Explorer and select Run as Administrator to launch the program. 
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4. The installer displays a message asking if PM Compass is deployed with Citrix. 

 
Click Yes if you are using Open Plan in a Citrix environment. The installer will copy the PM 
Compass Web client ClickOnce Bypass files to a shared folder. The Open Plan client, running on 
a Citrix server, will then use this folder to launch the PM Compass client instead of launching it 
from a browser. 

5. On the Path to shared Citrix folder screen, specify the shared folder containing the 
ClickOnceBypassPMCompass files, and click Next. 

 

Note: This screen displays only during new installation and based on whether you are using 
http or https URL connection to launch PM Compass. 

Note: In the Citrix field, you may enter a UNC path or a local path that points to the location 
of the extracted PM Compass client files. 
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6. On the Welcome to the Deltek Open Plan Add-In screen, click Install to begin the installation. 

 
7. On the InstallShield Wizard Complete screen, click Finish. 

Confirm the Open Plan Data Source on the Client 
The Open Plan Data Source must use the same server’s name, database name, and database username 
as entered into Weblink. 

Attention: For additional information when deploying with Citrix, see "Using PM Compass 
with Citrix or Remote Desktop (ClickOnce Bypass)" in the Deltek PM Compass Advanced 
Administration Guide. 
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To confirm the Open Plan data source on the client: 
 For Oracle, the Service name/SID (as defined in tnsnames.ora) and Username values must 

match the Weblink entries in PM Compass. 

 For SQL Server, the Database Server, Database Name, and SQL Login values must match the 
Weblink entries in PM Compass. 

Configure Open Plan for the PM Compass Add-In 
For the Open Plan PM Compass Change Requests Add-in to work, it requires access to the PM Compass 
application server. During the installation of PM Compass, the Open Plan database is updated to include 
the PM Compass application URL. However, if you opted to update the databases manually during 
installation, the PM Compass application URL would not be added unless you executed the SQL 
statement on your database to include it. 

Add or Edit the PM Compass Application Server Address on 
the Open Plan Database 
Follow this procedure to add or edit the _PMCWEBSERVICEURL application setting in Open Plan. This 
setting must exactly match the application URL defined in PM Compass on the Administration » System 
Settings » General tab. In addition, you should access PM Compass using the same URL from a 
browser. For example: http://<pmcwebservername>/pmcompass. 

To add the PM Compass application server address to the Open Plan database: 
1. Log into Open Plan as a member of the SYSADMIN group or as the user SYSADMIN. 

2. Click the product icon  and click Preferences » Application. 

3. On the Advanced tab of the Application Preferences dialog box, click the Defaults button to 
display the System Preferences Defaults dialog box. 

4. In the System Preferences Defaults dialog box, scroll down and look for the category titled 
_PMCWEBSERVICEURL.  

If this category does not exist, add it in the first blank row. 

5. In the Default Value field, enter the PM Compass application server address. 

For example, enter https://<pmcwebservername>/pmcompass where <pmcwebservername> 
is replaced with the PM Compass Web/Application server name. 

6. Click OK. 
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PM Compass Upgrade Installation Steps 
This chapter includes sections related to upgrading PM Compass. 

Deltek Cobra and Open Plan 
Before upgrading, you must have Cobra and Open Plan upgraded to a supported version. 

 
Deltek recommends that you make a backup of your production database before installing PM Compass.  

To install a test version of PM Compass into a database that is not your production database, you have 
two options: 

 Copy your production database to a new database and verify that Cobra and Open Plan function 
correctly when connected to it. Then, install PM Compass into the new database. This approach 
retains all security settings, saved reports, projects, and other data. 

 Install PM Compass into a new database, then restore the Cobra projects into it. 

Upgrading from PM Compass 8.1 
PM Compass 8.1 was a 32-bit application. By default, Windows installs 32-bit applications into the 
C:\Program Files (x86) folder and 64-bit applications into the C:\Program Files folder. PM Compass 8.5 is 
a 64-bit application. 

If you accepted the default installation path, the application would have been installed in the C:\Program 
Files (x86)\Deltek\PMCompass and C:\Program Files (x86)\Deltek\EPMSA folders. 

Since Windows installs 64-bit applications in the C:\Program Files folder by default, upgrading from a 
default 32-bit installation location will not overwrite your existing files. Instead, it will install to the 
C:\Program Files folder or an alternate folder that you select during the installation. 

The PM Compass upgrade installer detects your previous installation location. If that location is in an x86 
folder, the installer copies the configuration files into the new location, updates them to use the new 
installation path, and renames the old PMCompass and EPMSA folders. 

Encryption Settings 
PM Compass features an encryption mechanism that provides an extra layer of security, surpassing the 
traditional SSL encryption recommended for PM Compass implementations. This mechanism ensures 
that in-flight data transmission remains uncompromised. 

 

Installation Order 
When upgrading your installation, follow this sequence: 

Note: Check the latest Cumulative Update Release Notes for information on compatible and tested 
Cobra and Open Plan products. 

Note: When upgrading from version 8.1 or earlier, you must manually add the configuration settings 
detailed in “Additional Security Configurations” of the Deltek PM Compass Advanced Administration 
Guide under Secure the Web/Application Tier. 
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1. If you are upgrading Open Plan and/or Cobra along with PM Compass, upgrade those 
applications first. 

After upgrading, confirm that the products start correctly and have been successfully upgraded 
before installing PM Compass. 

2. If you store your data in SQL Server, run the upgrade installation on the Database server.  

3. Run the PM Compass installation on each of the Report servers. 

4. Run the PM Compass installation on each of the Web/Application servers. If you have multiple 
application servers, you only need to run these prompted options once: 

 Apply the database scripts to your database. 

 Load the new and updated reports. 

5. If you have a dedicated Process server, run the PM Compass installation on it. 

6. If a cumulative update is available for the version you installed, run the cumulative update on 
each server in the same order as the regular installation. 

7. Run each sub-release or integration install on every Web/Application server and Process server. 

Upgrading from a Non-Default Installation Location 
The PM Compass upgrade installer detects your previous installation location. If it is not the default folder 
(C:\Program Files (x86)\Deltek\PMCompass), the installer performs an in-place upgrade, overwriting the 
old files. 

Domain Service Account 
The upgrade must be performed using the same account that was used for the initial installation. If you 
log in with a different account, setup will display an error and exit the installation. You should log out and 
log back in as the user (domain service account owner) who performed the initial installation. 

 

Stop the PM Compass Process Server Processes 
Prior to upgrading PM Compass, Deltek recommends stopping the PM Compass Process Server 
processes. 

To stop the PM Compass Process Server processes: 
1. Ensure that Process Server jobs are running, then stop all queues. 

2. Ensure that no one is logged into EPM SA or PM Compass. 

3. Stop the Process server service on the dedicated Process server and on the Web server if that is 
also running. 

4. If you have configured PM Compass to use a database session state, you will need to run a SQL 
query to clear out the session state:  

a) Launch Weblink and click on the System Settings tab. 

b) If the Store Session State field is set to: 

Attention: For information about changing the domain service account owner, see “Appendix K: 
Configure the Account Running the Services” in this guide. 
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 In Database Server: Run the DELETE FROM FW_SessionState SQL query against the 
database listed on the System Settings tab to clear out the session state entries in the 
database.  

 In Memory: Continue with the PM Compass upgrade without running the query. 

5. Upgrade PM Compass and restart the Process server. 

Upgrade PM Compass 
Follow this procedure to upgrade PM Compass. 

To upgrade PM Compass: 
1. Log into the server as the Domain Service Account user. 

2. Double-click the DeltekPMCompass85CumulativeUpdate<version>.exe file that you 
downloaded to run the installation.  

3. On the Prerequisites screen, click Next. 
4. On the Welcome to Deltek PM Compass Installation Wizard screen, click Next. 

If you are installing on the database tier, the Select Destination screen displays, where you 
specify the location where you want to install PM Compass and its components, and click Next. 
The Start Copying Files screen displays. 

If you are upgrading the web/app server as part of the deployment, the installer will skip to the 
Ready to Install screen and then proceed to the Load Reports screen. Select the Load Reports 
option if you want the PM Compass reports to be automatically reloaded into the Reporting 
Server. Otherwise, you will need to manually reload the reports after the upgrade. 

5. The installer displays a message asking if PM Compass is deployed with Citrix. 

 
6. On the Confirm Installation Features screen, the wizard automatically selects the recommended 

Cobra and Open Plan integration files for installation, based on the data found in your PM 
Compass database tables. 
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If you change any of the selections to options that do not match your database tables, the wizard 
will display this screen. 

 

 
Click Yes to proceed. 

7. On the Cobra Web Service URL screen, click Next. 
By default, the wizard installs the Cobra Web Service on each Web/Application and Process 
server. Deltek strongly advises against making any changes to this. 

Note: Choosing the non-recommended install option for the integration may cause the integration 
files to not match the tables in your database, which can impact whether the integrations work. The 
only time the integrations might be different is if you plan to upgrade your Cobra or Open Plan tables 
after the installation. However, it is recommended to upgrade your Cobra and Open Plan tables 
before installing PM Compass. 
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8. On the Specify Report Server and Report Server URL Information screen, enter the necessary 

information in the appropriate fields, and click Next. 
Setup uses the default Report Server URL to initially check the configuration of Microsoft SQL 
Reporting Services on the Web server to the Reporting Services Web Service. 

 
If the setup is unable to connect to the Reporting Service Web Service screen, it displays an error 
message indicating the connection failure and shows the Specify Report server and Report 
Server URL Information screen. 
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9. The Password screen may appear depending on the version you are upgrading from or if you 

have changed the DeltekPMCompass account password. If it does not appear, skip to the next 
step. 

You must specify a secure password for the account that meets your company’s security 
requirements. 

 
After entering the password and clicking Next, you must re-enter the password to verify it and 
then click Next. 

10. On the Database Platform screen, select your database platform and click Next. 
11. The next screen depends on whether you selected Oracle or Microsoft SQL Server. Refer to 

the section below that corresponds to your selected database. 

Oracle Database 
The setup checks for supported versions of the Oracle Client driver. If it finds a supported 
version, setup continues. If not, the wizard displays a message informing you that no supported 
Oracle driver has been found, and the setup exits when you click OK. To resolve this, install the 
supported Oracle client driver version and run the wizard again. 

 

 

Attention: For more information to connect to the Report Server, see “Appendix C: Microsoft 
SQL Server Reporting Services” in this guide. If your report server has already been 
configured and you are unsure of how to complete this screen, see “Connecting to the Report 
Server” in the same appendix. 

Warning: Setup does not save this account or log it anywhere, so you should keep the 
details in a safe place. 

Attention: On the Oracle Connection Information screen, enter the necessary information in 
the appropriate fields, and click Next. 
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 Service name/SID: Enter the unique name of your Oracle database instance as defined in 
your tnsnames.ora file. 

 Username: Enter the Oracle user schema with rights to modify the tables in the Oracle 
database.  

 Password: Enter the password associated with the Oracle Username. 

The following validations are performed: 

 SID is found in tnsnames.ora. 

 Username/password are correct. 

 The versions of Cobra and Open Plan (if installed) are supported. 

 The database has Unicode and case incentive indexes enabled. 

If any of these validations fail, the wizard displays a message, and the setup exits. 

 
Microsoft SQL Server Database 
On the Database Server (MSSQL) Setup Connection Information screen, enter the necessary 
information in the appropriate fields, and click Next. 

 
 Database Server: Enter the name of the Database server and the database instance. 

 Select Windows Integrated or enter the SQL Login and SQL Password. 

 SQL Login: Enter a Microsoft SQL Database Server Login that is mapped to the 
db_owner role in the database. If you use the SQL Login and SQL Password 
fields, make sure that server security is configured to support Mixed Mode Security. 

Attention: For steps to resolve Cobra and Open Plan database prerequisite requirements, 
see “Appendix H: Unicode and Case-Insensitive Prerequisites for Cobra and Open Plan 
Databases” in this guide. 



PM Compass Upgrade Installation Steps 

Installation Guide 106 

 

 
 SQL Password: Enter the password associated with this SQL Login. 

 Database Name: If you have an existing Cobra database, enter your Cobra database name. 
If this is a new installation, enter the name of the new database you created to store your 
data.  

The following validations are performed: 

 Username/password are correct. 

 The database name is valid, and the user has access. 

 The versions of Cobra and Open Plan (if installed) are supported. 

 The version of SQL Server is supported. 

If any of these validations fail, the wizard displays a message, and the setup exits. 

12. Choose whether PM Compass integrates with the Microsoft Project scheduling tool. 

 
 If you are using Microsoft Project as a PM Compass scheduling tool, enter the UNC share 

location for the MSP Files and Process Logs folders, and click Next. 
 If you are not using Microsoft Project as a PM Compass scheduling tool, leave the UNC 

Share Path fields blank, and click Next.  

 

Note: Security best practice recommends not using the default SYSADMIN account (sa) for 
your SQL Server connection. 

Attention: To manually configure the system after the installation, see “Appendix N: 
Integrating with Microsoft Project” in this guide. 
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13. Choose whether PM Compass integrates with the Primavera P6 scheduling tool. 

 
14. If you are integrating PM Compass with Primavera P6, specify the Primavera P6 UNC share 

location where you want to store the process logs on the Primavera P6 Integration Process Logs 
UNC Share Path screen. If the location for MSPLogs is already specified, the screen may not 
display. 

Attention: For information about the permissions required for these folders, see “File Share 
Requirements” in this guide 
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15. On the Shared Network Folder screen, specify the UNC share location where you want to store 

links, general export files, and MPP export files. For example, 
\\<servername>\DeltekPMCompass\. 

 
16. On the Default Files Folders screen, the wizard displays the default Links, General Export, and 

MPP Export folder locations. You can edit these locations in PM Compass after the installation 
(Administration » System Settings » File Folders tab). 

Attention: For information about the permissions required for these folders, see File Share 
Requirements. 
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17. On the Script Options screen, select your database script option and click Next. 

 

 

 
18. On the Summary of selected installation options screen, review the installation and click Next. 

Note: The wizard displays this screen if you have a Web/Application or Process server in 
your deployment. 

Note: The PM Compass installation does not automatically back up your database before applying 
any scripts. Make a backup of your database before selecting any of the options on this screen. 
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19. On the Ready to Install screen, click Install. 

The wizard displays the Setup Status screen. 

 
20. On the Deltek PM Compass Installation Wizard Complete screen, click Finish.  

 
If prompted, you can restart your computer after installing PM Compass. 

Note: The wizard displays this screen if you have a Web/Application or Process server in 
your deployment. 



PM Compass Upgrade Installation Steps 

Installation Guide 111 

 

 

 
 

Note: If you encountered any errors during the installation, contact Deltek Support Center and send 
the installation log file. For more information on the log file location, see “Temporary Log Files and the 
Log Files Folder” in this guide. 

Note: If you prefer to restore the sample database, you can restore it onto your Report Server 
database engine (Oracle) or Microsoft SQL Server database server (SQL Server) using the Deltek PM 
Compass Sample Database Restore Wizard. For more information, see “Appendix I: How to Run the 
Deltek PM Compass Sample Database Restore Wizard” in this guide. 
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Post-Installation Steps 
After successfully installing PM Compass, it is important to follow these post-installation steps to ensure 
everything is configured correctly and running smoothly.  

Launch the PM Compass Components 
This section includes topics about launching the PM Compass components. 

Launch PM Compass Components from a Browser  
Launch the following client components from Microsoft Edge: 

 PM Compass: https://<servername>/PMCompass 

For example: https://servername.company.com/PMCompass  

 EPMSA: https://<servername>/EPMSA 

For example: https://servername.company.com/EPMSA 

Launch PM Compass from a Desktop Shortcut 
You can launch PM Compass and the EPMSA client from your desktop using a shortcut. You must first 
move the shortcuts created by the installation on the application server to a shared location. Then, you 
can copy the shortcuts down to their client desktop. 

Move the Shortcuts 

Follow this procedure to move the shortcuts to a shared location. 

To move the shortcuts: 
1. On the Application server, click the Windows icon to display the Start menu.  

2. Locate the Deltek PM Compass folder and expand the contents. 

3. Right-click the Deltek PM Compass icon and select More… and Open File Location. 

4. Copy the Deltek PM Compass shortcut to a shared UNC for which users will have access. 

5. Access the Administration folder. 

6. Copy the Deltek EPM Security Administrator to a shared UNC for which users will have access. 

7. Navigate to the <PMCompassInstallationFolder>\Support.  
The default folder is C:\Program Files\Deltek\PMCompass\Support. 

8. Copy the file Compass.ico to the shared UNC. 

9. Copy the file app-security.ico to the shared UNC. 

Edit the Shortcuts 

Follow this procedure to edit the shortcuts to use the icon file in the shared location. 

To edit the shortcuts: 
1. In the shared location, locate the PM Compass shortcut. 

https://servername.company.com/EPMSA
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2. Right-click the shortcut and select Properties. 

3. On the Shortcut tab, click the Change Icon button. 

4. Click the Browse button and select the compass.ico file in the shared location. 

5. Close the Properties dialog box. 

6. In the shared location, find the Deltek EPM Security Administrator shortcut. 

7. Right click the shortcut and select Properties. 

8. On the Shortcut tab, click the Change Icon button. 

9. Click the Browse button and select the app-security.ico file in the shared location. 

10. Close the Properties dialog box. 

Notify the PM Compass Users 

Send an email to PM Compass users. The email should contain a link to the shared path and instructions 
to drag the PM Compass shortcut to their desktop. 

Launch Weblink   
You must run Weblink on the Web/Application server using the shortcut created in the PM Compass 
installation folder.  

Set or Confirm the IIS/.NET Globalization Culture Setting 
You must ensure that the.NET Globalization Culture setting for the PM Compass application in IIS is the 
same as the Region setting on the Process and Web/Application servers. 

To confirm or set the culture setting for PM Compass and EPM SA in IIS: 
1. From Administrative Tools, launch IIS Manager. 

2. In the left pane, expand the web site (example, Default Web Site) that hosts the PM Compass 
application. 

3. Select PMCompass. 

4. In the right pane, in the ASP.NET section, double-click the .NET Globalization icon. 

5. In the Culture field, confirm or select the culture. 

 
6. If you make a change, click Apply. 

7. In the left pane, select EPM SA and repeat steps 4 through 6. 

Set Up Recovery Actions for the PM Compass Process Server 
Occasionally, the PM Compass Process Server may stop due to an error. To address this, you can set up 
Windows Services to automatically restart the service whenever this happens. 

Note: This setting must match the regional settings on the Process and Web/Application 
servers. Navigate to Control Panel » Region, and on the Formats tab, check the Format 
field. In addition, the regional settings on the servers must match the regional settings on the 
client machine. 
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To configure Windows Services to automatically restart the Process Server service: 
1. Navigate to Control Panel » Administrative Tools » Services. 

1. Double-click the Deltek PM Compass Process Server service. 

2. In the Recovery tab of the dialog box, select the action that you want to perform for the First 
failure, Second failure, and Subsequent failures options. 

 

 
3. Click Apply and then click OK. 

Set Up Recovery Actions for the Cobra Web Service 
Occasionally, the Cobra Web Service may stop due to an error. To address this, you can set up Windows 
Services to automatically restart the service whenever this happens. 

To configure Windows Services to automatically restart the Cobra Web Service: 
2. Navigate to Control Panel » Administrative Tools » Services. 

1. Double-click the Cobra Web Service service. 

2. On the Recovery tab of the dialog box, select the action that you want to perform for the First 
failure, Second failure, and Subsequent failures options. 

Note: The default failure option when a service stop is set to Take No Action. Deltek 
recommends configuring the First failure and Second failure options to Restart the 
Service. For the Subsequent failures option, if you have a command line set up to notify 
administrators via email about service failures, you should configure it to send an email or 
another type of alert. 
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3. Click Apply and then click OK. 

Disable the Dedicated Process Server 
If you have a dedicated Process server and you do not want your Web server to pick up the Process 
Server jobs, you should disable the Deltek PM Compass Process Server service on the Cobra Web 
Server.  

To disable the Deltek Process server: 
1. Log into the Cobra Web Server as the Domain Service Account. 

2. Navigate to Control Panel » Administrative Tools » Services. 

3. Double-click the Deltek PM Compass Process Server service 

4. On the General tab of the Deltek PM Compass Process Server Properties dialog box, change the 
Startup Type to Disabled. 

5. Click OK. 

Note: The default failure option when a service stop is set to Take No Action. Deltek 
recommends configuring the First failure and Second failure options to Restart the 
Service. For the Subsequent failures option, if you have a command line set up to notify 
administrators via email about service failures, you should configure it to send an email or 
another type of alert. 
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Share the ItemTypeExport Folder on the Web Server 
Once the installation is finished, you must share the ItemTypeExport folder on the PM Compass Web 
server and configure the appropriate access rights to allow users to access files generated by the 
ItemTypeExport feature. 

To share the ItemTypeExport folder and assign access rights: 
1. On the PM Compass Web server, create a network share on the ItemTypeExport folder located 

in the PM Compass installation folder.  

2. Grant read permissions to the shared ItemTypeExport folder for the authorized users. 

The following NTFS permissions will automatically be added to the folder for the users: 

 Read & execute 

 List folder contents 

 Read 

Confirm the Polling Interval and Max Concurrent Job 
Settings 
The Polling Interval is used when processes are scheduled. It indicates how often PM Compass polls the 
Application server to check to see if something needs to be run. Under normal circumstances, a polling 
interval of 30 seconds (which is the default) improves performance and jobs are processed in a timely 
manner.  

The Max Concurrent Jobs field limits the number of concurrent jobs running on the Process server. It is 
different from the Maximum field which sets the maximum number of jobs that can run concurrently for 
the selected queue, although the two do work together. 

 

To confirm the Polling Interval and Max Concurrent Job settings: 
1. On the Application server, click Start » All Programs » Deltek PM Compass » Weblink. 

2. On the Weblink Login screen, enter the password.  

If this is the first time you are launching Weblink after installation, Weblink prompts you to set up 
a password. 

3. On the System Settings tab, review the following: 

 Polling interval (sec): The interval in seconds at which the system polls databases for alerts 
and schedule jobs. You can enter a numeric value from 0 through 999. By default, this field 
displays 5. 

 Max Concurrent Jobs: The maximum number of jobs that can run concurrently on the 
Process server, regardless of the actual number of jobs in a queue. You can enter zero (0) to 
have unlimited concurrent jobs. You can enter a numeric value from 1 through 999. By 
default, this value is set to 10. The Process server will never run more than the number of 
concurrent jobs set here, regardless of the setting in the queue Maximum field.  

Attention: For important information and examples about the Max Concurrent Jobs field and the 
difference between it and the Maximum field, see “Maximum Field vs. Max Concurrent Jobs Field” in 
the EPM SA Help System. 
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4. If you make changes, click Save. 

Configure Weblink 
Follow this procedure to configure Weblink. 

To configure Weblink: 

1. On the Application server, click Start » All Programs » Deltek PM Compass » Weblink. 

2. On the Weblink Login screen, enter the password. 

If this is the first time you are launching Weblink after installation, Weblink prompts you to set up 
a password. 

3. On the Report Server tab, update the password for the DeltekPMCompass account. 

4. On the System Settings tab, perform the following steps: 

 Enter the interval in seconds at which the system polls databases for alerts and schedule 
jobs. You can enter a numeric value from 0 through 999. By default, this field displays 5. 

When you enter or modify the value, a message is displayed informing you to restart any 
Process server that needs to use the new setting. 

 Enter the maximum number of jobs that can run concurrently on the Process server, 
regardless of the actual number of jobs in a queue. You can enter zero (0) to have unlimited 
concurrent jobs. You can enter a numeric value from 0 through 999. By default, this field is 
10. 

If you run too many concurrent jobs, add additional load to your Database server and/or 
Report server. Deltek recommends that the total of all of the process queues (per server) 
does not exceed the number in the Max Concurrent Jobs field. If the total of all of your 
process queues (per server) does exceed the number in the Max Concurrent Jobs field, 
only the number of jobs specified in the Max Concurrent Jobs field will run concurrently.  

When you enter or modify the value, a message displays informing you that you must restart 
any Process server that needs to use the new setting. 

5. Click Save. 

6. Restart the Deltek PM Compass Process Server service that will use these settings. 

Configure Cobra to Write Process Logs to a File 
During a change request, Cobra executes a process. If any errors or warnings occur, a link to the log is 
added to the Links tab of the workflow. To enable PM Compass users to view the process logs generated 
by PM Compass, you must configure Cobra to write process logs to a file. Once configured, you can use 
the Process Log Viewer in Cobra to view these logs. 

 

To configure Cobra to write the process logs to a file: 

1. In Cobra, click  » Preferences » Application and click the Data Access tab. 

Note: For a Cobra n-tier deployment, you cannot configure Cobra to write process logs to a file. 
Instead, the process logs are stored in the database, and you will need to use Cobra to view them. In 
addition, you must know the failure time to search through the process logs for the relevant process 
during that period. 
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2. In the Process Log group box, perform the following steps: 

 Select Write process logs to a text file option to store the process log information to a text 
file in a local folder instead of the database. All Cobra processes will store the process log 
files in the specified location.  

 Enter the full path to the folder using a UNC format in the Location field. For example, 
\\<servername>\CobraProcessLogs.  

 

 
3. Click OK to apply the change and close the dialog box. 

4. Restart the Cobra Web Service. 

Configure the Cobra Report Templates Folder Location 
PM Compass can run Cobra reports to export data. To locate the Cobra report templates, PM Compass 
requires them to be stored in a shared location. 

During the Cobra client installation, the Cobra report templates are installed in the following location: 
C:\Program Files (x86)\Deltek\Cobra\ReportTemplates. 

To configure Cobra to use a shared location for report templates:   
1. In PM Compass, copy the Cobra ReportTemplates folder to a shared location. 

 

2. In Cobra, click  » Preferences » Application.  

3. On the Reports tab, enter the shared location of the Cobra report template folder in the Report 
Template Location field and click OK.  

 

 
4. Restart the Cobra Web Service. 

Attention: For more information on the shared folder, see “File Share Requirements” in this 
guide. 

Note: Type or paste the path. Do not use the ellipses as it will not allow you to browse to the 
shared network folder. 

Note: Deltek recommends using a shared location within the same share as the Links, 
General Export, MPP Export, and Integration Process Logs default file folders.  

Attention: For more information on the shared folder, see “File Share Requirements” in this 
guide. 
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Microsoft Project and Primavera  
Depending on your scheduling system, additional tasks may be required. 

 
If you are using Primavera P6 as your scheduling system, review Appendix O: Integrating with Primavera 
P6. 

Attention:  
 If you are using Microsoft Project as your scheduling system, review “Appendix N: Integrating 

with Microsoft Project” in this guide. 

 If you are using Primavera P6 as your scheduling system, review “Appendix O: Integrating 
with Primavera P6” in this guide. 
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Post-Installation Checklist 
This chapter covers the post-installation checklist for PM Compass. 

Recommended Secure Deployment of PM Compass 
Step Related Topics 

1 Security is a critical part of any application. 
Applications must be secured against 
disclosure of confidential information, 
modification, destruction of data, 
misappropriation of resources, and 
compromise of accountability.  

Deltek recommends securing your PM 
Compass deployment. 

“Secure Your PM Compass Deployment” in 
the Deltek PM Compass Advanced 
Administration Guide 

Web/Application Server 
Step Related Topics 

1 In Weblink, set the Weblink password, the 
Polling Interval value, and Max Concurrent 
Jobs value. 

“Configure Weblink” under “Post-Installation 
Steps” in this guide 

2 If you make changes to the databases.enc file 
and you are not using a shared databases.enc 
file, you must copy the changed 
databases.enc file to all other Web/Application 
server and the Process server and then restart 
the Deltek PM Compass Process Server 
service on each server. This ensures that each 
server uses the same configuration. 

If you have multiple servers and you want to 
automate the process, Deltek has a script that 
you can use.  

Deltek recommends that you test the script 
before using it on your production servers. 

KB article #85452 on the Deltek Support 
Center site 

“Configure a Shared Location for 
Databases.enc” in the Deltek PM Compass 
Advanced Administration Guide 

3 Confirm that the supported Cobra and Open 
Plan integration files have been applied by 
accessing each Web/Application server.  

 

4 In Control Panel » Administrative Tools » 
Services, verify the Domain service account 
used as the identity and confirm the services 
are running for the following: 

 The Deltek PM Compass Process Server 

“Domain Service Account vs Default Local 
Account” in this guide 
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Step Related Topics 
 Cobra Web Service 

5 Configure your antivirus, intrusion detection, or 
malware prevention software to exclude the 
following folders and files: 

 <PM Compass Installation 
Directory>\EPMSA\databases.enc file 

 <PM Compass Installation 
Directory>\EPMSA\Web\Bin\ folder 

 <PM Compass Installation 
Directory>\PMCompass\Web\web.config 
file 

 <PM Compass Installation 
Directory>\PMCompass\Web\Bin\ folder 

 

6 If this is a new PM Compass installation, you 
must complete the following tasks: 

 Perform these steps on the server tier: 

 Set the IIS/.NET Globalization setting. 

 Set up recovery actions for the PM 
Compass Process Server. 

 Disable the Process server on the 
Web server. 

 Share the ItemTypeExport folder on 
the Web server. 

 Perform these steps on the client or server 
tier: 

 Configure Cobra to write process logs 
to a file. 

 Configure Cobra report templates to a 
shared location. 

 Copy Cobra report templates to a 
shared location. 

“Post-Installation Steps” in this guide 

7 Configure the PM Compass servers to print to 
network printers. 

“Appendix D: Printing in PM Compass” in this 
guide 

8 Configure Weblink. “Configure Weblink” under “Post-Installation 
Steps” in this guide 
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Dedicated Process Server 
Step Related Topics 

1 See Steps 2 and 3 in the Web/Application 
Server post-installation checklist to view the 
settings that affect the Process server. 

 

2 Confirm that the supported Cobra and Open 
Plan integration files have been applied. 

 

3 In Control Panel » Administrative Tools » 
Services, verify the Domain service account 
used as the identity and confirm the services 
are running for the following: 

 The Deltek PM Compass Process Server 

 Cobra Web Service 

 

4 Configure your antivirus, intrusion detection, or 
malware prevention software to exclude the 
following folders and files: 

 <PM Compass Installation 
Directory>\EPMSA\databases.enc file 

 <PM Compass Installation 
Directory>\EPMSA\Web\Bin\ folder 

 <PM Compass Installation 
Directory>\PMCompass\Web\web.config 
file 

<PM Compass Installation 
Directory>\PMCompass\Web\Bin\ folder 

 

5 Confirm that the supported Cobra and Open 
Plan integration files have been applied by 
accessing each Web/Application server.  

 

6 Perform the following steps on the server tier: 

 Set the IIS/.NET Globalization setting. 

 Set up recovery actions for the PM 
Compass Process Server. 

“Post-Installation Steps” in this guide 

 

7 To process scheduled jobs, ensure at least one 
server is running the Deltek PM Compass 
Process Server Windows Service. If you 
disable this service on the Web/Application 
server, you must specify at least one Process 
server and assign queues to it. 

“Configuring the PM Compass Settings in 
EPM Security Administrator” in this guide 
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Step Related Topics 

8 Configure a dedicated Process server to pick 
and process jobs only from a specific queue. 

“Appendix K: Configuring the Account 
Running the Services” in this guide 

Client Tier (Workstation) 
Step Related Topics 

1 Provide PM Compass users with the PM 
Compass and EPM SA URLs. 

 PM Compass: Replace servername in 
the URL with your server’s name 
(http://servername/pmcompassclient) 

 EPM SA: Replace servername in the 
URL with your server’s name 
(http://servername/epmsaclient) 

 

2 When you launch PM Compass or EPM SA, 
use the following credentials for new/sample 
databases are:  

 Username: SYSADMIN 

 Password: password 

“Configuring the PM Compass Settings in 
EPM Security Administrator” in this guide 

3 For Open Plan users only 
Perform the following steps: 

 Verify that the version of Open Plan 
installed is supported by PM Compass. 

 Verify that the Open Plan data source 
entries match those used by PM Compass 
for the database.  

Contact your system administrator for the 
details of the connection if Open Plan is not 
already configured. 

“Appendix A: System Requirements” in this 
guide 

4 For Cobra users only 
Perform the following steps: 

 Specify the location of the process logs. 

 Specify the location of the report 
templates. 

“Configure Cobra to Write Process Logs to a 
File” and “Configure the Cobra Report 
Templates Folder Location” in this guide 

http://servername/pmcompassclient
http://servername/epmsaclient
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Configuring the PM Compass Settings in EPM 
Security Administrator 
Deltek EPM Security Administrator (EPM SA) helps you maintain license keys, users, groups, roles, and 
access to the various EPM applications. Since PM Compass is a role-based application, security is an 
integral part of the application. EPM SA allows you to define the security rights for PM Compass, Cobra, 
and Open Plan. 

Use the procedures in this chapter to: 

 Specify the Application servers. 

 Create login IDs. 

 Enter licenses and assign users to the license. 

 Create and assign groups and roles. 

 Configure system settings. 

 

Log into EPM SA 
Follow this procedure to log into EPM SA. 

To log into EPM SA: 
1. Launch Microsoft Edge and enter the URL of EPM SA. 

For example, http://<web server>/EPMSA/. 

2. If the application does not load automatically, click the Deltek EPM Security Administrator link.  

3. On the EPM SA Login screen: 

a. Enter the user ID of SYSADMIN with the default password of password.  

PM Compass automatically creates a SYSADMIN account for administrative functions. This 
account does not use one of your purchased licenses. 

b. In the Database field, select the database to which you want to log on.  

If you opted to restore a copy of the sample demonstration database during installation, you might 
see an additional “sample” database available when logging into EPM SA. Make sure to select 
the database where your data will be stored. 

Enter Your New License Key 
Follow this procedure to enter your license key in EPM SA. 

To enter your license key: 
1. Log into EPM SA. 

2. On the Navigation menu, click Products » Deltek PM Compass. 

3. Click the License tab. 

Note: These tasks are typically completed by a network administrator. 
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4. In the License grid, click Insert, and enter the following details: 

 Client Number 
 Organization Name 
 Activation Key 

 
5. Click Save. 

The grid is populated with the License Mode, the number of licensed users, and so on. 

Change the Default Password for the SYSADMIN User  
Follow this procedure to change the default password for the SYSADMIN user. 

To change the SYSADMIN user password:  
1. Log into EPM SA. 

2. In the left navigation pane, click Security, and click Users.  

3. Search for the SYSADMIN user ID. 

4. Click the Authentication tab. 

5. Click Set Password and enter a password. 

Create a User Login ID with SYSADMIN Privileges 
Follow this procedure to create a login ID with SYSADMIN privileges. 

To create a user login ID with SYSADMIN privileges:  

1. Log into EPM SA. 

2. In the left navigation pane, click Security, and click Users.  

3. Click New » New Record. 

4. On the General tab, perform the following steps: 

 Enter your appropriate values in the Username, First Name, and Last Name fields. 

 In Primary Role, select SYSADMIN. This gives you full access rights to configure the 
system. 

 Enter your email address. 

5. On the Groups tab, click Insert and select SYSADMIN. 

6. On the Authentication tab, click Set Password, and enter a password. 

7. Click Save. 

Create a User Login ID to Connect to Open Plan 
If you are using Open Plan, you must create a specific username and password for PM Compass to 
connect to Open Plan. PM Compass utilizes this information to implement changes and execute 

Note: This was emailed to you when you downloaded the PM Compass installation. 
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processes, such as time analysis, for projects managed by PM Compass. This login information is solely 
for processing purposes and is not used for access control. 

These credentials are required regardless of whether you use Open Plan as your scheduling tool, as PM 
Compass relies on Open Plan functionality for all schedule changes and processes. 

 

To create a user login ID to connect to Open Plan: 
1. Log into EPM SA. 

2. In the left navigation pane, click Security and then click Users.  

3. Click New » New Record. 

4. On the General tab, perform the following steps: 

 Enter your appropriate values in the Username, First Name, and Last Name fields. 

 In Primary Role, select SYSADMIN. This gives you full access rights to configure the 
system. 

 Enter your email address. 

5. On the Groups tab, click Insert and select SYSADMIN. 

6. On the Authentication tab, click Set Password, and enter a password. 

7. Click Save. 

8. In the left navigation pane, click Configuration, and click System Settings. 

9. In Credentials for PM Compass to Connect to Open Plan, enter the username and password 
that you created. 

10. Click Save. 

 

Configure the PM Compass System Settings 
Follow this procedure to configure the system settings in EPM SA. 

To configure the system settings: 
1. Log into EPM SA. 

2. In the left navigation pane, click Configuration, and click System Settings. 

3. On the Email tab, enter the appropriate values in the following fields: 

 Email Server: Enter your email server IP address or server name. 

 Port: Enter the port (25 is the most common). 

 SMTP Server Domain Authentication: Enter an email address and password if your SMTP 
server requires domain authentication. 

Note: If you are not using Open Plan, PM Compass automatically populates the username and 
password in EPM SA during installation. In this case, do not remove or edit the data in these fields as 
this will break the integration. 

Note: When you proceed with the steps to enter licenses and set up user access, you will need to 
assign the newly created user to an Open Plan license. 
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 Default Help Desk Email: In the top right corner of PM Compass, under the Help menu, you 
will find an option called Internal Help Desk. This feature allows end users to quickly email 
someone within your company who can assist with their issues. Enter the email address of 
the person in your company who should receive all user support request emails 

 Default Sender Email: When the PM Compass workflow sends a user an email notification 
or error message, it will come from the address entered in this field. Deltek recommends 
creating a dedicated email address for this purpose, such as 
PMCompass@yourcompany.com, and using it as the default sender. During implementation, 
any replies to PM Compass emails will be directed to this account. One benefit of having a 
dedicated email address is that you can set up an Outlook rule to move emails from this 
address to a specific folder or forward them to designated individuals. 

4. Click Save. 

5. Click Send Test Email to Default Help Desk and check to confirm that your default help desk 
email received the test email. 

6. On the Servers tab, confirm the PM Compass Application server is listed in the Application 
Servers grid. If you have multiple servers, confirm all servers are listed in the grid. 

7. Click Save. 

Create Groups for Data Access Control 
Groups consist of individual users assigned to data objects, such as projects, within the applications. 
Typically, groups represent major programs, projects, or functional units like the project management 
office within an organization. 

Users can have different roles within a group. For instance, if JDOE is part of the ENGINEERING group, 
and that group has the rights to create projects, JDOE can create a project. 

The role assigned to a group determines what its users can do with the menu options. This allows you to 
enable or disable access to certain application features based on groups with multiple users, rather than 
a single role. 

A user must belong to at least one group to log in to PM Compass. 

 

To create or edit a group: 
1. Log into EPM SA. 

2. In the left navigation pane, click Security, and click Groups. 

3. On the Groups form toolbar, click New, and select from one of the following options: 

 New Record: Select this option to create a blank group record. 

 Copy Current Record: Select this option to copy the current group record to a new record. 
The copied group becomes populated with the original group information, except for the 
Group ID. 

 Select Record to Copy: Select this option to copy a record of another group. Selecting this 
option displays the Group Search dialog box. Selecting multiple records is not allowed. The 
copied record becomes populated with the original group information, except for the Group 
ID. 

Attention: For more information about groups, including defining permissions for a group, see 
“Define Group Profiles" under Managing Security in the EPM SA Help System. 
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4. Enter or modify the necessary details. 

5. Click Save. 

Assign Roles and Groups to Users 
After creating roles and groups, you must assign users to them. 

To assign roles and groups to users: 
1. Log into EPM SA. 

2. In the left navigation pane, click Security, and click Users. 

3. Use the navigation arrows or the Search field to locate the user. 

4. On the General tab of the Users form, select a primary role for the user. 

5. On the Groups tab, click Insert. 
6. Use the Lookup dialog box to locate the group that you want to assign. 

7. Select the group and click Select. 

Use CTRL+click or SHIFT+click to select and assign multiple groups. 

8. Click Select. 
The group is added to the Assigned Groups grid. 

9. Click Save. 

Add Users to a Product 
Before a user can log into PM Compass, Cobra, or Open Plan, they must be assigned to a product. 

To add users to a product: 
1. Log into EPM SA. 

2. In the left navigation pane, click Products, and click PM Compass. 

3. In the Assigned Users grid on the License tab, click Insert, and select users in the User Search 
dialog box.  

Use CTRL+click or SHIFT+click to select and assign multiple users. 

4. Click Select. 
5. Click Save. 

Your license key specifies the number of licensed users. You can only select up to this number of 
licensed users in the grid. 
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Verifying the PM Compass Settings 
Use the procedures in this chapter to verify the PM Compass settings. 

Specify and Apply the Default Application URL 
In PM Compass, enter the URL where Deltek PM Compass is installed to ensure hyperlinks in emails 
sent from PM Compass function correctly. 

To specify and apply the default application URL: 
1. In Microsoft Edge, enter the URL for PM Compass.  

For example, http://<web server>/PMCompass. 

2. Click Deltek PM Compass or wait for the application to load.  

PM Compass will then display the Deltek PM Compass Logon dialog box. 

a. Enter a username and password that has SYSADMIN privileges. 

b. In the Database field, select the same database you selected in the EPM SA Login 
dialog box. 

c. Click Login. 

3. In the PM Compass, click Administration » System Settings. 

4. In the Application URL field on the General tab, enter the application URL.  

For example, http://<web server>/PMCompass. 

 

Verify the PM Compass Components  
Inside PM Compass, you can verify that the various components are configured correctly. 

To verify components: 
1. Login to PM Compass with the user ID you created and assigned as a member of the SYSADMIN 

group.  

2. On the Navigation menu, click Administration » System Settings. 

3. On the General tab, perform the following actions: 

a. Verify that the application URL is correct. 

b. In the User to Resolve Workflow Failures field, verify that the designated user is 
responsible for resolving workflow issues during implementation. 

4. On the Verify Components tab, click Verify. 

As each component is verified, a Passed or Failed status is added to the line. If any record fails, 
click the hyperlinks to follow the steps to resolve the issue. 

Note: When you use Model Changes, the system launches it using this URL. 
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Next Steps 
These tasks are usually carried out by a Control Account Manager or System Administrator.  

 

Email Users 
Email users to inform them that PM Compass has been installed. Include the hyperlink to access PM 
Compass and recommend that they add the URL as a favorite in Microsoft Edge. Alternatively, you can 
provide instructions for adding a shortcut to their desktop. 

Attention: For more information, see “Configuring PM Compass” in the PM Compass Help System. 
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Using the Sample Databases 
Deltek recommends restoring the sample databases to facilitate evaluation and testing.  

PM Compass includes sample SQL Server databases, which are zipped and available in DSM. To get 
started, download the Deltek PM Compass 8.5 Sample Databases.zip from DSM and extract the 
sample databases on your server based on the database you are using. 

The sample databases are available for all supported versions of Cobra and Open Plan, and are 
combined in the following format: PMCompassCobOPSampleData.bak or 
PMCompassCobOPSampleSnapShot.bak. 

  
If you are using SQL Server, extract the sample databases on the Database server. If you are using 
Oracle, extract the sample databases on the Report server. 

To use the sample databases, you must restore them first. After restoring the sample databases, 
configure them to run on your server. 

 

To configure the sample databases: 
1. In PM Compass, navigate to Administration » System Settings, and perform the following 

steps: 

a. Click the General tab and enter the application URL in the Application URL field. 

 
b. Click the Files Folders tab and enter the shared folder location in the appropriate fields. 

 
2. Using the Cobra Data Tool on the client, create a data source for the sample database. 

3. In Cobra, click  » Preferences » Application.  

Attention: For detailed instructions, see “Appendix I: How to Run the Deltek PM Compass Sample 
Database Restore Wizard” in this guide. 

Attention: For more information, see “General Tab of the System Settings Form” in the PM 
Compass Help System. 

Attention: For more information about sharing the folder, see "File Folders Tab of the 
System Settings Form" in the PM Compass Help System and “File Share Requirements” in 
this guide. 
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4. In the Application Preferences dialog box, perform the following steps: 

a. Click the Data Access tab, and perform the following steps in the Process Log group box: 

i. Select the Write process logs to a text file option. 

ii. Enter the full path to the folder using a UNC format in the Location field. 

b. Copy the Cobra report templates to a shared folder for which PM Compass has access 
rights. 

c. Click the Reports tab and enter the UNC path to the shared folder of Cobra report 
templates in the Report Template Location field. 

 
5. In EPM SA, click Configuration » Systems Settings, and perform the following steps: 

a. On the General tab, enter the credentials for PM Compass to connect to Open Plan.  

The user must be a member of the SYSADMIN group.  

b. On the Servers tab, specify the Application server.  

6. In PM Compass, click Administration » System Settings, click the Verify Components tab and 
then click Verify. 

Log into the Sample Database 
The sample database includes several users. The security settings allow the following users to log in: 

User ID Password Project Responsibility 

SYSADMIN password All  

EVELYN  Inter-Planet Shuttle PCA 

JACK  Inter-Planet Shuttle Control Account 
Manager 

RICK  Inter-Planet Shuttle Project Manager 

ED  Inter-Planet Shuttle IPT Lead 

JANE  USS San Antonio PCA 

SAM  USS San Antonio Control Account 
Manager 

PAUL  USS San Antonio Project Manager 

FRED  USS San Antonio IPT Lead 

AL password All The System 
Administrator 

Attention: For more information, see “Reports Tab of the Application Preferences 
Dialog Box” in the Cobra Help System. 
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To log into the sample database: 
1. Access the PM Compass Login dialog box. 

2. Enter one of the user IDs and passwords from the table above. 

3. Select the sample database from the Database field and click OK. 

Use the Sample Databases to Configure the BCR Snapshot 
Database 
You can use the sample database to configure the BCR snapshot database. 

To use the sample database in configuring the BCR snapshot database: 
1. Restore the sample database. 

2. Run the Deltek Cobra Data Tool as Administrator and perform the following steps: 

a. On the Data Sources page, add the 
PMCompass<version>Cob<version>OP<version>SampleSnapShot.bak data source 
to which you want to add a linked BCR Snapshot database. 

b. Navigate to the pages of the Cobra Data Tool Wizard by clicking Next. 
c. On the Link to External Database page, specify the connection details of the 

PMCompass<version>Cob<version>OP<version>SampleSnapShot.bak database 
using the same data provider as the sample database. 

d. On the Confirmation page, click Finish when the “Link to External Database will be 
updated” message displays, 

3. If the main database has additional user fields, you must add them to the BCR Snapshot 
database as well. 

4. If you have previously run the RecreateAsGlobalTempTables_Oracle.sql script, you must run it 
again. 

5. Add a data source to Open Plan. Press and hold the CTRL key and click the Login button. 

Use the Sample Database with MSP Integration 
You can use the PM Compass project titled Vessel (from the sample database) and the related sample 
.mpp file (vessel.mpp) to learn more about the MSP integration process. 

To run the MSP integration process using the sample data: 

1. Copy the vessel.mpp file into the MSP Files folder.  

This file is installed on the Web/Application server. The default location for this file is <Default 
Installation Directory>\Support\MSP. For example, C:\Program Files\Deltek\PM 
Compass\Support\MSP. 

2. If you did not specify the UNC path to the MSP Files folder during installation, you will need to 
add it manually by running a database script. If you did specify the UNC path during installation, 
you can skip this step. 
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3. In PM Compass, display the Project Form view, click the Schedule Integration tab, and perform 

the following steps: 

a. Link the vessel.mpp file to the PM Compass Vessel project. 

b. Click Run Now to load the associated MSP file into PM Compass. 

c. Identify the assignee and approver. 

d. Click Schedule to schedule the creation of progress entries and notifications. 

 

Attention: For steps, see “Add or Edit the MSP Integration Folder UNC Paths” in this guide. 

If you have not yet created the folders, see “Create the MSP Files and Logs Folders and 
Configure the Security Settings” in this guide. 

Attention: For more information, see “Configure Progress for Microsoft Project” in the PM 
Compass Help System under Projects. 

For additional configuration information, see “Appendix N: Integrating with Microsoft Project” 
in this guide. 
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Using the PM Compass Help System 
Once you have completed your PM Compass installation, you can refer to the PM Compass Help System 
for additional configuration guidance.  

For instance: 

 Integration with Other Products: Refer to this section to know about the setup and 
configuration information for each integrated product.  

 Workflow Type Configuration: This section under Administration » Workflow Type 
Configuration includes information about: 

 Creating, deleting, and modifying workflow types 

 Adding and removing standard, custom, and source fields 

 Modifying forms using the Form Designer 

 Workflow concepts and procedures 

 Change Management Process: This section under Workflows » Workflow Types » Change 
Management) steps you through the change request process in detail and includes links to 
related topics. 

 Progress: This section under Projects » Progress includes topics that step you though the 
progress configuration process with links to related topics. 
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Troubleshooting the Installation 
This chapter includes topics on troubleshooting installation-related issues. 

Temporary Log Files and the Log Files Folder 
All temporary log files are stored in the %localappdata% location 
(C:\Users\%username%\AppData\Local\), and a shortcut to the log file is added to the desktop. The log 
file name is similar to the executable file name but with a .txt extension. 

Once the installation is complete, the desktop shortcut is deleted, and the log file is moved to a log 
subfolder in the PM Compass installation directory. This folder contains the installation log, as well as 
logs created when the installation loads reports into the Report server and any subsequent database 
conversions from the database upgrade utility. 

 

Check the Log Files After Installation 
After completing the installation, Deltek recommends reviewing the database conversion log files for any 
errors. If you find any, contact the Deltek Support Center and provide them with the log file contents. 

Conversion Log 
During the conversion, the database conversion log files are saved with a .log extension in the <PM 
Compass Installation Directory>\Logs\ScriptLogs folder. For example: C:\Program 
Files\Deltek\PMCompass\Logs\ScriptLogs. 

These log files contain the output of commands processed against your database and should be sent to 
Deltek if you encounter any errors during the database conversion. The logs are created when you select 
either the Automatically run scripts during the installation or Create batch file to run scripts 
manually option to apply the database changes. 

The Automatically run scripts during the installation option also causes the setup to parse through 
the log file for errors. If any are identified, the setup will display a text window with the contents of the file 
and a warning that errors were encountered during the conversion. 

If you choose to run the database scripts via the installation-created batch file or the product-specific 
batch files, there is an additional batch file named Check_Errors.bat located in each scripts sub-folder 
(Cobra, SQL, and Oracle) that you should also run. This batch file will check the log files created by each 
database script process and write any errors identified in those logs to an Errors.txt file in each scripts 
sub-folder. 

PM Compass Database Upgrade Wizard Utility Log 
If you updated any databases after the installation using the Database Upgrade Wizard Utility, ensure that 
a conversion log for each database was created. Match the time stamp of the conversion with the log file 
starting with DeltekPMCompassDBUpgradeSetupLog... and the time stamps of the files in the 
ScriptLogs folder to identify the scripts for the converted database. The name of the converted database 
can be found in the DeltekPMCompassDBUpgradeSetupLog.txt file. 

Search for the following terms in the log file: 

Note: If you encounter any errors during the installation, contact the Deltek Support Center and 
provide them with the log file. 
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 msg 

 timeout 

 error 

 ORA- 

If you find any errors, contact the Deltek Support Center and provide them with the log file contents. 

If you ran the database scripts using the utility's automatic option or the product-specific batch files, there 
is an additional batch file named Check_Errors.bat located in each ScriptLogs sub-folder. Run this batch 
file to check the log files created by each database script process. It will write any identified errors to an 
Errors.txt file in each script sub-folder. This text file will include the log file where the error was found, the 
line number of the error, and the error text. 

Run the Database Scripts Manually 
If you chose to run the database scripts manually using the installation-created batch file or the product-
specific batch files, there is an additional batch file named Check_Errors.bat located in each script sub-
folder (Cobra, SQL, and Oracle). You should also run this batch file. It will check the log files created by 
each database script process and write any identified errors to a file named Errors.txt in each scripts 
sub-folder. This text file will include the log file where the error was found, the line number of the error, 
and the error text. 

Log Files Generated During the Report-Loading Process 
If you encountered errors during the report-loading process of the installation but the installation 
continued, check the log file in the PM Compass\Logs folder named DeltekMakoCMD_xx-XX.log (where 
xx-XX represents the language of your loaded reports) to ensure the reports were loaded correctly. If 
there are errors, you can reload your reports by navigating to Administration » Report Administration 
and clicking Load Report Files. 

Sample Database Restore Wizard 
Deltek recommends that you review the DeltekPMCompass_RestoreWizard_SetupLog.txt log file to 
check for errors. 

Unsupported Scenarios 
Deltek does not support the following scenarios because they can cause significant issues in the 
performance, reliability, and functionality of your PM Compass application, as well as with other 
applications on your network.  

 Deltek PM Compass and previous versions cannot be run at the same time on the same 
Web/Application server.  

 You cannot perform a single-server deployment on the Microsoft Essentials Edition of Windows 
Server. Only the PM Compass SQL Server database tier and/or report tier can be installed on this 
server. 

 You cannot install any PM Compass tier on the Microsoft ISA server or on any other software-
based firewall (except Windows firewall).  

 You cannot install any PM Compass tier on any server with Citrix configured as a Remote 
Desktop Session Host Server.  

 Server administration via a remote desktop connection is fully supported. 
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 PM Compass does not support using desktop operating systems for production server 
installation. 

 You cannot install any PM Compass tier on: 

 A Domain Controller 

 Any version of Microsoft Exchange Server 

 Any version of Microsoft SharePoint Server 
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Troubleshooting PM Compass 
This chapter provides guidance on how to contact Deltek if you encounter issues during installation. It 
also includes a list of potential installation errors and their possible solutions. 

 

Oracle Issues 
If you encounter the error “ORA-01000: maximum open cursors exceeded,” it indicates that certain 
processes have surpassed the default cursor count (1000).  

To resolve this, increase the number of open cursors on the Oracle database.  

For example: 
alter system set open_cursors = 3000 scope-both; 

“503 Service Unavailable” Error 
If you encounter a “503 Service Unavailable” error when launching PM Compass, it indicates an issue 
with the user account running the PM Compass server components.  

To resolve this, reconfigure the account running those components. 

 

Application Servers Not Identified in EPM SA 
To run jobs in EPM SA, you need to specify the servers. The Application servers you list will then be 
available for selection as Process servers. 

 Application servers: These servers handle user requests, such as saving user data and 
processing requests from the client application. 

 Process servers: These servers manage scheduled jobs, including scheduled reports, queued 
integration processes, and workflows. 

To add, edit, or delete an Application server: 
1. Log into EPM SA using an account with SYSADMIN privileges. 

2. On the Navigation menu, click Configuration » System Settings. 

3. On the Servers tab, do one of the following: 

Attention: For troubleshooting integration issues, see the following sections in this guide: 

 “Troubleshooting Cobra Integration Issues” 

 “Troubleshooting Open Plan Integration Issues” 

 “Troubleshooting Microsoft Project Integration Issues” 

 “Troubleshooting Primavera P6 Integration Issues” 

 “Troubleshooting Oracle Issues” 

Attention: For more information and steps, see “Appendix K: Configure the Account Running the 
Services” in this guide. 
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 On the Application Servers grid toolbar, click Insert to add a new process queue or 
application server 

PM Compass adds a blank row where you can enter the name of the queue or server. 

 In the Application Servers grid, select the queue and click Delete on the grid toolbar to 
delete an existing queue. 

4. Complete or modify other fields on this form and click Save. 

 

SSRS Reports Intermittently Hanging or Failing 
If your reports are intermittently hanging or failing, the issue might be due to antivirus software monitoring 
the folder where SSRS temporary files are written. For a solution, refer to KB article 102261 on the Deltek 
Support Center site. 

 

Microsoft Edge Issue 
If PM Compass does work with Microsoft Edge, confirm that you have enabled the ClickOnce flag in the 
Edge settings. 

To enable the ClickOnce flag: 
1. Display the Microsoft Edge browser. 

2. In the address bar, enter edge://flags/#edge-click-once. 

3. In the ClickOnce Support field, select Enabled. 

4. Restart the browser. 

Email Address for Logged-In User Fails 
The workflow and other processes in PM Compass use email to notify users. Each PM Compass user 
must have a valid email address entered in EPM SA. 

To correct the logged-in user email address: 
1. Log into EPM SA using an account with SYSADMIN privileges. 

2. On the Navigation menu, click Configuration » System Settings. 

3. Use the Search field or navigation arrows to locate the user. 

4. On the General tab, edit the Email field and click Save. 

5. In PM Compass, verify the installed components again. 

Attention: For more information, see “Servers Tab of System Settings” under Managing 
Configuration » System Settings » Toolbar and Tabs in the EPM SA Help System. 

Attention: For additional information regarding Antivirus and SQL Server, see the following Microsoft 
article: Choosing Antivirus Software for Computers that run SQL Server. 

https://support.microsoft.com/en-us/help/309422/choosing-antivirus-software-for-computers-that-run-sql-server


Troubleshooting PM Compass 

Installation Guide 141 

 

PM Compass Report Installation Errors 
When installing reports in PM Compass, you may encounter various errors that can disrupt the process. 
Understanding the common issues and their solutions can help ensure the smooth installation and 
operation of your reports. 

Installation Type Problem Possible Cause Solution 

Upgrade existing PM 
Compass installation 

The connection 
between the Report 
Server database and 
Reporting Services 
URL fails 

The account specified 
in Weblink does not 
have the appropriate 
rights to the Report 
server, Web server, 
Report Server 
databases, and PM 
Compass database. 

Grant the Weblink account 
the necessary rights to the 
Report server or use a 
Weblink account that has 
the necessary rights to the 
report server. 

All installation types The connection 
between the Report 
Server database and 
the Reporting 
Services URL fails. 

The Report server did 
not respond in a 
timely manner and the 
connection timed out. 

Launch PM Compass and 
reload the reports. 

 

PM Compass Tier Installation Messages 
This section provides documentation on messages that may appear during the installation of PM 
Compass tiers, along with brief explanations and tips on how to proceed. 

Run Reports 
Follow this procedure if you get an invalid user error when running reports. 

1. Launch Deltek Weblink. 

2. Select your database. 

3. On the Report Server tab, if your Report Server database connection is configured for Windows 
Authentication, clear and then select the Windows Authentication option to refresh the details. 

4. Save the changes. 

Connecting to the Report Server During Installation 
If you encounter errors connecting to the Report server during installation, review the steps in "Important 
Information about Configuring Report Services" in this guide. 

One potential cause of the 401 error is an invalid username/password combination. If the credentials are 
correct but the 401 error persists, the solution may involve creating a Service Principal Name (SPN) and 
disabling Kerberos authentication. When the Report server service account is configured as a domain 
account, Reporting Services defaults to using Kerberos Authentication.  

Attention: For steps to 
resolve this issue, see 
“Reload Reports” and 
“Refresh Printers” in this 
guide. 
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To prevent HTTP 401 errors when installing the PM Compass Web Tier, testing Weblink connections to 
Reporting Services, or loading reports in PM Compass, perform one of the following: 

 Create an SPN for the account. 

 Turn off Kerberos authentication in the rsreportserver.config file on the Report server. 

 Configure an SPN, logon to a domain controller as a domain administrator and complete the 
steps in the following Microsoft link: https://msdn.microsoft.com/en-us/library/cc281382.aspx. 

 
The screenshot below illustrates the syntax used to add an SPN (setspn -a) for the Report 
server’s NETBIOS and FQDN names with a domain account, as well as the syntax to list (setspn 
-l) the registered SPNs for the domain account. In this example, the domain is 
applebartlett.com, the Report server name is CAMOPSK33TRPT, and the account name is 
RSAccount. 

 
 Alternatively, instead of setting an SPN, you can configure the RSReportServer.config file with 

the following XML structure to specify NTLM only. This approach is suitable for deployments that 
do not support Kerberos or to work around Kerberos authentication errors (HTTP 401 errors). By 
default, this file is located in the Reporting Services installation folder, within the \Reporting 
Services\ReportServer subdirectory: 

 <AuthenticationTypes> 

 <RSWindowsNTLM /> 

 </AuthenticationTypes> 

 

Running Large Reports (SQL Server Reporting Services 
(SSRS) Reports) 
Running large reports can take a significant amount of time to complete. When you preview large reports 
from PM Compass (Reports » <report category> » <report> » Preview), the connection to the server 

Note: Do not specify a port in the command syntax as suggested by Microsoft. 

Attention: For details about Kerberos-related authentication issues and additional steps on 
how to edit the RSReportServer.config file in the following Microsoft Reporting Services 
documentation: https://msdn.microsoft.com/en-us/library/cc281253.asp. 

https://msdn.microsoft.com/en-us/library/cc281382.aspx
https://msdn.microsoft.com/en-us/library/cc281253.asp
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may time out before the report finishes. If you encounter a timeout error, Deltek recommends scheduling 
the report to run on the Process server. This creates an archive of the report that you can view in your 
dashboard once it is complete. To do this, click Schedule on the Reporting toolbar to display the 
Schedule dialog box. 

When scheduling the report, you can select Send Process Status Email Alert to Submitter to receive 
an email notification when the report finishes or fails. Once the report is completed, you can view it by 
clicking on the Archived Reports tab (Reports » <report category>). If the report fails (and does not 
appear on the Archive tab), you can check the Report Logging tab (Administration » Report 
Administration) to locate the report. If it has failed, the Status column will display rsInternalError. 
If you encounter any errors when running reports and need to troubleshoot them, you can find additional 
details in the SQL Server Reporting Services log files on the Report server. Your administrator can review 
these logs. Microsoft provides information on what is stored in the logs, where to find them, and how to 
configure them. 

SQL Logging and SQL Exceptions 
You can enable two modes for logging in PM Compass: 

 SQL Exceptions: This mode provides details when an error occurs. It is recommended that this 
be enabled in a development environment when you are testing new releases. If the error occurs, 
it will be logged, and you will not have to spend time recreating the error. 

 SQL Logging: This mode is verbose logging that captures every query and the time it takes to 
execute the query. This logging is helpful when determining performance issues. This logging 
should only be enabled when determining performance issues. 

 
Enabling logging in the production environment is not recommended for long periods as logging can 
impede performance. You can enable logging by editing the web.config file. If you enter a valid path for 
logging, the SQL Exceptions will be logged. Setting SQLLogging to Y in the file will provide more detailed 
logging used for performance testing. 

 

To enable SQL exceptions: 
1. Create the folder to store logging. 

The logging folder must be shared. Deltek recommends creating a new logs folder called 
SqlLogs on the same level as the folder where you store your Integration Process logs.  

For example, if this is your Integration Files folder: \\<servername>\<Deltek 
folder>\ProcessLogs, then you create your SqlLogs folder here: \\<servername>\<Deltek 
folder>\SqlLogs. 

To see the location of your Integration Process logs, log into PM Compass, navigate to 
Administration » System Settings, and click the File Folders tab. 

2. Locate the web.config file, which is located in the web folder of the PM Compass installation 
directory and open it using Notepad or any other text editor. 

Attention: For more information, see the “Logging and Exception Tracing” topics in the PM Compass 
Help System. 

Note: Make sure that all users are logged out of PM Compass before making these changes. When 
changes are made, all users will automatically be logged out. 
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3. In the <appSettings> section, add or locate the following lines: 
<add key="SQLLogDirectory" value="<log path>" /> 

<add key="SQLLogging" value="<Y/N>" /> 

4. To enable SQL exceptions, modify the following line to include the folder in Step 1. 
<add key="SQLLogDirectory" value="<log path>" /> 

For example: 
<add key="SQLLogDirectory" 
value="\\<server>\DeltekPMCompass\Files\Links\SQLLogs " /> 

5. To include SQL logging, modify these lines to include the folder in Step 1 and set the value to Y.  
<add key="SQLLogDirectory" value="<log path>" /> 

<add key="SQLLogging" value="<Y/N>" /> 

For example: 
<add key="SQLLogDirectory" 
value="\\<server>\DeltekPMCompass\Files\Links\SQLLogs" /> 

<add key="SQLLogging" value="Y"/> 

6. Save and close the web.config file. 

7. Restart IIS by performing the following actions: 

a. On the Start menu, click Run. 

b. Enter inetmgr and click OK to open IIS. 

c. Locate the PM Compass Web application and restart it.  

By default, this is under Default Web Site. 

How PM Compass Writes SQL logs and SQL Exceptions 
The table below shows the conditions under which PM Compass writes logs for SQL and SQL 
exceptions. 

SQLLogging SQLLogDirectory 
Value 

Will Write SQL Logs? Will Write SQL 
Exceptions? 

Y Not specified or folder 
does not exist 

No No 

N Valid path entered No Yes 

Y Valid path entered Yes Yes 

N Not specified or folder 
does not exist 

No No 

Log Format for Query Without Exception (One Line Per SQL Execution) 

[Time Started] [SQL Query] [Elapsed Time] [Number of records returned/Affected records] 
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Sample Log Content 
2019-11-21T17:05:04.888    SELECT CostSystem FROM CAM_SystemSettings  0.001   1 

Log Format for Queries with Exception (One Line Per SQL Execution) 

[Time Started] [SQL Query] [Elapsed Time] ERR:[Exception Error] [Call Stack] 

Sample Log Content 
2018-11-21T17:05:04.888    SELECT CostSystem FROM CAM_SystemSettings ERR: ORA-00001: 
unique constraint (PMC82COB82CU5ORAUPG.CAM_ITEMUPDATESTATUSPK) violated    at 
Oracle.DataAccess.Client.OracleException.HandleErrorHelper(Int32 errCode, 
OracleConnection conn, IntPtr opsErrCtx, OpoSqlValCtx* pOpoSqlValCtx, Object src, 
String procedure, Boolean bCheck)   at 
Oracle.DataAccess.Client.OracleException.HandleError(Int32 errCode, OracleConnection 
conn, String procedure, IntPtr opsErrCtx, OpoSqlValCtx* pOpoSqlValCtx, Object src, 
Boolean bCheck) at Oracle.DataAccess.Client.OracleCommand.ExecuteNonQuery()   at 
Deltek.Framework.Ancestors.Server.ParameterizedCommand.ExecuteCommand(Object[] 
parameterValues) in 
C:\Development\FrameworkDotNet\production\46PMC82\VB\Server\Ancestors\ParameterizedCom
mand.vb:line 155 

Using Windows Event Viewer to Troubleshoot Cobra Web Service 
If you come across unhandled exceptions in Cobra Web Service, you can locate an entry in the Windows 
Event Viewer under Applications and Service Logs » Microsoft » Windows » Application Server-
Applications » Operational log. 

Sending Installation Log Files to Deltek 
If you encounter any problems while installing Deltek PM Compass, contact Deltek Support Center for 
assistance. To help us resolve your installation issues as quickly as possible, send all installation log files 
to Deltek when requesting assistance with troubleshooting an installation. 

 

 

UNC Shared Folders 
If you encounter an error during installation that the UNC share folders cannot be created, check the 
following: 

 Ensure that the UNC path specified is a valid path. 

 Ensure that the account running the PM Compass Application pool in IIS has proper privileges to 
read and write to the share. 

 Ensure that the account running the PM Compass Process Server Windows Service on the Web 
server and any Process servers also has the proper privileges to read and write to the UNC path. 

If necessary, you have the option to edit the folders in PM Compass (Administration » System Settings 
» File Folders). 

Note: Make sure to take note of any error messages that appear when errors occur. If possible, 
capture screenshots and send the screenshot files to Deltek. 

Attention: For more information, see “Temporary Log Files and the Log Files Folder” in this guide. 
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“TemplateFile Missing" Error 
If the ReportTemplates folder created during Cobra installation is missing, it can result in a “TemplateFile 
missing” error during a PM Compass export. When encountering this error, verify that the Report 
Template Location field on the Reports tab of the Application Preferences dialog box in Cobra is 
correctly set. In addition, ensure that a network share is configured to allow all installations of Cobra Web 
Service to access report templates. The user account running the Cobra Web Service Windows Service 
must have at least read rights to the Report Templates folder. Remember that the setting in the Report 
Template Location field is saved per database, so any changes require repetition for each database. 
After making the change, stop and restart both Cobra Web Service and the PM Compass Process server. 



Appendix A: System Requirements 

Installation Guide 147 

 

Appendix A: System Requirements 
Deltek recommends that you carefully consider the system requirements necessary to run PM Compass 
properly. 

Server Software Requirements 
Various parts of the PM Compass application are distributed to logical tiers for performance, scalability, 
and security purposes. These logical tiers are distinct technologies required to run PM Compass, such as 
Report server software or Web server software. They may or may not be hosted on the same server. The 
method you use to distribute PM Compass’s logical tiers across multiple tiers or actual server depends on 
your organization’s needs.  

The software requirements for each logical tier are listed in the tables below. 

 Supported Versions: These are the actively tested versions of technologies used to deploy 
Cobra. These technologies are neither embedded in nor directly supported by Deltek. Changes to 
these technologies are made at the discretion of the technology vendors. 

 Compatible Versions: These are previously supported and tested technologies used to deploy 
Cobra. These are not actively tested but are believed to be compatible with Cobra. Deltek does 
not recommend these technologies for new deployments but will make its best effort to answer 
related questions. These technologies may not be available for troubleshooting by Deltek. 

Supported Deployment Technology Compatible Deployment Technology 

Database Server (Oracle) 

The supported minimum software requirements for the 
complete installation of Deltek PM Compass database tier 
with Oracle include: 

Operating System 
 Microsoft Windows Server 2022 Azure Edition 

 Microsoft Windows Server 2022 

 Microsoft Windows Server 2019  

Database Platform 
Oracle Databases (Standard/Enterprise) 

 Oracle RDBMS 19.10 or higher 

JServer Java Virtual Machine Required 

Operating Systems 
 Microsoft Windows Server 2016 

 UNIX supported with Oracle 
Databases 

 Standard and Enterprise editions 
supported 

 64-bit (x64) Database Server 
supported 

 JServer Java Virtual Machine  

 Supported on Linux, Unix, and 
Exadata 

Database Server (Microsoft SQL Server) 64-bit only 

The supported minimum software requirements for a 
complete installation of Deltek PM Compass database tier 
with Microsoft SQL Server include: 

Operating System 
 Microsoft Windows Server 2022 Azure Edition 

 Microsoft Windows Server 2022 

Operating System 
 Microsoft Windows Server 2016 

Database Platform 
 Microsoft SQL Server 2017 

 Microsoft SQL Server 2016 
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Supported Deployment Technology Compatible Deployment Technology 
 Microsoft Windows Server 2019 

Database Platform 
 Microsoft Azure SQL 

 Microsoft SQL Server 2022 

 Microsoft SQL Server 2019 

Other 
 Microsoft .NET Framework 4.8 (Required for the 

optional installer) 

Database Compatibility Level 
 Microsoft SQL Server 2022 (150) 

 Microsoft SQL Server 2019 (140) 

AI Model Provider 

 Microsoft Azure OpenAI GPT-35-Turbo 

 Microsoft  Azure OpenAI GPT-4-Turbo 

 Microsoft Azure OpenAI GPT-4o 

 Microsoft  Azure Government Cloud GPT-35-Turbo 

 Microsoft  Azure Government Cloud GPT4-Turbo 

 Microsoft Azure Government OpenAI GPT-4o 

 

Report Server (Microsoft SQL Server) 64-bit only 

The supported minimum software requirements for a 
complete installation of Deltek PM Compass Report server 
tier with Microsoft SQL Server include: 

Operating System 
 Microsoft  Windows Server 2022 Azure Edition 

 Microsoft Windows Server 2022 

 Microsoft Windows Server 2019 

Microsoft SQL Server Reporting Services with Report 
Server database on PM Compass supported SQL Server 
versions 1 

 Microsoft SQL Server Reporting Services 2022 

 Microsoft SQL Server Reporting Services 2019 

 Microsoft SQL Server Reporting Services 2017 

Operating Systems 
 Microsoft Windows Server 2016 

Operating Systems 
 Microsoft Visual C++ 

Redistributable for Visual Studio 
2015–2022 
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Supported Deployment Technology Compatible Deployment Technology 

 
Oracle Client - (For Oracle databases only) 

(64-bit/x64) 

 Must match OS Platform 

 Version must match Oracle database server. 

 19c (64-bit only) 

 Oracle Server name/SID defined in tnsnames.ora 
must be the same on your PM Compass Application, 
Report, and Process server tiers. 

Other 
 Microsoft .NET Framework 4.8 

 Microsoft Visual C++ Redistributable for Visual Studio 
2015–2022 

Required when running PM Compass client on the Web 
server 

Web and Process Servers Software Requirements 
Supported Deployment Technology Compatible Deployment 

Technology 

Web Server 

The supported minimum software requirements for the complete 
installation of Deltek PM Compass Web server tier include: 

 

Operating System 
 Microsoft Windows Server 2022 Azure Edition - With 

Microsoft Internet Information Services (IIS) 10.0 Role 
enabled 

 Microsoft Windows Server 2022 - With Microsoft Internet 
Information Services (IIS) 10.0 Role enabled 

 Microsoft Windows Server 2019 - With Microsoft Internet 
Information Services (IIS) 10.0 Role enabled 

Operating System 
 Microsoft Windows 

Server 2016 - With 
Microsoft Internet 
Information Services 
(IIS) 10.0 Role enabled 

Transport Layer Security (TLS) 
If you have implemented TLS, review Appendix S: Secure 
Transport Layer Security (TLS). 

 

Warning: 1SSRS Report Server databases cannot be 
hosted on Microsoft Azure SQL because Microsoft SSRS 
does not support it. 
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Supported Deployment Technology Compatible Deployment 
Technology 

Oracle Client - For Oracle databases only 
You must install both the 32-bit and 64-bit Oracle client on the Web 
server.  

 Version must match the Oracle database server. 

 19c (Deltek recommends 19.3 or higher1) 

 Oracle Server name/SID defined in tnsnames.ora must be 
the same on your PM Compass Application, Report, and 
Process server tiers. 

 

 

SQL Server Database Drivers - For SQL Server databases only 
(32-bit and 64-bit) 

 Microsoft OLE DB Driver 19 for SQL Server (x64)  

 Microsoft ODBC Driver 17.3 for SQL Server 

 Microsoft Command Line Utilities 15 for SQL Server 

 Microsoft SQL Server 2012 Native Client 

 Microsoft Visual FoxPro OLEDB Provider 

 

Optional Scheduling Integration with Microsoft Project Files 
(.mpp files) 
For PM Compass to integrate with Microsoft Project files (.mpp 
files): 

 You must install one of the following on the PM Compass 
server: 

 Microsoft Project Professional 2013 (on Windows 
Server 2016 and 2019) 

 Microsoft Project Professional 2016 (on Windows 
Server 2022) 

 Microsoft Project Professional 2019 

 

Note:  
 You must install the supported .NET Framework before 

installing the Oracle client. 

 1The Oracle client installations do not register the data 
access components.  See “Register your Oracle Client” 
section in “Appendix F: Using Oracle with PM 
Compass” of this guide for details to register the Oracle 
data components to avoid an error in the PM Compass 
application when it tries to connect to the Oracle 
database. 
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Supported Deployment Technology Compatible Deployment 
Technology 

 Microsoft Project Professional 2021 

 Microsoft Project Professional 2024 

Microsoft Project Professional 2019, 2021, and 2024 are supported 
for .mpp files only.  

Microsoft Project Standard is also supported for those versions. 

AND 
 You must configure the Project Server accounts on the 

Project Web App Accounts setting menu by selecting the 
following: 

 Computer Account 
 Set as Default 

 

Optional Scheduling Integration with Microsoft Project Server 
(Project Web Application versions 2013 or 2016 only) 
For PM Compass to integrate with Microsoft Project Server, the PM 
Compass server requires Microsoft Project Professional 2013 SP1 
64-bit version only with update from Nov 10, 2015 applied on the 
server. 

Supported: 
 Connection to Project Server 2016 using Project 

Professional 2013 

 Project Professional 2013 with Project Web Application 
2013 

Not supported: 
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Supported Deployment Technology Compatible Deployment 
Technology 

 Connection to Project Server 2019 using Project 
Professional 2013 

 Connection to Project Server with Project Professional 
2016 or higher 

 

Optional Scheduling Integration with Oracle Primavera 
 Oracle Primavera P6 EPPM 23.12 

 Oracle Primavera P6 EPPM 22.12 

 Oracle Primavera P6 EPPM 21.12 

Oracle Primavera 
 Oracle Primavera P6 

EPPM 19.12 

 Oracle Primavera P6 
EPPM 18.8 

 Oracle Primavera P6 
EPPM 17.12 

Other 
 Regional Language: The Format field (on the Formats tab 

under Control Panel » Region) on the server should be 
the same as the end user’s setting. 

 Solid PDF Converter: PM Compass installs it if not 
detected during installation. 

 SSL Supported: Steps to configure PM Compass for use 
with SSL are detailed in the “Configure the Secure Sockets 
Layer (SSL)” section of the Deltek PM Compass Advanced 
Administration Guide. 

The SSL architecture of PM Compass is such that, if you are using 
SSL for PM Compass, you must use SSL for Reporting Services. 
You cannot run SSL for PM Compass without an SSL binding 
configured for Reporting Services. You cannot run PM Compass 
without SSL and still use SSL for Reporting Services. 

 Microsoft Visual C++ Redistributable for Visual Studio 
2015–2022 

 Microsoft .NET Framework 4.8 

 

Warning: PM Compass supports integrating and connecting to 
Microsoft Project Server, but it REQUIRES that the Microsoft 
Project Professional 2013 64-bit client be installed on the PM 
Compass Web/Application and Process servers. 

Do not install Microsoft Project Professional 2016 on the PM 
Compass Web/Application and Process servers. 

Microsoft Windows Server 2022 does not support Microsoft 
Project Professional 2013 installation and license activation. 

PM Compass does not support connection to Project Web 
Application 2019. 
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Supported Deployment Technology Compatible Deployment 
Technology 

Process Server 

The supported minimum software requirements for the complete 
installation of Deltek PM Compass Process server tier include: 

 

Operating System 
 Microsoft Windows Server 2022 Azure Edition - With 

Microsoft Internet Information Services (IIS) 10.0 Role 
enabled 

 Microsoft Windows Server 2022 - With Microsoft Internet 
Information Services (IIS) 10.0 Role enabled 

 Microsoft Windows Server 2019 - With Microsoft Internet 
Information Services (IIS) 10.0 Role enabled 

Operating System 
 Microsoft Windows 

Server 2016 - With 
Microsoft Internet 
Information Services 
(IIS) 10.0 Role enabled 

Transport Layer Security (TLS) 
If you have implemented TLS, review Appendix S: Secure 
Transport Layer Security (TLS). 

 

Oracle Client - For Oracle databases only 
You must install both the 32-bit and 64-bit Oracle client on the Web 
server.  

 Version must match the Oracle database server. 

 19c (Deltek recommends 19.3 or higher1) 

 Oracle Server name/SID defined in tnsnames.ora must 
be the same on your PM Compass Application, Report, and 
Process server tiers. 

 

 

SQL Server Database Drivers - For SQL Server databases only 
(32-bit and 64-bit) 

 Microsoft OLE DB Driver 19 for SQL Server (x64)  

 Microsoft ODBC Driver 17.3 for SQL Server 

 

Note:  
 You must install the supported .NET Framework before 

installing the Oracle client. 

 1The Oracle client installations do not register the data 
access components.  See “Register your Oracle Client” 
section in “Appendix F: Using Oracle with PM 
Compass” of this guide for details to register the Oracle 
data components to avoid an error in the PM Compass 
application when it tries to connect to the Oracle 
database. 
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Supported Deployment Technology Compatible Deployment 
Technology 

 Microsoft Command Line Utilities 15 for SQL Server 

 Microsoft SQL Server 2012 Native Client 

 Microsoft Visual FoxPro OLEDB Provider 

Optional Scheduling Integration with Microsoft Project Files 
(.mpp files) 
For PM Compass to integrate with Microsoft Project files (.mpp 
files only): 

 You must install one of the following on the PM Compass 
server: 

 Microsoft Project Professional 2013 (on Microsoft 
Windows Server 2016 and 2019) 

 Microsoft Project Professional 2016 (on Microsoft 
Windows Server 2022) 

 Microsoft Project Professional 2019 

 Microsoft Project Professional 2021 

 Microsoft Project Professional 2024 

Microsoft Project Professional 2019, 2021, and 2024 are supported 
for .mpp files only.  

Microsoft Project Standard is also supported for those versions. 

AND 
 You must configure the Project Server accounts on the 

Project Web App Accounts setting menu by selecting the 
following: 

 Computer Account 
 Set as Default 
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Supported Deployment Technology Compatible Deployment 
Technology 

 

Optional Scheduling Integration with Microsoft Project Server 
(Project Web Application versions 2013 or 2016 only) 
For PM Compass to integrate with Microsoft Project Server, the PM 
Compass server requires Microsoft Project Professional 2013 SP1 
64-bit version only with update from Nov 10, 2015 applied on the 
server. 

Supported: 
 Connection to Project Server 2016 using Project 

Professional 2013 

 Project Professional 2013 with Project Web Application 
2013 

Not supported: 

 Connection to Project Server 2019 using Project 
Professional 2013 

 Connection to Project Server with Project Professional 
2016 or higher 
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Supported Deployment Technology Compatible Deployment 
Technology 

 

Optional Scheduling Integration with Oracle Primavera 
 Oracle Primavera P6 EPPM 23.12 

 Oracle Primavera P6 EPPM 22.12 

 Oracle Primavera P6 EPPM 21.12 

Oracle Primavera 
 Oracle Primavera P6 

EPPM 19.12 

 Oracle Primavera P6 
EPPM 18.8 

 Oracle Primavera P6 
EPPM 17.12 

Other 
 Regional Language: The Format field (on the Formats tab 

under Control Panel » Region) on the server should be 
the same as the end user’s setting. 

 Solid PDF Converter: PM Compass installs it if not 
detected during installation. 

 SSL Supported: Steps to configure PM Compass for use 
with SSL are detailed in the “Configure the Secure Sockets 
Layer (SSL)” section of the Deltek PM Compass Advanced 
Administration Guide. 

The SSL architecture of PM Compass is such that, if you are using 
SSL for PM Compass, you must use SSL for Reporting Services. 
You cannot run SSL for PM Compass without an SSL binding 
configured for Reporting Services. You cannot run PM Compass 
without SSL and still use SSL for Reporting Services. 

 Microsoft Visual C++ Redistributable for Visual Studio 
2015–2022 

 Microsoft .NET Framework 4.8 

 

Warning: PM Compass supports integrating and connecting to 
Microsoft Project Server, but it REQUIRES that the Microsoft 
Project Professional 2013 64-bit client be installed on the PM 
Compass Web/Application and Process servers. 

Do not install Microsoft Project Professional 2016 on the PM 
Compass Web/Application and Process servers. 

Microsoft Windows Server 2022 does not support Microsoft 
Project Professional 2013 installation and license activation. 

PM Compass does not support connection to Project Web 
Application 2019. 
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Client Software Requirements 
Supported Deployment Technology Compatible Deployment Technology 

Client Operating Systems 

The supported minimum software requirements for 
the PM Compass Workstation include: 

Operating Systems (32-bit or 64-bit/x64) 

 Microsoft Windows 11 

 Microsoft Windows 10 

Citrix 
 XenApp 7.x (Win Svr 2022) 

 XenApp 7.x (Win Svr 2019) 

 XenApp 7.x (Win Svr 2016) 

 

Microsoft Edge 
 Microsoft Edge v87 (Nov 2020 or later) 

 

 

 

Microsoft Excel 
 Microsoft Excel 365 

 Microsoft Excel 2024 

 Microsoft Excel 2021 

 Microsoft Excel 2019 

Microsoft Word 
 Microsoft Word 365 

 Microsoft Word 2024 

 Microsoft Word 2021 

 Microsoft Word 2019 

 Adobe Reader or compatible PDF Reader 
(for exporting reports in PDF format) 

Microsoft Excel 
 Microsoft Excel 2016 

Microsoft Word 
 Microsoft Word 2016 

 

Note: You can launch PM Compass from 
Chrome with a chrome web store third-party 
ClickOnce extension. For example, Windows 
ReMix ClickOnce helper, Meta4 ClickOnce 
Launcher, or ClickOnce for Google Chrome by 
Menarva. 

Note: You can launch PM Compass from 
Edge if ClickOnce is enabled. ClickOnce is 
enabled by default from Edge build 87 (Nov 
2020). 
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Supported Deployment Technology Compatible Deployment Technology 
 Microsoft Office 365 is supported but requires 

full product installation. 

 Adobe Reader or compatible PDF Reader (for 
exporting reports in PDF format) 

 

 Microsoft .NET Framework 4.8 

 Microsoft Visual C++ Redistributable for Visual 
Studio 2015–2022 

 

Deltek Product Integration 
Supported Deployment Technology Compatible Deployment Technology 

Deltek Product Integration 

The versions listed below are the minimum 
supported versions installed on Client machines. 
Subsequent cumulative update (CU) releases 
within the listed major/minor release will be 
supported unless otherwise noted. Subsequent 
major or minor releases are not supported. 

Deltek Cobra1 
 Cobra 8.7 (Beginning with PM Compass 8.5 

Cumulative Update 07) 

 Cobra 8.6 

 Cobra 8.5 Cumulative 17 or later 

 
Cobra and PM Compass License Compatibility 
Cobra licenses—whether concurrent or named—
do not impact PM Compass operations or 
compatibility. It is not necessary to convert Cobra 
licenses to named-user licenses for use with PM 
Compass. 

 

Note: PM Compass supports integration with 
Microsoft Office with exporting of lists and 
reports to Excel, and reports to Word. 

Note: 1Cobra Web Service updates are 
included in the PM Compass Web and 
Process server installation. Cobra Web 
Service uses port 8000. For more information, 
see the Deltek PM Compass Advanced 
Administration Guide. 



Appendix A: System Requirements 

Installation Guide 159 

 

Supported Deployment Technology Compatible Deployment Technology 

Deltek Open Plan (64-bit) 
 Open Plan 8.8 (Beginning with PM Compass 

8.5 Cumulative Update 11) 

 Open Plan 8.7 Cumulative 07 or later 

 Open Plan 8.6 Cumulative 11 or later 

Deltek Open Plan Add-In for PM Compass 
 Open Plan Add-In for PM Compass 8.5 

Integration Installers 
Installs the appropriate integration files on the PM 
Compass Web/Application and Process servers. 
The files are located in DSM under the PM 
Compass folder in the Sub-Release section. 

 Cobra 8.5 Integration for PM Compass 8.5 

 Cobra 8.6 Integration for PM Compass 8.5 

 Open Plan 8.6 Integration for PM Compass 
8.5 

 Open Plan 8.7 Integration for PM Compass 
8.5 

 MSP Server Integration for PM Compass 8.5  

(Provides Project Server Integration with 
Progress support for non-Open Plan users) 

 Primavera P6 Server Integration for PM 
Compass 8.5  

(Provides Primavera P6 Server Integration 
with Progress support for non-Open Plan 
users) 

 

Open-Source Software 
This table describes the open-source software included in PM Compass. 

Software Company 

Oracle Data Access Components 
4.122.1.20161216 

Oracle 

Pcrypt Public domain Password encryption based on 
D3DES 

Newtonsoft Json.NET 12.0.3.23909 Newtonsoft 
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PM Compass Architecture 
PM Compass is a 64-bit (x64) application. Cobra Web Service is a 32-bit application that runs in WOW64 
mode on 64-bit servers.  

.NET Framework  
PM Compass’s server-side architecture uses Microsoft’s .NET framework. The .NET framework v4.8 must 
be installed on the client and the Web server. In addition, you must install the .NET framework before 
installing the Oracle client.  

 .NET is Microsoft’s name for a set of software technologies developed to connect information, people, 
systems, and devices. 

 
The .NET framework gives users the power to extend PM Compass’s reach — by developing applications 
that integrate with PM Compass, calling Web Service from within PM Compass, and communicating with 
PM Compass through mobile devices.  

Deltek’s main client application is deployed using the ClickOnce technology, which requires Microsoft 
.NET Framework.  

 

Using Microsoft Edge in Dashparts and Custom Menu Items 
If you are going to use Microsoft Edge in dashparts and custom menu items, Deltek recommends 
installing Microsoft Edge WebView2 Runtime, a control that utilizes Microsoft Edge as a rendering engine, 
on the client machine. 

 
WebView2 Runtime is automatically installed if you are using any of the following products: 

 Windows 10 version 21H1 or later 

 
 Office 365  

 
PM Compass automatically detects if WebView2 Runtime is installed when displaying web pages on http 
dashparts. Otherwise, PM Compass uses the previous Web browser control that utilizes Internet Explorer 
as a rendering engine. 

Attention: For more information, see https://www.microsoft.com/net/. 

Note: You can download the Microsoft .NET Framework from this link: https://www.microsoft.com/en-
us/download/details.aspx?id=42642. 

Attention: For more information on Microsoft Edge WebView2 Runtime, see 
https://docs.microsoft.com/en-us/microsoft-edge/webview2/. 

Attention: For more information, see https://docs.microsoft.com/en-
us/deployoffice/webview2-install. 

Note: Microsoft Edge WebView2 Runtime is displayed on Apps & features. 

https://www.microsoft.com/net/
https://www.microsoft.com/en-us/download/details.aspx?id=42642.
https://www.microsoft.com/en-us/download/details.aspx?id=42642.
https://docs.microsoft.com/en-us/microsoft-edge/webview2/
https://docs.microsoft.com/en-us/deployoffice/webview2-install
https://docs.microsoft.com/en-us/deployoffice/webview2-install


Appendix A: System Requirements 

Installation Guide 161 

 

Install Microsoft Edge WebView2 

When generating the Assisted Explanation of Variance (EoV)workflow, a blank screen may be displayed 
with no details. In addition, clicking the Print button may return an error on that screen. This issue may be 
caused by the Edge WebView2 Runtime not being installed or possibly being corrupted. 

Follow this procedure to install Microsoft Edge WebView2. 

To install Microsoft Edge WebView2: 
1. Navigate to the Download the WebView2 Runtime site.  

2. Download the Evergreen Standalone Installer x64 and install it on the client machine that is 
unable to view the Assisted EOV. 

3. Restart PM Compass on the client machine. 

Hardware Sizing Considerations 
There are several factors that go into sizing an appropriate server infrastructure. The number of 
concurrent users accessing the system at any given time, the amount of data being analyzed, and growth 
expectations all have an impact on the initial sizing plans. The hardware profiles are intended as a 
starting point for deployment. It is expected that our clients will use the product in many ways. Plans for 
future releases, and client customizations will all impact the growth and scaling of the overall solution. 
Further in-depth discussion of the business needs of the solution during implementation of application will 
provide final guidance on hardware requirements. 

Memory Requirements for a Typical/Average Use 
Below are details on the memory footprint of the product. 

Tier Memory* 

Client Tier  200 MB - 250 MB for PMC when progressing a single project with 500 – 
1,000 activities 

Application Tier 
(Citrix/Terminal 
Server only) 

 75 MB – 100 MB per concurrent user. 

Reporting Tier  350MB – 500MB for PM Compass per concurrent user per report when 
running reports with 900 activities and 75-100 control accounts with 300-
400 work packages. 

Database Tier  Database instance memory should be 10% - 15% of the database size. For 
example, if database size is expected to be 500GB then allocate 50GB - 
75GB memory. 

* Per concurrent client instance and in addition to any memory needed for the operating system and other 
applications that may run in parallel with this product.  

Definition of Typical/Average Use 
A user using PM Compass when progressing a single project (500 – 1,000 activities) using the Progress 
view. 

https://developer.microsoft.com/en-us/microsoft-edge/webview2/?form=MA13LH#download
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Hardware Requirements 
The number of people using PM Compass, the PM Compass processes they are using, and the size of 
your database all have an effect on the hardware and software requirements for your servers. 

 

Single-Server Deployment (One Server) 
The following table lists the recommended minimum hardware requirements for a PM Compass single 
deployment. 

Installation for 1 to 25 Concurrent Users 

Tier Hardware Required Determining Factors 

Database / Web / Application / 
Reporting Tier 

Server Class Machine 
 2 x Logical Processor  

 2.8 GHz or faster CPU  

 16 GB Physical Memory 

 

Two-Server Deployment (Two Servers) 
The following table lists the recommended minimum hardware requirements for a PM Compass two-
server deployment. 

Installation for 25 to 200 Concurrent Users 

Tier Hardware Required Determining Factors 

Database Tier/Reporting Tier 
*The report tier can be installed 
on either the Web server or the 
SQL Server. 

Additional SQL licensing costs 
may be incurred if installing SQL 
Reporting Services on PM 
Compass web tier. 

Server Class Machine 
 1 - 2 x Logical Processor 

2.6 GHz or faster CPU 

 8+ GB Physical Memory 

 Database Size 

 Database Growth 

Web/Application/Reporting 
Tier 
*The report tier can be installed 
on either the Web server or the 
SQL Server. 

Server Class Machine 
 1 - 2 x Logical Processor 

2.6 GHz or faster CPU 

 8+ GB Physical Memory 

 Total Users 

 Power Users 

 User Location 

 Database Size 

Note: Specific server hardware configurations may have an impact on your overall Deltek product 
licensing requirements. It is recommended you confirm with a Deltek Technical Sales Engineer if the 
server hardware you plan to deploy is in line with your Deltek license agreement and how overall 
server infrastructure expansion in the future may affect your Deltek licensing. 
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Tier Hardware Required Determining Factors 
(Additional SQL licensing costs 
may be incurred if installing SQL 
Reporting Services on PM 
Compass web tier. 

Three-or-More Server Deployment (Three or More Servers) 
The following table lists the recommended minimum hardware requirements for PM Compass three-or-
more server deployment. 

Installation for 200+ Concurrent Users 

The three-or-more-servers installation model is designed for large organizations. There might be 
additional Report, Application, or Web servers required for load balancing, performance, security, or fault 
tolerance reasons. You can use additional servers to run multiple reports, applications, or Web servers on 
additional servers. Contact your Deltek Technical Services representative for instructions. 

Tier Hardware Required Determining Factors 

Database Tier Server Class Machine 
 2 x Logical Processor 2.8 

GHz or faster CPU 

 16+ GB Physical Memory 

 Database Size 

 Database Growth 

 PM Compass Processes 

Reporting Tier 
*Additional SQL licensing costs 
may be incurred if installing SQL 
Reporting Services on a 
dedicated Report server. 

Server Class Machine 
 2 x Logical Processor 2.6 

GHz or faster CPU 

 16+ GB Physical Memory 

 Power Users 

 Database Size 

Web/Application Tier Server Class Machine 
 2 x Logical Processor 2.6 

GHz or faster CPU 

 8+ GB Physical Memory 

 Total Users 

 Power Users 

 User Location 

 PM Compass Processes 

Workstation Deployment (Client Tier) 
The following table lists the recommended minimum hardware requirements for the client tier (web 
application only). 

Client Tier Hardware Required Determining Factors 

Minimum  1.8 GHz or faster CPU 

 2 GB RAM 

 40 GB Hard Drive 

Usage (for web application only, 
not for workstations running the 
Smart Client application) 
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Client Tier Hardware Required Determining Factors 
 1024x768 SVGA Video 

Display 

Recommended  2.0 GHz or faster CPU 

 2 GB RAM  

 40 GB Hard Drive 

Usage 

Using PM Compass with Citrix or Remote Desktop 

 
The Deltek PM Compass Smart Client Web application uses the Microsoft .NET Framework ClickOnce 
deployment technology which makes it easy for administrators to deliver Windows-based applications to 
end-users by sending them a URL. However, in cases where Citrix is used, the ClickOnce deployment 
behavior may not be supported by Microsoft or Citrix. 

 

Unsupported Scenarios 
Deltek does not support the following scenarios because they can cause significant issues in the 
performance, reliability, and functionality of your PM Compass application, as well as with other 
applications on your network.  

 Deltek PM Compass and previous versions cannot be run at the same time on the same 
Web/Application server.  

 You cannot perform a single-server deployment on the Microsoft Essentials Edition of Windows 
Server. Only the PM Compass SQL Server database tier and/or report tier can be installed on this 
server. 

 You cannot install any PM Compass tier on the Microsoft ISA server or on any other software-
based firewall (except Windows firewall).  

 You cannot install any PM Compass tier on any server with Citrix configured as a Remote 
Desktop Session Host Server.  

 Server administration via a remote desktop connection is fully supported. 

Note: If you are running Model Changes which is part of the integrated BCR process and Open Plan 
is running in a Citrix environment, then you will need to follow the steps in the “Using PM Compass 
with Citrix or Remote Desktop (ClickOnce Bypass)” in the Deltek PM Compass Advanced 
Administration Guide. 

This is required because the Open Plan Client process and the PM Compass web client must be 
running in the same user session on the same server.  

If Open Plan is running on a Citrix box, then the PM Compass client will also need to be launched on 
the Citrix box launched from within Open Plan. 

Attention: For more information about the Smart Client ClickOnce Deployment Options, see “Using 
PM Compass with Citrix or Remote Desktop (ClickOnce Bypass)” in the Deltek PM Compass 
Advanced Administration Guide. 
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 PM Compass does not support using desktop operating systems for production server 
installation. 

 You cannot install any PM Compass tier on: 

 A Domain Controller 

 Any version of Microsoft Exchange Server 

 Any version of Microsoft SharePoint Server 
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Appendix B: Microsoft Internet Information 
Service (IIS) Installation on Windows Server 
This chapter covers topics on IIS installation. 

Check If Microsoft (IIS) Is Already Installed 
If you have already enabled the Web Server role on your Web server, you need to check the features and 
role services. 

To check the features and role services on Windows Server 2016 or 2019: 
1. Launch Server Manager. 

2. In the left menu, click IIS.  

If the IIS option is not listed, perform the steps for installing Microsoft IIS for the first time. 

3. In the Roles and Features group, verify that all of the required role services are installed. 

 

Install Microsoft IIS For the First Time 
Follow this procedure to install Microsoft IIS for the first time. These steps are necessary for the proper 
detection of ASP.NET. 

To install Microsoft IIS on Windows Server 2016 or 2019: 
1. Log onto Microsoft Windows Server as a domain or local administrator. 

2. Launch Server Manager. 

3. Click Manage » Add Roles and features. 

4. On the Before you begin screen of the Add Roles and Features Wizard, click Next.  
5. On the Select installation type screen, select Role-based or feature-based installation and click 

Next.  
6. On the Select destination server screen, select your server and click Next. 
7. On the Select server roles screen, select Web Server (IIS).  

a. In the Add Roles and Features Wizard dialog box, click Add Features. 

8. On the Select server roles screen, click Next. 
9. On the Select Features screen, expand .NET Framework 4.x Features, select .NET Framework 

4.x and ASP.NET 4.x, and click Next. 

10. On the Web Server Role (IIS) screen, click Next. 
11. On the Select role services screen, enable the following sub-options: 

 Web Server 

Attention: For more information, see Step 11 in “Install Microsoft IIS For the First Time” 
below. 
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 Common HTTP Features 
 Default Document 

 Directory Browsing 

 HTTP Errors 

 Static Content 

 HTTP Redirection 

 Health and Diagnostics 
 HTTP Logging 

 Request Monitor 

 Performance 
 Static Content Compression 

 Security 
 Windows Authentication 

 Request Filtering 

 Application Development 
 .NET Extensibility 4.x 

 ASP.NET 4.x 

 
 ISAPI Extensions 

 ISAPI Filters 

 Management Tools 
 IIS Management Console 

 IIS Management Scripts and Tools 

12. Click Next. 
13. In the Confirm Installation Instructions dialog box, click Install to begin the process. 

 
14. In the Installation Results dialog box, click Close. 

 

Note: The Add Roles and Features Wizard dialog box displays when you select this option. 
Click the Add Features button.) 

Note: On the Confirm installation selections screen, if a message displays about specifying 
an alternate source path, see the Microsoft KB article # 2734782 (Method 2). 

Note: If you have not applied the supported version of Microsoft.NET on your server, make 
sure you install it before beginning the PM Compass installation. 

http://support.microsoft.com/en-us/kb/2734782
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Enable the IIS Feature from a PowerShell Console 
As an alternative to the graphical user interface, you can enable IIS components from a PowerShell 
console.  

To enable IIS from a PowerShell console: 
1. Right-click on the Windows Start Menu and select one of the following options (whichever 

appears: 

 Windows PowerShell (Admin)  
 Command Prompt (Admin) 

 Enter PowerShell and click Enter.  
2. In the PowerShell console, run the following command: 

Install-WindowsFeature -Name Web-Server,Web-Http-Redirect,Web-Request-
Monitor,Web-Windows-Auth,Web-Net-Ext45,Web-Asp-Net45,Web-ISAPI-Ext,Web-ISAPI-
Filter,Web-Scripting-Tools –IncludeManagementTools 
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Appendix C: Microsoft SQL Server Reporting 
Services 
Microsoft SQL Server Reporting Services (SSRS) is a server-based reporting platform that you can use to 
create and manage tabular, matrix, graphical, and free-form reports that contain data from relational and 
multidimensional data sources. The reports that you create can be viewed and managed over a World 
Wide Web-based connection. SSRS includes the following core components: 

 A complete set of tools that you can use to create, manage, and view reports. 

 A Report server component that hosts and processes reports in a variety of formats. Output 
formats include HTML, PDF, TIFF, Excel, CSV, and more. 

 An API that allows developers to integrate or extend data and report processing in custom 
applications or create custom tools to build and manage reports. 

The reports that you build can be based on relational or multidimensional data from SQL Server, Analysis 
Services, Oracle, or any Microsoft .NET data provider such as ODBC or OLE DB. You can create tabular, 
matrix, and free-form reports. You can also create ad hoc reports that use predefined models and data 
sources. 

SSRS uses URLs to access the Report Server Web Service and Report Manager. Before you can use 
either application, you must configure at least one URL each for the Web Service and Report Manager. 
SSRS provides default values for both application URLs that work well in most deployment scenarios, 
including side-by-side deployments with other Web services and applications. 

SSRS uses a SQL Server database for internal storage. The database is a required component. It is used 
to store reports, session data, resources, and server metadata. 

The migration to this new tool includes such benefits as: 

 Ease of Deployment and Management: SSRS is embedded in the SQL Server the database 
clients already use. This streamlines deployment and updates and provides a platform for 
delivery of new functionality for years to come. 

 Industry Leading Platform: SSRS is fast becoming one of the leading Business Intelligence (BI) 
platforms in the market. 

 Better Technology Alignment with PM Compass: SSRS aligns well with the rest of the 
Microsoft centric technology strategy for PM Compass. 

 

Additional Information about SSRS 
The best way to learn about SSRS and how to configure it is through the documentation included with 
your SQL Server (Books Online, Microsoft Labs, and so on). The following links provide steps for 
configuring the latest versions of SSRS: 

 For SQL Server Setup, Install and Upgrade (How-to Topics):  

https://msdn.microsoft.com/en-us/sqlserver/ff625277 

 For Configuring SQL Server Reporting Services (How-to Topics): 

https://msdn.microsoft.com/en-us/library/bb934490 

Note: Scale-out configuration of SSRS is supported and provides a load balanced configuration for 
scalability. This requires the Enterprise Edition of SQL Server. 

https://msdn.microsoft.com/en-us/sqlserver/ff625277
https://msdn.microsoft.com/en-us/library/bb934490
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The following links provide additional information about Reporting Services: 

 Reporting Services Overview and Tutorials: 

https://msdn.microsoft.com/en-us/library/ms159106.aspx 

 Demos, Videos, Virtual Labs, Webcasts: 

https://msdn.microsoft.com/en-us/sqlserver 

 Registering the Managed ODP.NET for the RDL Reports: 

https://learn.microsoft.com/en-us/sql/reporting-services/report-data/ 

If your reports are intermittently hanging or failing, the issue may be caused by the antivirus software 
monitoring the folder where the SSRS temporary files are being written. 

 

 

PM Compass Report Management and Delivery Platform 
PM Compass uses SSRS as the report management and delivery platform.  

There are several things to consider when you are planning a PM Compass implementation. 

 SSRS must be installed and configured to connect to the Report Server before installing PM 
Compass.  

 The Microsoft SQL Server Edition and type of licensing purchased may impact your SSRS 
deployment options. 

 PM Compass utilizes the SSRS’s WinForm Report Viewer control to display reports. This control 
necessitates a direct connection to the server hosting the SSRS Web Service via Port 80. 
Consequently, if your server is accessible from the internet, both your Report server and 
potentially your Database server (if they are on the same machine) will be directly exposed to the 
Internet, posing a security risk to your data. In addition, an external fully qualified domain name 
(FQDN) is required for external users to resolve the Report server. 

 
 When storing PM Compass data in an Oracle database, the Report server must have the Oracle 

client installed and configured to connect to the PM Compass database. Once this setup is 
selected, the sample database will be restored into a database on the Reporting Server. 

Attention: For a solution, refer to KB article #102261 on the Deltek Support Center site. 

Attention: For additional information regarding Antivirus and SQL Server, see the following Microsoft 
article: Choosing Antivirus Software for Computers that Run SQL Server. 

Note: A reverse proxy that uses Microsoft’s Application Request Routing (ARR) extension 
for IIS allows the direct forwarding of requests through the PM Compass Web server to the 
Reporting Services Web Service, with responses going back to your Internet clients. This 
configuration resolves all of the issues identified above. 

For more information about creating a reverse proxy, see the Deltek PM Compass 
Advanced Administration Guide. 

https://msdn.microsoft.com/en-us/library/ms159106.aspx
https://msdn.microsoft.com/en-us/sqlserver
https://learn.microsoft.com/en-us/sql/reporting-services/report-data/
https://support.microsoft.com/en-us/help/309422/choosing-antivirus-software-for-computers-that-run-sql-server
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Microsoft SQL Server Editions 
This section discusses topics related to using the SQL Server Editions. 

SQL Server Workgroup and Express Editions 
Users of SQL Server Workgroup Edition and SQL Server Express Edition with Advanced Services (SQL 
Server Express) should note the following: 

 PM Compass does not support the SQL Server Express Edition. 

 The Report server database must be hosted on the local machine running the SQL Server 
database engine instance. Remote SQL Server instances cannot be used to host the Report 
Server database. 

 Data sources used in a report must also be SQL Server databases running on the local machine 
with the SQL Server database engine instance. Remote data sources or other data sources are 
not supported. To use additional data source types, a different edition of SSRS is required. This 
means your PM Compass database must reside on the same machine as your Report Server 
database. 

 If your PM Compass data is stored in Oracle or on a different Database server from your 
Reporting Services server, you cannot use the Workgroup Edition of SQL Server. This edition 
requires that both the source data (where your PM Compass data is stored) and the Report 
server be on the same machine. 

 Report history snapshots are not supported in the Web edition of the SQL Server database. At 
least the Standard edition of SQL Server is required. 

 You will either use the Single-Server Deployment Model or Configuration 1 of the Two-Server 
Deployment Model. 

SQL Server Standard, Business Intelligence, and Enterprise Editions 
Users of SQL Server Standard, Business Intelligence, or Enterprise Editions should note the following: 

 The report snapshots feature in SSRS requires at least the Standard edition of SQL Server. 

 If you choose to separate the Report server (Web Service) from the Database server hosting the 
Report Server database, an additional Microsoft SQL Server license is required. 

 
 Report Server scale-out deployment, which involves multiple Report Server instances sharing a 

single Report Server database, is only available in the Microsoft SQL Server Enterprise Edition. 

 

SSRS and Your Deployment Model Options 
When planning your deployment of SSRS, it is important to consider the capabilities and requirements of 
your SQL Server Edition. Here are the options based on different editions: 

Attention: For more information, see “Report Server Licensing Requirements” in this 
guide. 

Attention: For the list of features supported by the editions of SQL Server, see 
https://msdn.microsoft.com/en-us/library/cc645993.aspx. 

https://msdn.microsoft.com/en-us/library/cc645993.aspx
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 Two-Server Deployment: Your SQL Server Edition and licenses will determine your two-server 
deployment configuration. 

 WorkGroup Edition: This edition requires that the Report Server database used by Reporting 
Services and any external data sources (such as the PM Compass database) reside on the same 
machine. If you have this edition, you will migrate to either a single-server deployment model or 
the two-server model (Configuration 2). 

 
 Standard and Enterprise Editions: These editions support having the PM Compass database 

on a separate Database server from the server hosting the reporting services Report Server 
database, allowing for deployments on two or more tiers. 

 

Report Server Licensing Requirements 
The deployment method for your Report Server depends on the edition and licenses of your Microsoft 
SQL Server database. If you intend to host your Reporting Services Web Service on a different machine 
from the reporting services Report Server database, you need to verify that your SQL Server edition and 
licenses support this configuration. 

 

Licensing Impacts on Functionality 
The table in this section outlines the licensing implications and impacts on functionality associated with 
the commonly used editions of Microsoft SQL Server available on the market today and supported by PM 
Compass. 

 

Functionality Workgroup Standard Enterprise 

Custom Reporting 

Report Builder    

Report Models for 
Report Builder 

   

Report Designer    

Attention: For more information, see “Installation/Deployment Models” in this guide. 

Attention: For these editions, review the license information and link in the “Report Server 
Licensing Requirements” section below to determine if you have the appropriate number of 
SQL Server licenses. 

Attention: For detailed information on the licensing options available with SQL Server and Reporting 
Services, refer to the following Microsoft article: SQL Server Licensing Options. 

Note: The Express edition is not supported. 

http://www.microsoft.com/en-us/server-cloud/products/sql-server/buy.aspx
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Functionality Workgroup Standard Enterprise 

Standard Reporting 

Access to All Standard 
Reports 

   

Report History 
(Previously Run) 

   

Email Reports    

Email Report Links    

Schedule Reports    

Schedule and Report 
History 

   

Search and Download 
in Preview 

The workgroup does 
not have the XML 
support needed for this 
feature 

  

 

Configure Microsoft SQL Server Reporting Services  
Follow this procedure to configure your initial SSRS setup. This step is only necessary for PM Compass 
to verify SSRS. PM Compass will use the accounts specified on the Report Server tab in Weblink to 
connect to Reporting Services. 

By default, SSRS is configured during the PM Compass installation. These steps are only required if you 
did not configure reporting services during the installation. 

 

To configure your initial SSRS setup: 
1. Click Start » All Programs » Microsoft SQL Server <version> » Configuration Tools » 

Reporting Services Configuration Manager to launch the Reporting Services Configuration 
Wizard. 

2. In the Reporting Services Configuration Connection dialog box, select your SSRS instance name 
and click Connect. 

Attention: For more details about Microsoft SQL Server editions, see 
https://www.microsoft.com/sqlserver/en/us/product-info/compare.aspx. 

Attention: For additional information about configuring Report Services, see “Important Information 
about Configuring Report Services” in this guide. 

https://www.microsoft.com/sqlserver/en/us/product-info/compare.aspx
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3. If the reporting services instance is not already running, navigate to the Report Server Status 

pane of the Reporting Services Configuration Manager dialog box, click Start to start the 
reporting services instance. 

 
4. In the Service Account pane, select the appropriate account in the Use built-in account field, 

and click Apply.  

Microsoft recommends using the Network Service account.  

The Service Account pane displays the results in the bottom pane. 

Note: If you have multiple installations of reporting services, you may see more than one 
instance. MSSQLServer is the default instance. 
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If you have configured the Report Server Service Account to be a domain account, SSRS will use 
Kerberos Authentication by default. 

 
5. In the Web Service URL pane, click Apply to accept the default values.  

The default value for Virtual Directory is ReportServer. If you installed Report Server as an 
instance, the virtual directory usually starts with ReportServer separated by a character, such as 
an underscore or dollar sign, and the instance name to differentiate itself from the others. 

 
6. Take note of the Report Server Web Service URL displayed in the Web Service URL dialog box. 

This information may be needed if PM Compass cannot connect to the Report Server during 
installation and requests the correct path. 

Click Apply to accept your settings. If the settings are correct, the Results pane displays the 
status. 

Attention: For additional information on choosing a service account, see the “Service 
Account Reporting Services Configuration” topic in SQL Server Books Online. 

Attention: For additional information, see “Report Tier” under “Pre-Installation Checklists” in 
this guide. 

Note: PM Compass uses the Report Server Web Service URL at the bottom of the dialog box 
as part of its test connection URL when it tries to connect to the Report server. 

SSRS does not require you to enable IIS. 

https://msdn.microsoft.com/en-us/library/ms189964.aspx
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7. In the Report Server Database pane, click Change Database to display the Change Database 

screen of the Report Server Database Configuration Wizard. 

 
8. On the Change Database screen, select whether to create a new report server database or use 

an existing one. For a new installation, select Create a new report server database and click 
Next. 
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9. Enter the Database server name and a user account that has the appropriate privilege to create 

or select the database and assign the required rights. 

 
a. Click Test Connection to test your credentials. Make the corrections as necessary if the 

server’s name or the user credentials are incorrect. 
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b. Click OK when you have connected successfully to the database to go back to the 

Change Database of the screen of the Report Server Database Configuration Wizard. 

10. In the Database pane, accept the default values and click Next. 

 

 
11. In the Credentials pane, specify the type of credential and accounts for the SSRS connections to 

the database and click Next. 

Note: Only Native Mode is supported. Select Native Mode if it is not selected by default. 
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The summary of the changes that you made is displayed. 

12. Click Next. 

 
The Report Server Database Configuration Wizard displays the status of the steps taken to 
create the report server databases. 
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13. Click Finish when all steps have been marked as successfully completed. 

 
14. In the left pane of the Report Services Configuration Manager dialog box, click Report Manager 

URL. 

15. In the Report Manager URL pane, click Apply to accept the default values.  

The Results pane displays the results. 
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16. Click Encryption Keys in the left pane and back up the encryption keys to a safe location and 

then click Apply. 

17. Click Exit. 
18. Open a web browser and go into the Reports server URL: https://servername/Reports. Once you 

are in, you are now ready to begin the PM Compass installation. 

 

 

Important Information about Configuring Reporting Services 
When setting up SSRS, keep the following points in mind: 

Note: You need to set up the security permission of the Report server by logging into the 
URL. Add the service/admin account that you are using to install PM Compass. 

 In Site Settings » Security, add the service/admin account and assign it the System 
Administrator role. 

 In Reports Folder » Manage » Security, add the service/admin account and assign 
it the Content Manager role. 

Note: Do not configure an Execution Account during the Report server configuration. 
Configuring this account causes the account specified in the Execution Account to be used 
instead of the credentials listed in Weblink. This may result in reporting errors within PM 
Compass. 

https://servername/Reports
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 If you are not familiar with Microsoft Reporting Services or how to configure it, additional details 
and steps can be obtained from the following link: https://msdn.microsoft.com/en-
us/library/ms156305.aspx. 

 If you will use the server-side printing functionality of PM Compass, see “Appendix D: Printing in 
PM Compass” in this guide for instructions on where and how to configure the account. 

 If you have configured the Report Server Service Account to be a domain account, SSRS will use 
Kerberos Authentication by default. You must ensure that you have created an SPN for the 
account. To configure an SPN, complete the steps in this link: https://msdn.microsoft.com/en-
us/library/cc281382.aspx. 

 Alternatively, you can configure the RSReportServer.config file with the following XML structure 
that specifies NTLM only. This is for deployments that do not support Kerberos or to work around 
Kerberos authentication errors (HTTP 401 errors): 
<AuthenticationTypes> 

<RSWindowsNTLM/> 

</AuthenticationTypes> 

 

Connecting to the Report Server 
SSRS provides access to the full functionality of the report server through the report server web service, 
which is an XML Web Service with a SOAP API. It uses SOAP over HTTP and acts as a communications 
interface between client programs and the report server. The Web Service provides two endpoints: one 
for report execution and one for report management. The setup connects to the report execution 
endpoint. If it is unable to connect to the Reporting Service Web Service screen, the setup returns an 
error message. 

The Specify Report Server and Report Server URL Information Screen 
Complete one of the following actions: 

 Verify that the information on the screen is correct and click Next. 
 Update the fields with the correct values then click Next. 

Attention: For more details about Kerberos authentication issues, see 
https://msdn.microsoft.com/en-us/library/cc281253.aspx. 

https://msdn.microsoft.com/en-us/library/ms156305.aspx
https://msdn.microsoft.com/en-us/library/ms156305.aspx
https://msdn.microsoft.com/en-us/library/cc281382.aspx
https://msdn.microsoft.com/en-us/library/cc281382.aspx
https://msdn.microsoft.com/en-us/library/cc281253.aspx
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 Report Server: The Report Server name is the name of your Report Server machine. Make sure 

that the Virtual Directory value matches the Virtual Directory of the Report Server displayed on 
the Reporting Services Configuration Manager dialog box. 

 Report Server URL: The following example shows the format of the URL used to connect to the 
Reporting Services Web Service on the Report Server: 

https://<Report Server Name>/Virtual Directory/reportservice2005.asmx 

 

Note: SQL Server Reporting Web Services (ReportingService2005.asmx) provides the interface for 
enumerating the reports and report folders. It provides a host of other capabilities for report execution, 
rendering and management. 

The “2005” in the Web Service name does not reflect any version of SQL Server. 
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This table describes each element in the URL.  

URL Element Description 

Server The name of the server on which the Report Server is 
deployed. 

Virtual Directory The name of the folder that contains the XML Web Service 
for report execution. This is configured during setup or 
when you run the SSRS Configuration tool. The default 
name//name/virtual directory is named reportserver. 
If you are unsure of the name of your Report Server virtual 
directory, launch the SSRS Configuration tool on the Report 
Server.  

In SQL Server, select the Web Service URL on the left, and 
then view the entry from the Virtual Directory field on the 
right. If you install Reporting Services as an instance, the 
name of the virtual directory may also include the instance 
name. For example, reportserver_INSTANCENAME.  

For example: https://<Report Server 
Name>/reportserver_SQL2014/reportingservices2005.asmx 

<endpointname>.asmx The name of the Web Service endpoint is 
reportingservices2005.asmx. 

This is required in the URL for PM Compass to confirm the 
Report Server configuration. 

Reporting Services Web Service: The SQL Server 
Reporting Web Services (Reportingservices2005.asmx – it 
has not been changed for 2008) provides the interface for 
enumerating the reports and report folders. It provides a 
host of other capabilities for report execution, rendering and 
management. 

Identify Reporting Services Web Service URL 
Follow this procedure to identify the virtual directory required to detect Reporting Services for SQL Server. 

To identify the Reporting Services Web Service URL: 
1. Click Start » All Programs » Microsoft SQL Server <version> » Configuration Tools » 

Reporting Services Configuration Manager. 
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If you have not configured SQL Reporting Services, click the Help icon in the lower left corner of 
the SSRS Configuration Manager dialog box to access Microsoft documentation for configuring 
SSRS. 

2. In the left pane, connect to the Report Server Web Service URL. 

3. In the right pane, select the Virtual Directory field. 

 
4. If setup is unable to connect to the Report Server Database Server or to identify the Reporting 

Services databases, it displays the SQL Reporting Database Server Setup Connection form. 
Enter the correct values into their corresponding fields. 

 Report Database Server: Use this field to enter the name of the Database server that has 
the Report Server database. 

 SQL Username: Use this field to enter a Microsoft SQL Database server login/username that 
is a member of the SQL Server SysAdmin Role. The default sysadmin account for SQL 
Server is sa. If you use the SQL Server Username and Password, ensure that the server 
security is configured to support Mixed Mode.  

 SQL Password: Use this field to enter the password associated with this SQL Login. 

 Windows Integrated: Select this option to authenticate your SQL Server using your 
Windows account if you are logged on to the server with the appropriate administrative rights. 
Your current Windows account must also be a member of the sysadmin role in the Microsoft 
SQL Server to perform the installation. If you are using integrated authentication, ensure that 
your current logged in account is a member of the sysadmin role in SQL Server. When SQL 

Note: Make sure the entry in the Virtual Directory field matches the virtual directory entry 
listed on the Specify Report Server and Report Server URL form. 
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Server is installed, it does not add members of the local administrator’s group to the SQL 
Server sysadmin role by default. 

 ReportServer Database: Use this field to enter the name of your Report Server database. 
Typically, the default name for this database is ReportServer. 

 ReportServerTempDB Database: Use this field to enter the name of your 
ReportServerTempDB database. Typically, the default name for this database is 
ReportServerTempDB. If you did not choose the default names or you are unable to recall 
the name of your Report Server database, follow the steps below to identify them. 

 

Identify the Report Server Databases 
Perform this procedure on your Report Server to identify the names of the ReportServer and Report 
ServerTempDB databases that are required for setup to detect Reporting Services for SQL Server. 

To identify the names of the ReportServer and ReportServerTempDB databases: 
1. Click Start » All Programs » Microsoft SQL Server <version> » Configuration Tools » 

Reporting Services Configuration Manager. 
2. On the Reporting Services Configuration Manager screen, click Database in the left pane. 

3. Click Change Database on the right pane. 

 
4. On the Change Database screen, select the Choose an existing report server database 

option, and click Next. 

Note: If the SQL login does not have db_owner membership of the Report Server and 
ReportServerTempDB databases, setup displays an error message and includes additional 
details in the installation log. Setup is then unable to continue until the SQL username 
account specified is given the appropriate rights. 
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5. If you are logged in as an Administrator, click Next to accept the default values to make a 

connection using Integrated Authentication.  

If you are not logged in as an Administrator, select SQL Server Account in the Authentication 
Type field, enter the System Administrator (SA) credentials in the Username and Password 
fields, and click Next. 

 
6. Use the Report Server Database field to view the names of the ReportServer and 

ReportServerTempDB databases. 

 
Note: Take note of the names of the ReportServer and ReportServerTempDB databases. 
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7. Click Cancel.  
8. Use the name of the ReportServer and ReportServerTempDB databases to populate the SQL 

Report Database Server Setup Connection screen that displays during the installation, if the 
Report Server databases cannot be identified. 

 

How to Give Your Account Proper Rights and Privileges in 
Reporting Services 
This section details the necessary Report Server rights and the credentials for both the Report server and 
SQL Server database. 

Required Rights for Report Server 
During the installation of the Report Server, two types of credentials are required for successful 
completion: 

 Windows Account: This account must have the appropriate rights and privileges for the Report 
Server Web Services component. It requires Content Manager and System Administrator 
privileges within the Reporting Services Report Manager Tool. This prevents the “401 
unauthorized access” error when testing the connection to the Reporting Services Web Service 
and when running reports. 

 Report Server SQL Server Database Login: This login must be a member of the db_owner role 
for the ReportServer and ReportServerTempDB databases. If you use a SQL Server database, it 
should also include your PMCompass database. 

Attention: For more information, see “Configure Microsoft SQL Server Reporting Services” in this 
guide. 
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To configure and verify proper rights and privileges to the Report Server Web Services 
component: 

1. Log on locally to the Report Server desktop console with a Domain Service Account that is a 
member of the local administrator group and launch Report Manager URL 
(https://localhost/reports):  

If you do not see the options below, launch MS Edge using the Run as administrator option in 
order to run it with elevated privileges. 

 
2. Click Manage Folder on the SQL Server Reporting Services screen.  

 
3. Click Add group or user. 

Note: Although the Local Windows Administrator Group on the Report Server will look like it is a 
member of the Content Manager and System Administrator roles in Reporting Services, you must still 
explicitly grant those rights to the account so that the installation can connect to Reporting Services 
and assign the proper privileges to the local DeltekPMCompass windows account that the installer 
creates. 

You must be on the server and browse to the Report Manager URL using localhost as the server 
name (https://localhost/reports) in order to see the Report Manager configuration options. 

https://localhost/reports
https://localhost/reports
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4. Add the Domain Service Account, which you will use to log in and perform the PM Compass 

installation, to the Content Manager role. During the installation, this account connects to the 
report server and installs the PM Compass reports into Reporting Services. These rights are also 
required by the account listed in Weblink to run the PM Compass reports. 

5. After the installation is complete, you can remove your Windows Domain Account if you prefer it 
not to have rights to the reports. The installation creates an account named DeltekPMCompass, 
which is assigned the same rights listed in these steps to load and run PM Compass reports on 
behalf of PM Compass users. 

 
6. Click OK. 
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The account will now appear in the listing with Content Manager rights. 

 
7. Click Site Settings. 

 
8. Click Security. 
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9. Click Add group or user, enter your Domain Service Account, and select the System 

Administrator role. Click OK. 
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The account now has the necessary privileges to prevent a 401 Unauthorized error during 
installation, as well as when testing and running reports. 

 

Prerequisite Report Server and SQL Server Database Credentials 
During the installation of PM Compass, when the installer tests for proper rights to the Report Server, a 
SQL Server account is required to connect to the Microsoft SQL Server Database hosting the Report 
Server databases used for managing the Report Server and PM Compass reports. This account must be 
configured on the Microsoft SQL Server hosting the Report Server. Most installations have the SQL 
Server Report Server database on the same machine as the Report Server Web Server component. 

To avoid errors during the Report Server installation, when testing Weblink entries, or when running 
reports, you must configure a Report Server SQL Server database login and grant it membership to the 
db_owner role on the SQL Server hosting the ReportServer and ReportServerTempDB databases. If you 
are using Microsoft SQL Server to host your PM Compass database, also grant this role for your 
PMCompass database. 
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To configure and verify proper rights and privileges to the Report Server Database Server 
component: 

1. Launch Microsoft SQL Server Management Studio. 

 
2. Expand the Security » Logins folder. 

 
3. Right-click on the Logins folder and select New Login. 

4. Create a new SQL Server login and set password for it. 

The example below creates an account named PMCompass. 

Note: This procedure should also be performed on your database if your database platform is 
Microsoft SQL Server. 
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5. Click User Mapping and select the ReportServer database option in the Users mapped to this 

login section. 

 
6. In the Database role membership for <Server> section, select the db_owner option to add the 

login to the db_owner role for the database. 
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7. Repeat these steps for the ReportServerTempDB database. 

 
8. For PM Compass databases hosted on Microsoft SQL Server ONLY: If you are using 

Microsoft SQL Server to host your PM Compass database, repeat these steps to map the login to 
the PM Compass database and grant it db_owner role membership. 
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9. Click OK. 
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Appendix D: Printing in PM Compass  
PM Compass provides the ability to: 

 Print directly on the users’ local printers. 

 Send a printout or batch to printers that are installed directly on the Web server. This is used 
primarily for batch-job printing using the Process server for transactions such as Batch Billing. 

Print to Local Printers on End-User Workstations 
Deltek PM Compass uses the Microsoft SQL Reporting Services WinForm Report Viewer control to 
render reports and allow users to preview a report. From the Preview dialog box, a print job is sent 
directly to a user's local printer without having to save to a PDF and other file types. 

Creating a Reverse Proxy 
The Microsoft SQL Reporting Services WinForm Report Viewer control requires a direct connection to the 
server running the SQL Reporting Services Web service over Port 80. This means that if your Report 
server, and possibly your Database server, are installed on the same machine, they are directly exposed 
to the Internet. It also requires an external FQDN so that the Report server can be resolved by the 
external users. 

A reverse proxy that uses Microsoft’s Application Request Routing (ARR) extension for IIS allows direct 
forwarding of requests through the PM Compass Web server to the Reporting Services Web Service with 
responses back to the Internet clients. This configuration resolves all of the issues identified above. 

For example, if PM Compass is hosted on the internet, your users will need access to the Report server 
to run reports. If you do not want to expose your report server, you can use your Web/Application server 
as a proxy for the Report server. 

 

To print to a local printer: 
1. In PM Compass, preview a report. 

2. Click the Printer icon in the Preview dialog box to display the printers that are installed on the 
local workstation. 

 
3. Select the local printer and click Print to send the printout to the local printer. 

Attention: Attention: For more information about creating a reverse proxy, see the Deltek PM 
Compass Advanced Administration Guide. 
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Print to Network Printers Installed on the Web Server 
PM Compass printers are installed on the Web server and not on the Report server.  

 

To print using a network printer installed on the PM Compass Web server: 
1. In PM Compass, select a report and click the Print icon on the toolbar. 

 
2. In the Printer Name field, select the network printer.  

If only <Local Printer> is listed, it means the system administrator has not yet installed printers 
on the server.  

Attention: For information on how to install printers on the Web Server, see “Install Network Printers 
on the Deltek PM Compass Web Server” in this guide. 
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3. Click Print to send the job to the printer. 

 

Install Network Printers on the Deltek PM Compass Web 
Server 
If you install PM Compass while logged in with a domain account, ensure that the printers are installed on 
the Web server using the same domain account. This allows end-users to print directly to domain printers 
from within PM Compass. 

 
If PM Compass was not installed using a domain account, direct printing from the server is not possible. 
To properly install printers on the PM Compass Web Server, ensure you meet the requirements listed in 
this section. 

 

To install network printers on the Deltek PM Compass Web server: 
1. Create or use an existing Windows Domain account (not a domain administrator).  

If local or domain password policies cause the password to expire, ensure that the password is 
updated in Weblink to avoid connection errors.  

2. Complete these steps on the Web server: 

Note: If you preview a report and then try to print, it will always use the local printers installed 
on your workstation and not the one installed on the PM Compass Web server. 

Attention: For more information, see “Domain Account vs. Default Local Account” under 
“Permissions Required for Installing PM Compass” in this guide. 

Attention: For more information on the detailed steps, see KB article #66245 on the Deltek Support 
Center site. 

https://deltek.custhelp.com/app/answers/detail/a_id/66245
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a. Log onto the Web server and add the account to the Local Administrator Group.  

This gives the account the privilege of installing the print drivers. 

b. Add the account to the local IIS_IUSRS group.  

This gives the account the necessary rights to run the Application Pool. 

c. Click Control Panel » Administrative Tools and launch the Local Security Policy 
applet.  

d. Expand Local Policies and click User Rights Assignment. 
e. Double-click Logon as a Service and add the account to the list.  

This allows PM Compass to enumerate the list of printers. 

f. Double-click Logon as a Batch Job and add the account to the list.  

This allows PM Compass to run the application pool as part of the "IIS_IUSRS" local 
group. 

g. Log onto the Web server using the account and install all the printers required. 

h. Click Control Panel » Administrative Tools and launch the Internet Information 
Services Manager.  
Expand the application pool and change the identity of the application pool from the local 
DeltekPMCompass account to this account. If the other rights are not assigned, the 
application pool will not start. 

i. Enter this account in the top section of the Report Server tab within the EPM Security 
Administrator (EPM SA) Weblink Utility. 

j. Log onto the server using this account and install the printers so that they are added to 
the local profile. 

Report Server Requirements 
The Windows domain account must be configured with the proper rights and privileges to Reporting 
Services on the Report server.  

 

Deltek EPM SA Weblink Requirements 
The account must be referenced in the top section on the Report Server tab in Weblink. 

Attention: For steps to configure the Report server, see “How to Give Your Account Proper Rights 
and Privileges in Reporting Services” under “Appendix C: Microsoft SQL Server Reporting Services” 
in this guide. 
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Launch Weblink 
Follow this procedure to launch Weblink. 

To launch Weblink: 
1. Click Start » All Programs » Deltek PM Compass » Deltek PM Compass WebLink to launch 

the WebLink utility on the Web/Application server. 

2. Select your database entry.  

The database entry you selected here should also be mapped to the logon account as specified 
in the Weblink section in the procedure above. 

3. On the Report Server tab, enter the domain account you created and configured on the Web 
server in the Report Server Web Service Access section. 

4. In the Report Server Database Access section of the Report Server tab, enter the SQL Server 
logon account you created and configured on the Database server. 

This account must have the proper rights to the PM Compass database and the Report Server 
database.  

5. Launch PM Compass and the refresh report printers. 

Refresh the Report Printers 
Follow this procedure to refresh the report printers. 

To refresh the report printers: 
1. Launch PM Compass and log onto the database you configured in Weblink. 

2. Select Administration » Report Administration. 

3. On the Report Printers tab, click Refresh to update PM Compass with the printers installed. 
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Appendix E: Load Standard PM Compass Reports 
During the Web Server/Tier installation, PM Compass installs a standard set of reports.  

PM Compass uses the following internal steps to complete this process: 

1. PM Compass installs the PM Compass report folders and files into the PM Compass Reports 
folder: \\Program Files\Deltek\PMCompass\Reports\.  

2. PM Compass imports the PM Compass Report files into Microsoft SQL Server Reporting 
Services (SSRS) to make the reports available in Reporting Services. 

Installation Errors  
If there are issues with the connection between PM Compass and the Report server, the reports will not 
be installed correctly on the Report server. 

Installation Type Problem Possible Cause Solution 

Upgrade existing PM 
Compass installation 

The connection 
between the Report 
server database and 
Reporting Services 
URL fails. 

The account specified 
in Weblink does not 
have the appropriate 
rights to the Report 
server, Web server, 
Report server 
databases, and PM 
Compass database. 

Grant the Weblink 
account the necessary 
rights to the Report 
server or use a Weblink 
account that has the 
necessary rights to the 
Report server. 

All installations The connection 
between the Report 
server database and 
Reporting Services 
URL fails 

The Report server did 
not respond in a timely 
manner and the 
connection timed out. 

Launch PM Compass 
and reload the reports. 

 

Reload Reports  
If PM Compass displays an error message stating that PM Compass reports were not successfully 
imported during the installation process, you must reload the reports manually from the Utilities folder in 
PM Compass.  

To reload reports: 
1. Launch PM Compass and log onto the database you configured in Weblink. 

2. Select Administration » Report Administration. 

3. On the Load Reports tab, click Load Report Files to update the Reporting Services Web Service 
with the report definitions from the Web server. 

A warning displays: "Loading reports onto <Server> will prevent ALL users from running reports 
on this server for a few minutes. Are you sure you want to do this?” 

Attention: For 
steps to resolve this 
issue, see “Reload 
Reports” and 
“Refresh Printers”. 



Appendix E: Load Standard PM Compass Reports 

Installation Guide 204 

 

4. Click Yes. 

Refresh Printers 
Follow this procedure to refresh printers. 

To refresh printers: 
1. Launch PM Compass and log on to the database you configured in Weblink. 

2. Select Administration » Report Administration. 

3. On the Report Printers tab, click Refresh to update the PM Compass database with the list of 
printers that are on the Web server. 
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Appendix F: Using Oracle with PM Compass 
This chapter covers topics about using Oracle with PM Compass. 

 

Database Platform Options for Oracle Databases 
PM Compass supports Oracle and Microsoft SQL Server database platforms. The procedure in this 
chapter is for Administrators performing the PM Compass installation on an Oracle database. 

 

Run Scripts Manually on an Oracle Database 
PM Compass installs Microsoft command prompt/batch (.bat) files that you can use to apply the database 
script (.sql) files against your database.  

To apply the batch files to your database, you need to supply your connection information as parameters. 

This chapter includes separate sections for: 

 Applying scripts to your database for the first time (new to PM Compass). 

 Upgrading your database from the previous PM Compass version. 

Make sure that you choose the section that is appropriate to your situation. 

Oracle Batch Parameter Order 
There are parameters that can be passed to the batch files; however, they need to be run in the following 
order: 

1. Server/Instance Name 

2. User ID 

3. Password 

For example, if your Server/Instance name is ServerA, your User ID is UserIDA, and your Password is 
PasswordA, then when you launch the batch file from a command prompt, it will be in this format: 
“<name of batch file> ServerA UserIDA PasswordA” (with a space separating each parameter). 

Note: Deltek provides several deployment models. For all models, Deltek assumes that your Oracle 
database server is a separate machine. No installations are performed on this machine. All 
connections to your Database server are made from the Web/Application or Report server machines. 

Note: The PM Compass installer includes a utility called the PM Compass Database Upgrade Wizard 
Utility. It allows you to upgrade multiple databases (one at a time) if you have more than one copy of 
your database (for training and testing purposes). For more information, see “Appendix J: PM 
Compass Database Upgrade Wizard Utility” in this guide. 
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Apply PM Compass Scripts to Your Database for the First Time 
During the installation, if you selected to run the scripts manually, depending on the type of database you 
are upgrading for PM Compass (a new/blank database, or an existing Cobra or Open Plan database), 
you must perform the applicable steps in the sequence presented in the following table. 

Step Database Schema 
Requirements 

Step to Perform Description 

1 Cobra Schema  

(Only required if your 
database is NOT a Cobra 
database, that is, the 
database does not contain 
any Cobra tables.) 

 

1. Navigate to the following folder: 
<PMCompass 
InstallDir>\Databases\Scripts\Cob
ra\Oracle\Create\. 

2. Run the 
RunAllCreateScripts_Oracle.bat 
passing parameters for Oracle. 

Creates the Cobra 
tables/data using 
the 
RunAllCreateScript
s.bat 

2 OpenPlan Schema 

(Only required if your 
database is NOT an Open 
Plan database, that is, the 
database does not contain 
any Open Plan tables.) 

 

1. Navigate to the following folder: 
<PMCompass 
InstallDir>\Databases\Scripts\Ora
cle\ 

2. Run the 
RunOpenPlanScripts_Oracle.bat 
passing parameters for Oracle. 

Creates the 
OpenPlan 
tables/data using 
the 
RunOpenPlanScrip
ts.bat 

3 Framework Schema Framework – Run the <PMCompass 
InstallDir>\Databases\Scripts\Oracle\Run
FWScripts_Oracle.bat passing 
parameters for Oracle. 

Creates the 
FrameWork 
tables/data using 
the 
RunFWScripts.bat 

Warning: Do not run 
this script if you have 
an existing Cobra 
database. 

Warning: Do not run 
this script if you have 
an existing Open Plan 
database. 

Note: If you chose to run the database scripts using the installation created batch file or the product-
specific batch files, there is an additional batch file named Check_Errors.bat, located in each script 
sub-folder (Cobra, SQL and Oracle), which you should also run after running the appropriate 
database script batch files. 

This batch file checks the log files created by each database script process and writes any errors 
identified in those logs to an Errors.txt file in each script sub-folder. This text file will include the log 
file in which the error was found, the line number of the error, and the error text. 
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Step Database Schema 
Requirements 

Step to Perform Description 

4 EPM SA Schema EPM – Run the <PMCompass 
InstallDir>\Databases\Scripts\Oracle\Run
EPMScripts_Oracle.bat passing 
parameters for Oracle. 

Creates the EPM 
tables/data using 
the 
RunEPMScripts.bat 

5 PM Compass Schema PM Compass – Run the <PMCompass 
InstallDir>\Databases\Scripts\Oracle\Run
PMCompassScripts_Oracle.bat passing 
parameters for Oracle. 

Creates the 
PMCompass 
Tables/data using 
the 
RunPMCompassSc
ripts.bat 

6 Microsoft Project 
Integration 

 

Run the <PMCompass 
InstallDir>\Databases\Scripts\Oracle\Run
PMCompassMSPInit_Oracle.bat passing 
parameters for Oracle. 

Initializes the tables 
for Microsoft 
Project integration. 

 

7 Primavera P6 Integration 

 

Run <PMCompass 
InstallDir>\Databases\Scripts\Oracle\Run
PMCompassP6Init_Oracle.bat passing 
parameters for Oracle. 

Initializes the tables 
for Primavera P6 
integration. 

8 MSP Integration Add the MSP integration folder UNC path For steps, see “Add 
or Edit the MSP 
Integration Folder 
UNC Paths” under 
“Appendix N: 
Integrating with 
Microsoft Project” 
in this guide. 

Upgrade Your Database from a Previous PM Compass Version 
During the installation, if you selected to run the scripts manually, you must perform the step outlined in 
the table below. 

Step Database Schema 
Requirements 

Step to Perform Description 

1 PM Compass database 
upgrade  

 

Run the 
RunPMCompassUpgrade80to85_Oracl
e.bat passing parameters for Oracle. 

Upgrades your 
current PM 

Warning: Skip this 
step if you are using 
Open Plan as a 
scheduling tool. 

Warning: Only run if 
you are using 
Primavera P6. 
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Step Database Schema 
Requirements 

Step to Perform Description 

Compass 8.x + 
database. 

2 Microsoft Project 
Integration 

 

Run the <PMCompass 
InstallDir>\Databases\Scripts\Oracle\Run
PMCompassMSPInit_Oracle.bat passing 
parameters for Oracle. 

Initializes the tables 
for Microsoft 
Project integration 

3 Primavera P6 Integration 

 

Run <PMCompass 
InstallDir>\Databases\Scripts\Oracle\Run
PMCompassP6Init_Oracle.bat passing 
parameters for Oracle. 

Initializes the tables 
for Primavera P6 
integration. 

Registering Oracle Policy Files to the Global Assembly Cache 
(GAC) 
Running the Web/Application/Report/Process servers on a 64-bit machine with a 64-bit installation of SQL 
Reporting Services and an Oracle database server requires the installation of both the 32-bit and 64-bit 
Oracle clients on the Web/Application/Report/Process server. 

Installing the 64-bit Oracle client after the 32-bit version removes the 32-bit Oracle Policy files from the 
GAC. You need to add these files to the GAC after installing the 64-bit Oracle client. 

 

Register your Oracle Client 
You may encounter one or more of the errors described in the table. 

Error Description 

“Invalid Identifier” error encountered when using 
Oracle client 

The Oracle client installation failed to add the 
Oracle.DataAccess assemblies (dll and Policy 
files) to the Global Assembly Cache (GAC). 

Unable to find the requested .NET Framework 
Data Provider. It may not be installed. 

The Oracle client installation failed to add the 
Oracle.DataAccess assemblies (dll and Policy 
files) to the Global Assembly Cache (GAC). 

Warning: Skip this 
step if you are using 
Open Plan as a 
scheduling tool.. 

Warning: Only run if 
you are using 
Primavera P6. 

Note: In cases where the installer cannot proceed because the GACUTIL file does not yet exist, refer 
to the Deltek Support Center KB article # 79615. 
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Error Description 

An error occurred during report processing. This error is specific to the Report tier and the 64-
bit version of the Oracle client. The Oracle client 
installation failed to add the Oracle.DataAccess 
assemblies (dll and Policy files) to the 
machine.config on the Report server. 

Unable to load dll ‘OraOpsxx.dll’ (where xx is the 
Oracle client version): This specified module 
cannot be 
found.(Oracle.DataAccess.Client.OpsInit) 

You encounter this error when launching WebLink 
or EPMSA Admin. 

The Oracle client installation failed to add the 
Oracle.DataAccess assemblies (dll and Policy 
files) to the Global Assembly Cache (GAC). 

The Oracle client installation failed to add the 
Oracle.DataAccess assemblies (dll and Policy 
files) to the machine.config. 

Unable to load dll ‘OraOpsxx.dll’ (where xx is the 
Oracle client version): This specified module 
cannot be found 
(Oracle.DataAccess.Client.OpsInit) 

Follow the 32-bit or 64-bit steps below to resolve the issue. Anytime you install or add an Oracle client, 
you must run these steps to register both new and existing clients. 

 

32-Bit Oracle Client (Unmanaged) 

You must perform this procedure on your Web/Application and Process server machines. 

1. Click Start » All Programs » Accessories.  

2. Right-click the Command Prompt and select Run as administrator.  
3. On the Administrator Command Prompt window, enter the following lines: 

Register the ODP.NET 4 Unmanaged assembly into the GAC  
"<Oracle_client_home_path>\ODP.NET\bin\4\OraProvCfg.exe" /action:gac 
/providerpath:"<Oracle_client_home_path>\odp.net\bin\4\Oracle.DataAccess.dll" 

Register the ODP.NET 4 Unmanaged Publisher Policy assembly into the GAC  
"<Oracle_client_home_path>\ODP.NET\bin\4\OraProvCfg.exe" /action:gac 
/providerpath:"<Oracle_client_home_path>\odp.net\PublisherPolicy\4\Policy.4.112
.Oracle.DataAccess.dll" 

"<Oracle_client_home_path>\ODP.NET\bin\4\OraProvCfg.exe" /action:gac 
/providerpath:"<Oracle_client_home_path>\odp.net\PublisherPolicy\4\Policy.4.121
.Oracle.DataAccess.dll" 

Note: You must register the Oracle .NET Assemblies every time you install, add, or modify an Oracle 
client or after applying an Oracle client patch. You must run these steps to register both new and 
existing clients. 

Example 1: If you already have the 32-bit client installed and you add the 64-bit client, after the 
installation, you must register both the 32-bit and 64-bit clients. 

Example 2: You have an Oracle 64-bit client installed and are using PM Compass. You install a new 
Oracle client 32-bit version. If you are going to use the old and new Oracle client versions, after you 
install the new version, you must register both versions. If you are only going to use the new Oracle 
version, after the installation, you must register the new version. 
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"<Oracle_client_home_path>\ODP.NET\bin\4\OraProvCfg.exe" /action:gac 
/providerpath:"<Oracle_client_home_path>\odp.net\PublisherPolicy\4\Policy.4.122
.Oracle.DataAccess.dll" 

 
Configure the Machine.config for .NET 4 Framework with proper section Handler 
"<Oracle_client_home_path>\ODP.NET\bin\4\OraProvCfg.exe" /action:config 
/product:odp /frameworkversion:v4.0.30319 
/providerpath:"<Oracle_client_home_path>\odp.net\bin\4\Oracle.DataAccess.dll" 

4. Close the Administrator Command Prompt window.  

64-Bit Oracle Client (Unmanaged) 

You must perform this procedure on any machine that has the Report tier installed. 

1. Click Start » All Programs » Accessories.  

2. Right-click the Command Prompt and select Run as administrator.  
3. On the Administrator Command Prompt window, enter the following lines: 

 
Register the ODP.NET 4 Unmanaged assembly into the GAC  
"<Oracle_64bit_client_home_path>\ODP.NET\bin\4\OraProvCfg.exe" /action:gac 
/providerpath:"<Oracle_64bit_client_home_path>\odp.net\bin\4\Oracle.DataAccess.
dll" 

Register the ODP.NET 4 Unmanaged Publisher Policy assemblies into the GAC  
"<Oracle_64bit_client_home_path>\ODP.NET\bin\4\OraProvCfg.exe" /action:gac 
/providerpath:"<Oracle_64bit_client_home_path>\odp.net\PublisherPolicy\4\Policy
.4.112.Oracle.DataAccess.dll" 

"<Oracle_64bit_client_home_path>\ODP.NET\bin\4\OraProvCfg.exe" /action:gac 
/providerpath:"<Oracle_64bit_client_home_path>\odp.net\PublisherPolicy\4\Policy
.4.121.Oracle.DataAccess.dll" 

 "<Oracle_64bit_client_home_path>\ODP.NET\bin\4\OraProvCfg.exe" /action:gac 
/providerpath:"<Oracle_64bit_client_home_path>\odp.net\PublisherPolicy\4\Policy
.4.122.Oracle.DataAccess.dll" 

Configure the Machine.config for .NET 4 Framework with proper section Handler 
"<Oracle_64bit_client_home_path>\ODP.NET\bin\4\OraProvCfg.exe" /action:config 
/product:odp /frameworkversion:v4.0.30319 
/providerpath:"<Oracle_64bit_client_home_path>\odp.net\bin\4\Oracle.DataAccess.
dll"  

Register ODP.NET Managed Client to GAC 

 
“<Oracle_64bit_client_home_path>\odp.net\bin\4\OraProvCfg.exe /action:gac 
/providerpath:”<Oracle_64bit_client_home_path>\odp.net\managed\common\Oracle.Ma
nagedDataAccess.dll” 

Note: Oracle client home path refers to the location where the Oracle client binaries are 
stored. For example, C:\app\oracle\product\12.2.0\client_1. 

Note: Run this command if you are running PM Compass on any tier that includes the Report 
server, but you did not run the PM Compass installer on any of the tier. 
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Add ODP.NET Managed Client entries to machine.config 

 
“<Oracle_64bit_client_home_path>\odp.net\bin\4\OraProvCfg.exe /action:config 
/force /product:odpm /frameworkversion:v4.0.30319 
/providerpath:”<Oracle_64bit_client_home_path>\odp.net\managed\common\Oracle.Ma
nagedDataAccess.dll” 

4. Close the Administrator Command Prompt window. 

Note: Run this command if you are running PM Compass on any tier that includes the Report 
server, but you did not run the PM Compass installer on any of the tier. 
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Appendix G: Using Microsoft SQL Server with 
PM Compass 
This chapter covers topics about using Microsoft SQL Server with PM Compass. 

Database Platform Options for Microsoft SQL Server 
Databases 
PM Compass supports Oracle and Microsoft SQL Server database platforms. The procedure in this 
section is for Administrators performing the PM Compass installation on a Microsoft SQL Server 
database. 

 

Run Scripts Manually on SQL Databases 
PM Compass installs Microsoft command prompt / batch (.bat) files that you can use to apply the 
database script (.sql) files against your database. To apply the batch files to your database, you need to 
supply your connection information as parameters. 

This topic includes separate sections for: 

 Applying scripts to your database for the first time (new to PM Compass). 

 Upgrading your database from the previous PM Compass version. 

Make sure you choose the section that is appropriate to your situation. 

Microsoft SQL Batch Parameter Order 
There are parameters that can be passed to the batch files; however, they must be run in the following 
order: 

1. Database Name 

2. Server/Instance Name 

 
3. User ID  

4. Password 

Note: If you are unable to connect to your SQL Server or have not yet performed the requirements, 
see the Database Requirements section in this guide. 

The PM Compass installer includes a utility called the PM Compass Database Upgrade Wizard Utility. 
It allows you to upgrade multiple databases (one at a time) if you have more than one copy of your 
database (for training and testing purposes). For more information, see “Appendix J: PM Compass 
Database Upgrade Wizard Utility” in this guide. 

Note: If you are specifying the port number when making the connection to the SQL Server, you must 
enclose the parameter in double quotation marks: 

“<ServerA>,<port number>”.  
For example, “ServerA,1234”. 
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For example, if your Database Name is DatabaseA, your Server/Instance name is ServerA, your User 
ID is UserIDA, and your Password is PasswordA, then when you launch the batch file from a command 
prompt, it will be in this format: “<name of batch file> DatabaseA ServerA UserIDA PasswordA” (with 
a space separating each parameter). 

 

Apply PM Compass Scripts to Your Database for the First Time 
If you selected to manually run the scripts, depending on the type of database you are upgrading for PM 
Compass (that is, a new/blank database, an existing Cobra or Open Plan database) you must perform the 
applicable steps in the sequence presented in the following table. 

Step Database Schema 
Requirements 

Step to Perform Description 

1 Cobra Schema  

(Only required if your 
database is NOT a Cobra 
database, that is, the 
database does not contain 
any Cobra tables.) 

 

1. Navigate to the following folder: 
<PMCompass 
InstallDir>\Databases\Scripts\C
obra\SQLServer\Create\. 

2. Run the 
RunAllCreateScripts_SQL.bat 
passing parameters for SQL. 

Creates the Cobra 
tables/data using the 
RunAllCreateScripts
.bat. 

2 OpenPlan Schema 

(Only required if your 
database is NOT an Open 
Plan database, that is, the 
database does not contain 
any Open Plan tables.) 

1. Navigate to the following folder: 
<PMCompass 
InstallDir>\Databases\Scripts\S
QL\. 

2. Run the 
RunOpenPlanScripts_SQL.bat 
passing parameters for SQL. 

Creates the 
OpenPlan 
tables/data using the 
RunOpenPlanScript
s.bat 

Warning: Do not run 
this script if you have 
an existing Cobra 
database. 

Note: The user ID and password are optional. If you do not specify a user ID and password, it means 
that you are using Windows Authentication and the account with which you logged in must be a 
member of the db_owner role in the database in Microsoft SQL Server. 

Note: If you chose to run the database scripts via the installation created batch file or via the product 
specific batch files, there is an additional batch file named Check_Errors.bat located in each scripts 
sub-folder (Cobra, SQL and Oracle) which is run after the appropriate database script batch files have 
run. 

This batch file will check the log files created by each database script process and write any errors 
identified in those logs to an Errors.txt file in each scripts sub-folder. This text file will include the log 
file the error was found in, the line number of the error, and the error text. 
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Step Database Schema 
Requirements 

Step to Perform Description 

 

3 Framework Schema Framework – Run the <PMCompass 
InstallDir>\Databases\Scripts\SQL\Run
FWScripts_SQL.bat passing 
parameters for SQL. 

Creates the 
FrameWork 
tables/data using the 
RunFWScripts.bat 

4 EPM SA Schema EPM – Run the <PMCompass 
InstallDir>\Databases\Scripts\SQL\Run
EPMScripts_SQL.bat passing 
parameters for SQL. 

Creates the EPM 
tables/data using the 
RunEPMScripts.bat 

5 PM Compass Schema PM Compass – Run the <PMCompass 
InstallDir>\Databases\Scripts\SQL\Run
PMCompassScripts_SQL.bat passing 
parameters for SQL. 

Creates the 
PMCompass 
Tables/data using 
the 
RunPMCompassScr
ipts.bat 

6 Microsoft Project Integration 

 

Run <PMCompass 
InstallDir>\Databases\Scripts\SQL\Run
PMCompassMSPInit_Sql.bat passing 
parameters for SQL. 

Initializes the tables 
for Microsoft Project 
integration. 

 

7 Primavera P6 Integration 

 

Run <PMCompass 
InstallDir>\Databases\Scripts\Oracle\Ru
nPMCompassP6Init_Sql.bat passing 
parameters for SQL. 

Initializes the tables 
for Primavera P6 
integration. 

8 MSP Integration Add the MSP integration folder UNC 
path 

For steps, see “Add 
or Edit the MSP 
Integration Folder 
UNC Paths” under 
“Appendix N: 
Integrating with 
Microsoft Project” in 
this guide. 

Warning: Do not run 
this script if you have 
an existing Open Plan 
database. 

Warning: Skip this 
step if you are using 
Open Plan as a 
scheduling tool. 

Warning: Only run if 
you are using 
Primavera P6. 
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Upgrade Your Database from a Previous PM Compass Version 
During the installation, if you select to run the scripts manually, you must perform the step outlined in the 
table below. 

Step Database Schema 
Requirements 

Step to Perform Description 

1 PM Compass database 
upgrade  

 

Run the 
RunPMCompassUpgrade80to85_Sql.b
at passing parameters for SQL. 

Upgrades your 
current PM 
Compass 8.x + 
database. 

2 Microsoft Project 
Integration 

 

Run <PMCompass 
InstallDir>\Databases\Scripts\SQL\RunP
MCompassMSPInit_Sql.bat passing 
parameters for SQL. 

Initializes the tables 
for Microsoft 
Project integration 

3 Primavera P6 Integration 

 

Run <PMCompass 
InstallDir>\Databases\Scripts\Oracle\Run
PMCompassP6Init_Sql.bat passing 
parameters for SQL. 

Initializes the tables 
for Primavera P6 
integration. 

 

Warning: Skip this 
step if you are using 
Open Plan as a 
scheduling tool.. 

Warning: Only run if 
you are using 
Primavera P6. 
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Appendix H: Unicode and Case-Insensitive 
Prerequisites for Cobra and Open Plan Databases 
A new PM Compass database is Unicode only and uses case-insensitive indexes. If you are installing PM 
Compass into an existing Cobra and Open Plan database, confirm the database is configured correctly.  

The sections below detail any specific checks and possible changes that must be performed to ensure 
your existing Cobra and Open Plan databases are compatible for integration with PM Compass. 

During the early stages of the PM Compass installation, the setup program connects to your database 
and queries it to determine if it has Unicode support and CI indexes. If it detects that the database does 
not meet the criteria, the installer displays the reason(s) why, and saves a PMC85_Unicode_CI.zip file in 
the same location as the DeltekPMCompass<version>.exe file before exiting. The zip file contains 
several database script files that you need to update your database to satisfy the requirements and 
restart the installation.  

Before you make any changes to your database, review the sections below to ensure that there are no 
issues with your particular environment. 

Choosing the Oracle Character Set 
The PM Compass platform supports the non-Unicode character set WE8MSWIN1252. When you 
configure your Oracle database using the Oracle tools, make sure that you choose the WE8MSWIN1252 
character set when you create your initial PM Compass database. 

 

Case-Insensitive (CI) Indexes 
As there may be a small performance impact, Deltek recommends that existing Open Plan customers 
undertake general performance tests for their Open Plan deployment after migrating to use Unicode data 
and function-based indexes. In addition, if you have custom applications that directly access the Open 
Plan database, you may need to modify them to ensure that any queries take advantage of the CI 
indexes. 

Open Plan Database Prerequisite Steps 
Complete the steps below in the order listed. 

 

Step 1: Extract the Unicode and Case-Insensitive Prerequisites for Cobra 
and Open Plan Databases 
These script files will be used in step 2 (Determine if Unicode is Supported) and step 3 (Determine 
Whether Case-Insensitive Indexes Exist in the Open Plan Database) below, depending on which 
database prerequisites are needed. 

Note: PM Compass does not currently support the Unicode Translation Format (UTF) character sets. 

Tip: Before performing the steps below, Deltek strongly recommends that you backup up your Open 
Plan database. 
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The File to Run column in the tables below tells you which script file to run and when. Only run the 
scripts applicable to your database platform (Oracle or SQL). 

To run the script files: 
1. Navigate to the same location as the DeltekPMCompass<version>.exe file. 

2. Locate PMC85_Unicode_CI.zip (which includes several files) and extract them. 

If you are prompted to replace files, select Yes to All. 
3. Run the appropriate script files listed in the File to Run column in the Step 2 table below to 

enable Unicode support and/or create CI indexes for your database. 

Step 2: Determine if Unicode is Supported 
If you were informed during setup that your database does not support Unicode, run the file listed in the 
Results and Next Steps column that corresponds to your version of Cobra. 

If you prefer to query your database manually to determine if it supports Unicode character sets before 
you begin the installation, you can run the SQL statement in the Manually Query Your Database column 
below. If the value returned from the statement returns Non-Unicode, you must run the file that matches 
the version of Cobra you are using below against your database. 

Database Platform Manually Query Your 
Database 

File to Run 

Microsoft SQL 
Server Database 

select case when data_type = 
'NVARCHAR' THEN 'Unicode' 
else 'Non-Unicode' end  

from 
information_schema.columns 
where table_name = 
'OPP_ACT' and column_name 
= 'ACT_ID'; 

Cobra 8.0 or later - 
PMC_UnicodeConversion_SqlServer.sql 

Oracle Database select case when data_type = 
'NVARCHAR2' then 'Unicode' 
else 'Non-Unicode' end 

from user_tab_columns where 
table_name = 'OPP_ACT' and 
column_name = 'ACT_ID'; 

PMC_UnicodeConversion_Oracle.sql 

Step 3: Determine Whether Case-Insensitive Indexes Exist in the Open 
Plan Database 
Case-Insensitive (CI) indexes are required in Open Plan databases to be compatible with PM Compass. 
Open Plan databases stored in SQL Server typically have case-insensitive indexes since that setting is 
configured during the installation of Microsoft SQL Server, and the default setting is for case-insensitive. 
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Database Platform Manually Query Your 
Database 

File to Run 

Microsoft SQL 
Server Database 

Not required. Case sensitivity 
is configured during installation 
of Microsoft SQL Server. The 
default setting is case-
insensitive. 

N/A 

Oracle Database select case when count(*) > 0 
then 'OPP CI Enabled' else 
'OPP CI Not Enabled' end 

from USER_OBJECTS where 
OBJECT_NAME like 
'PK_CI_OPP%'; 

 

If the installer indicated that you must apply 
the Case-Insensitive indexes or if the value 
returned from the query in the Manually 
Query Your Database column returns “OPP 
CI Not Enabled” then you must run the 
Opp_Oracle_CI_Indexes.sql script file 
against your database. 

Update EPM Security Administrator Security Tables 
Complete this step to update the PM Compass EPM Security Administrator (WST tables) to Unicode. 

 
If you were informed during setup that your database does not support Unicode in the EPM Security 
Administrator (WST tables), run the file listed in the File to Run column that matches the version of Cobra 
you are using. 

If you prefer to query your database manually to determine if the EPM Security Administrator tables 
support Unicode character sets before you begin the installation, you can run the SQL statement in the 
Manually Query Your Database column below. If the value returned from the statement returns Non-
Unicode, you must run the file that matches the version of Cobra you are using below against your 
database. 

 

Database Platform Manually Query Your 
Database 

File to Run 

Microsoft SQL 
Server Database 

select case when data_type = 
'NVARCHAR' THEN 'Unicode' 
else 'Non-Unicode' end  

from 
information_schema.columns  

where table_name = 
‘WST_USR’ and column_name 
= 'USR_ID’; 

PMC_UnicodeConversion_SqlServer.sql 

Recommendation: Deltek strongly recommends that you back up your database before 
completing this procedure. 

Note: The files below are included in PMC85_Unicode_CI.zip. 
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Database Platform Manually Query Your 
Database 

File to Run 

Oracle Database select case when data_type = 
'NVARCHAR2' then 'Unicode' 
else 'Non-Unicode' end 

from user_tab_columns  

where table_name = 
‘WST_USR’ and column_name 
= 'USR_ID’; 

PMC_UnicodeConversion_Oracle.sql 
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Appendix I: How to Run the Deltek PM Compass 
Sample Database Restore Wizard 
PM Compass ships with a sample/demo SQL Server database. Deltek recommends that you install a 
sample database to aid in the evaluation and testing process.  

Download the Deltek PM Compass 8.5 Sample Databases.zip from DSM and extract the sample 
databases on your server depending on which database you are using. 

 
 SQL Server: If your are using Microsoft SQL Server, extract the .bak files to your SQL Server 

Database Server and restore them using SQL Server Management Studio or the Database 
Restore Wizard. You will need a SQL login with administrator rights. 

 Oracle: If you are using Oracle, extract the .bak files to the machine hosting your Microsoft SQL 
Server Report Server Database and restore using SQL Server Management Studio or the 
Database Restore Wizard. You will need a SQL login with administrator rights. 

Although you are running the Database Restore Wizard on the Web server, the utility performs the 
following: 

 Installs the correct version of the SQL Server Native Client driver on the Web/Application and 
Process server. 

 Connects to your SQL Server Database (or Report Server if Oracle) 

 Checks for the default installation of PM Compass on the server to find the Sample Database 
backup file on that machine, if you extracted the sample backup files into the PM Compass 
directory on the server. 

If it is unable to find the sample database backup file, it will prompt you for the location of the file (on your 
Database or Report server) and use that information to restore the sample database. 

In order for the backup file to be available, you need to perform the PM Compass installation on your SQL 
Server Database server, or on your Report Server (if using an Oracle database), prior to completing these 
steps. 

 
If you manually restore the database, you must install the SQL Server Native Client Driver on the 
Web/Application server and the Process server. 

To restore the sample database: 
1. Log onto your Web server. 

2. Navigate to the PM Compass installation directory, drill down to the Support\Utilities folder, and 
launch the DeltekPMCompass<version>_RestoreWizard.exe file. 

Setup installs SQLDMO prerequisites in order to connect to the Microsoft SQL Server to restore 
the database. 

3. On the Deltek PM Compass Sample Database Restore Wizard Welcome screen, click Next. 

Attention: For more information, see Using the Sample Databases in this guide. 

Note: The SQL Server Native Client driver needs to be installed on all of the Web/Application and 
Process servers used by PM Compass. The correct version of this driver is located in the Utilities 
folder. 
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If the SQL login entered previously is not a member of the System Administrator role, the 
restoration will not proceed, and an error message is displayed. Click OK. 

1. On the Database Server (MSSQL) Setup Connection Information screen specify the SQL Server 
connection information for the database server where the restore will take place.  

The account specified here must be a member of the SYSADMIN role in Server Roles on the 
SQL Server in order to restore the database.  

2. Click Next. 
If the wizard is unable to find the sample database backup file, it will prompt you for the location 
of the file (on your Database or Report server) and use that information to restore the sample 
database. 

3. Verify or enter the path on your Database or Report server and click Next. 
4. On the Ready to Install screen, click Install. 
5. On the Deltek PM Compass Sample Database Restore Wizard Complete screen, click Finish. 

 

Attention: For steps on how to configure the sample database for use, see “Using the 
Sample Database” in this guide. 
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Appendix J: PM Compass Database Upgrade 
Wizard Utility 
In some cases, an Administrator may want to perform upgrade testing of sample and test databases 
when upgrading an existing PM Compass installation. During installation of PM Compass (new 
installation and upgrades) setup only allows you to upgrade one database during installation. The PM 
Compass Database Upgrade Wizard Utility was created to allow you to select more than one database to 
upgrade.  

To upgrade multiple databases, you must perform the steps below for each database individually. At the 
end of the steps, depending on the option you select, a log of the steps (and conversion if automatic) will 
be saved.  

To review the log, navigate to the PM Compass installation directory and drill down to the 
Logs\ScriptLogs folder. You can identify the logs for the database that was converted by the Date/Time 
stamp of the folder. 

 

To upgrade multiple databases: 
1. Log onto your Web server. 

2. Navigate to the PM Compass installation directory, drill down to the Support\Utilities folder, and 
launch the DeltekPMCompass<version>_DatabaseUpgrade.exe file. 

3. On the Deltek PM Compass Sample Database Restore Wizard welcome screen, click Next.  
4. On the Database Platform screen, select your database platform and click Next. 
5. The next screen depends on whether you selected Oracle or Microsoft SQL Server. See the 

section below that relates to your selected database. 

Oracle Database 
The setup checks for supported versions of the Oracle Client driver. If it finds a supported 
version, setup continues. If not, the wizard displays a message informing you that no supported 
Oracle driver has been found, and the setup exits when you click OK. To resolve this, install the 
supported Oracle client driver version and run the wizard again. 

 
On the Oracle Connection Information screen, enter the necessary information in the appropriate 
fields, and click Next. 

Note: The PM Compass database is Unicode only and uses case-insensitive indexes. When 
upgrading an existing Open Plan or Cobra database to PM Compass, it must also be Unicode 
enabled and using case-insensitive indexes. 

For more information, see “Appendix H: Unicode and Case-Insensitive Prerequisites for Cobra and 
Open Plan Databases” in this guide. 

Attention: For more information, see “Storing PM Compass Data in an Oracle Database” in 
this guide. 
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 Service name/SID: Enter the unique name of your Oracle database instance as defined in 

your tnsnames.ora file. 

 Username: Enter the Oracle user schema with rights to modify the tables in the Oracle 
database.  

 Password: Enter the password associated with the Oracle Username. 

The following validations are performed: 

 SID is found in tnsnames.ora. 

 Username/password are correct. 

 The versions of Cobra and Open Plan (if installed) are supported. 

 The database has Unicode and case incentive indexes enabled. 

If any of these validations fail, the wizard displays a message, and the setup exits. 

 
Microsoft SQL Server Database 
On the Database Server (MSSQL) Setup Connection Information screen, enter the necessary 
information in the appropriate fields, and click Next. 

Attention: For steps to resolve Cobra and Open Plan database prerequisite requirements, 
see “Appendix H: Unicode and Case-Insensitive Prerequisites for Cobra and Open Plan 
Databases” in this guide. 
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 Database Server: Enter the name of the Database server and the database instance. 

 Select Windows Integrated or enter the SQL Login and SQL Password. 

 SQL Login: Enter a Microsoft SQL Database Server Login that is mapped to the 
db_owner role in the database. If you use the SQL Login and SQL Password fields, 
make sure that server security is configured to support Mixed Mode Security. 

 
 SQL Password: Enter the password associated with this SQL login. 

 Database Name: If you have an existing Cobra database, enter your Cobra database name. 
If this is a new installation, enter the name of the new database you created to store your 
data.  

The following validations are performed: 

 Username/password are correct. 

 The database name is valid, and the user has access. 

 The versions of Cobra and Open Plan (if installed) are supported. 

 The version of SQL Server is supported. 

If any of these validations fail, the wizard displays a message, and the setup exits. 

4. Choose whether PM Compass integrates with the Microsoft Project scheduling tool. 

 

Note: Security best practice recommends not using the default SYSADMIN account (sa) for 
your SQL Server connection. 
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 If you are using Microsoft Project as a PM Compass scheduling tool, enter the UNC share 
location for the MSP Files and Process Logs folders, and click Next. 

 If you are not using Microsoft Project as a PM Compass scheduling tool, leave the UNC 
Share Path fields blank, and click Next.  

 

 

 
5. Choose whether PM Compass integrates with the Primavera P6 scheduling tool. 

 
6. If you are integrating PM Compass with Primavera P6, specify the Primavera P6 UNC share 

location where you want to store the process logs on the Primavera P6 Integration Process Logs 
UNC Share Path screen. If the location for MSPLogs is already specified, the screen may not 
display. 

Attention: To manually configure the system after the installation, see “Appendix N: 
Integrating with Microsoft Project” in this guide. 

Attention: For information about the permissions required for these folders, see “File Share 
Requirements” in this guide. 
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7. On the Shared Network Folder screen, specify the UNC share location where you want to store 

links, general export files, and MPP export files. For example, 
\\<servername>\DeltekPMCompass\. 

 
8. On the Default Files Folders screen, the wizard displays the default Links, General Export, and 

MPP Export folder locations. You can edit these locations in PM Compass after the installation 
(Administration » System Settings » File Folders tab). 

Attention: For information about the permissions required for these folders, see “File Share 
Requirements” in this guide. 
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9. On the Script Options screen, select your database script option and click Next. 

The options available on the screen depends on whether you are using a new or existing 
database. Refer to the section below that corresponds to your database. 

 
New Database 
If you have a new PM Compass database, or you are applying PM Compass for the first time to 
your Cobra or Open Plan database, your options are: 

 Automatically run scripts during the installation — creates the PM Compass tables: 
Select this option to create the PM Compass database tables automatically during 
installation. If you select this option, you do not need to run any scripts after the installation. 

 Create batch file (CreatePMCompassTables.bat) to run scripts manually: Select this 
option to create the PM Compass database tables manually after installation using a batch 
file. The batch file is named CreatePMCompassTables.bat and located in the <PM 
Compass Installation Directory>\Databases\Scripts folder. For example: C:\Program 
Files\Deltek\PMCompass\Scripts. 

 I will manually run the scripts to create the PM Compass tables. No batch file will be 
created: Select this option to manually create the PM Compass database tables after 
installation using the scripts located in the <PM Compass Installation 
Directory>\Databases\Scripts folder. For example: C:\Program 
Files\Deltek\PMCompass\Scripts. 

 

Note: The PM Compass installation does not automatically back up your database before applying 
any scripts. Make a backup of your database before selecting any of the options on this screen. 

Attention: For more information, see “Appendix G: Run Scripts Manually on a SQL 
Database” in this guide. 
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Existing Database 
If you have an existing PM Compass database, your options are: 

 Automatically run upgrade scripts during the installation: Select this option to upgrade 
the PM Compass database tables automatically during installation. If you select this option, 
you do not need to run any scripts manually after the installation. 

 Create batch file (UpgradePMCompassDB.bat) to run scripts manually: Select this 
option to upgrade the PM Compass database tables manually after installation using a batch 
file. The batch file is named UpgradePMCompassDB.bat and located in the <PM Compass 
Installation Directory>\Databases\Scripts folder. For example: C:\Program 
Files\Deltek\PMCompass\Scripts. 

 If you select this option, the wizard displays a message reminding you to run the batch file 
and pointing you to the location of the file. 

 I will manually run the upgrade scripts. No batch file will be created: Select this option to 
manually upgrade the PM Compass database tables after installation using the scripts 
located in the <PM Compass Installation Directory>\Databases\Scripts folder. For example: 
C:\Program Files\Deltek\PMCompass\Scripts. 

 
10. Click Finish. 

A message is displayed informing you that if the converted database wasn't already in Weblink, 
you may need to add a new entry for it.  

11. Click OK to continue. 

12. Click Finish. 

 

Note: Database conversion log files are saved into the <PM Compass Installation 
Directory>\Logs\ScriptLogs folder. For more information, see “Conversion Logs” in this guide  
“Troubleshooting the Installation”. 

Attention: For more information, see “Run Scripts Manually on SQL Databases” in this 
guide. 

Note: Check the log files when the installation is complete. 
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Appendix K: Configuring the Account Running 
the Services  
PM Compass should be installed using a Domain Service Account. The PM Compass server components 
will then be running under that account. If you need to create or change the user account running the PM 
Compass server components. For example, during the installation, if you are logged in as a local (non-
domain) account or you select Use Default Local Account (DeltekPMCompass) during the installation, 
and you enter a password that does not meet the server or domain password policies, the 
DeltekPMCompass local account is not created. When this happens, you will need to create the account 
manually and apply it as the credentials for the various PM Compass processes. 

 
During the installation, if you choose the option to use the default local account or did not log in with a 
domain account, the setup creates a local account and uses it to configure the initial PM Compass server 
components. This includes configuring the IIS Web server settings, creating and launching the Deltek PM 
Compass Process Server Windows service, and running PM Compass reports. 

 If there is a domain or local account policy with more stringent password requirements, the setup 
will be unable to create the account, and the PM Compass server components will need to be 
manually configured before users can launch it. If this happens, you will not be able to run 
reports. 

 If the local Deltek PM Compass account already exists and you are prompted to change the 
password during setup, but the new password does not meet the domain or local account policy 
requirements, you will see the following message: "HTTP Error 503: The service is unavailable." 
You will need to manually update the password for the account and configure the services to use 
the new password. 

 

Change the Domain Service Account Password 
Follow this procedure to manually update the password for the Domain Service Account. 

To change the password: 
1. On the server, click Compmgmt.msc » Local Users and Groups » Users and modify the 

account password. 
2. On the Web/Application and dedicated Process servers, perform the following steps for the IIS 

and Windows Services. 

Internet Information Services (IIS) 

 
a. Update the password of the Identity running DeltekPMCompassAppPool. 

Attention: For additional details on configuring accounts and enabling Windows Authentication, see 
the “Integrated Security Configuration for PM Compass” section in the Deltek PM Compass Advanced 
Administration Guide. 

Note: If you need to change the password for the Domain Service Account, see “Change the Domain 
Service Account Password” in this guide. 

Note: Perform these steps on the Web server, as Process servers do not need IIS. 
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i. Click Server Manager » Roles » Web Server (IIS) » Internet Information 
Services. 

ii. Right-click DeltekPMCompassAppPool and select Advanced Settings. 

iii. In the Process Model section, click the Identity value column and locate the 
DeltekPMCompass user. 

iv. Enter the username and password. 

v. Restart IIS. 

Windows Services 
a. Assign the DeltekPMCompass user as the Log On As for the CobraWebServices 

and the Deltek PM Compass Process Server service. 

b. Click Start » Administrative Tools » Services. 

c. Right-click CobraWebServices service and select Properties. 

d. Update the account password for the DeltekPMCompass account. 

e. Repeat these steps for the Deltek PM Compass Process Server service. 

f. Restart CobraWebServices and the Deltek PM Compass Process Server services. 

 

Change from a Non-Domain Account to a Domain Account 
During the installation, if you choose to install PM Compass with a non-domain account and later need to 
change it to a domain account, refer to Deltek KB article #66245 on the Deltek Support Center site. You 
can also find additional details in the Deltek PM Compass Advanced Administration Guide. 

Add the Account to the Local Administrators Group 
Follow this procedure to create the account (if it does not exist) and add it to the local Administrators 
group on the server. 

 

To add or update the account: 
 Set up the necessary user account and permissions. 

Note: If the user access to PM Compass requires access to domain printers and/or Windows 
Authenticated logins, you will need to use a domain account. The local account created during the 
install is not a domain account and will not have access to your domain by default. 

Note: This is the same account that you use when you configure Microsoft Project on the Process 
Servers. For more information, see “Appendix N: Integrating with Microsoft Project” in this guide. 

If possible, the account should have a static password. If it does not, each time the password is 
changed, it must be updated in all areas where you specified the password as part of the 
configuration which are: 

Windows Services 

DeltekPMCompassApplication Pool in IIS 

https://deltek.custhelp.com/app/answers/detail/a_id/66245


Appendix K: Configuring the Account Running the Services 

Installation Guide 231 

 

 Users: Click Compmgmt.msc » Local Users and Groups » Users and create the 
account. Skip this step if the account is already created. 

 Groups: Click Compmgmt.msc » Local Users and Groups » Groups and add the 
account to the Administrators group. 

Add the Account to the Report Server (SQL Server Reporting 
Web Services) 

Follow this procedure to add the account to the SQL Reporting Services home page (Report Manager 
URL). 

To add or update the account: 
1. Browse to https://YOUR REPORT SERVER NAME/Reports. 

 
2. Add the DeltekPMCompass user as a content manager. 

a. Click Folder Settings. 

b. Click New Role Assignment. 
c. Add the DeltekPMCompass user. 

d. Select the Content Manager option. 

e. Click OK. 

3. Add the DeltekPMCompass user as a System Administrator. 

a. In the upper right pane, click Site Settings. 

b. In the left pane, click Security. 

c. Click New Role Assignment. 
d. Add the DeltekPMCompass user. 

e. Select the System Administrator option. 

f. Click OK. 

Add the Account to the Web/Application and Dedicated 
Process Servers 
Follow this procedure to create the account and add it to the local Administrators group on the 
Web/Application and dedicated Process servers. 

To add or update the local users or groups account: 
1. On the Web/Application and dedicated Process servers, perform the required steps for each 

section. 

Users 
 Click Compmgmt.msc » Local Users and Groups » Users and create the account. Skip 

this step if the account is already created. 

Note: Deltek recommends right-clicking the Edge icon and selecting Run as Administrator. 
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Groups 
 Click Compmgmt.msc » Local Users and Groups » Groups and add the account to the 

IIS_IUSRS group. 

Local Security Policies 
 Click Start » Administrative Tools » Local Security Policy » Local Policies » User 

Rights Assignment, and add the account to the following groups: 

 Log on as batch job. 

 Log on as a service. 

Internet Information Services (IIS) 
1. Update the password of the Identity running DeltekPMCompassAppPool. 
2. Click Server Manager » Roles » Web Server (IIS) » Internet Information Services. 

3. Right-click DeltekPMCompassAppPool and select Advanced Settings. 

4. In the Process Model section, click the Identity value column and locate the 
DeltekPMCompass user. 

5. Enter the username and password. 

6. Restart IIS. 

Windows Services 
1. Assign the DeltekPMCompass user as the Log On As for the CobraWebServices and 

the Deltek PM Compass Process Server service. 

2. Click Start » Administrative Tools » Services. 

3. Right-click CobraWebServices service and select Properties. 

4. Update the account password for the DeltekPMCompass account. 

5. Repeat these steps for the Deltek PM Compass Process Server service. 

6. Restart CobraWebServices and the Deltek PM Compass Process Server services. 

Add the Account to Weblink 
Follow this procedure to add the account to Weblink. 

To add or update the account: 
1. Open up the Deltek PM Compass Weblink by clicking Start » All Programs » Deltek PM 

Compass » Weblink. 

2. If this is the first time you are logging into Weblink, you need to set a password. 

3. In Weblink, click the Report Server tab. 

4. Enter the password you created for the DeltekPMCompass account. 

Specify the User Account Running the Windows Service 
(Cobra Web Services) 
Follow this procedure to modify the account running the Cobra Web Services. This account is used to run 
the Windows service, write Cobra logs, and access any files that are part of the integration. 
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To modify the account running Cobra Web Services: 
1. Create a local Windows user account or identify a Domain user account that will be used to run 

the CobraWebServices service.  

For example, CobraWebServices. 

2. Add the new Windows user account or the Domain user account to the local Administrators group 
on the server. 

3. Log onto the server using the new Windows account.  

A local profile for the account is created.  

4. Click Administrative Tools » Services to launch the Windows Services Applet.  

5. Right-click the CobraWebServices service and select Properties.  

6. On the Log On tab: 

a. Select This account: to specify a user account to run the process.  

b. Enter the CobraWebServices username and password that you created.  

c. Click OK. 

 



Appendix L: Configuring Advanced Cobra Options 

Installation Guide 234 

 

Appendix L: Configuring Advanced Cobra 
Options 
This chapter provides instructions for configuring advanced options in Cobra. These settings allow you to 
customize and optimize the performance and functionality of Cobra to meet your specific needs. 

Important Note for Cobra n-Tier Users 
Cobra supports an n-tier application server mode deployment where one or more servers are utilized as 
application servers. Processing of the business logic is distributed among the application servers. All 
servers in the PM Compass deployment model are n-tier servers with each server performing and sharing 
specific functions of the application. 

The Cobra n-tier deployment does not support hosting the Cobra Web Service. If you already have the n-
tier version of Cobra deployed on the PM Compass application server, the PM Compass installation 
deploys its own Cobra Web Service using the files deployed in the <PM Compass Installation 
Folder>\CobraEngine folder (using the installer downloaded from DSM) instead of your existing Cobra 
installation. 

Cobra Multi-Project Concurrency Services with PM Compass 
Cobra leverages the PM Compass Process Server to support concurrency when running Cobra 
processes. 

 

BCR Analysis Report Snapshot Database 
In order to run the PM Compass BCR Analysis Report, you must first set up a Cobra snapshot database. 

 

Cobra Debug Log Files 
When enabled, Cobra creates debug log files that log detailed information about various Cobra 
processes. A Customer Success analyst may direct you to enable the Cobra debug logs to gather more 
information to solve an issue.  

When these logs are enabled, they are located in C:\Users\<Service Account 
Name>\Documents\Deltek\Cobra\Logs on the Web/Application or Process server.  

Attention:  
 For details about how to leverage the PM Compass Process Server to support concurrency 

when running Cobra processes, see the Deltek PM Compass and Cobra Concurrency 
Solution Setup and Configuration Guide. 

 For details on configuring the dedicated Cobra Process Server to only process the Cobra 
multiple concurrent project jobs, see “Appendix P: Configure a Dedicated Process Server” in 
this guide. 

Attention: For details about how to create a snapshot database and how to link the snapshot 
database in the Cobra Data Tool, see "Appendix K: Managing BCR Snapshot Database" of the 
Deltek Cobra Installation Guide. 
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The Cobra Web Service is installed as a Windows Services on each of your PM Compass 
Web/Application and Process servers. 

ProcessLog.xml File 
The ProcessLog.xml file provides information about what went wrong during a process. The log allows 
you to include additional details, such as SQL statements and Cobra data. For Cobra Web Service, this 
log is located in C:\Users\\Documents\Deltek\Cobra\Logs on the Web/Application or Process server. 

Debug Log File 
Sometimes, the Processlog.xml file does not provide enough information to identify the cause of an 
error. Cobra has a secondary logging mechanism called Debug logs. These logs can be enabled 
temporarily to generate detailed logs. For more information on these logging options, refer to the Cobra 
Help System. 

 

Enable the Cobra Debug Files 

Follow this procedure to enable the Cobra debug files. 

To enable the debug files: 
1. In Cobra, click the Cobra button, and navigate to Preferences » Application. 

2. On the Data Access tab, perform the following steps: 

 In the Debug Log group, select Generate processlog.xml. You have the option to include 
SQL statements or Cobra data. 

 In the Process Logs group, select Write process logs to a text file and specify a location for 
the file. 

3. Click Apply. 

4. In the Windows Services application, restart the Cobra Web Service on each of your PM 
Compass Web/Application and Process servers. 

Disable the Debug Log Files 

Follow this procedure to disable the debug log files. 

To disable the debug log files: 
1. In Cobra, click the Cobra button, and navigate to Preferences » Application. 

2. On the Data Access tab, perform the following steps: 

 In the Debug Log group, clear Generate processlog.xml. You have the option to include 
SQL statements or Cobra data. 

3. In the Process Logs group, clear the Write process logs to a text file option 

4. Click Apply. 

Note: These logging options use a lot of disk space and add performance overhead. Therefore, 
Deltek recommends enabling them only when requested by a Deltek Customer Success analyst. 
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5. In the Windows Services application, restart the Cobra Web Service on each of your PM 
Compass Web/Application and Process servers. 

Running Cobra Web Service on Multiple Servers 
If you have enabled Cobra logs, the logs are stored on the server under the profile of the account running 
the Cobra Web Service. For example, C:\Users\<accountname>\Documents\Deltek\Cobra. 

If you have configured the My Documents folder to be redirected to a network share for the account 
running the service, there is a chance that two or more servers may try to write to the same log file at the 
same time which can cause an error. 

The solution is to point “My Documents” to a local path on each server to avoid this error. 

You must restart the Cobra Web Service on each of your PM Compass Web/Application and Process 
Servers. 

Troubleshooting Cobra Integration Issues 
This section covers troubleshooting topics for Cobra integration issues. 

Verify Components 
After the PM Compass installation, you should run verify components to ensure that the Cobra integration 
is working correctly. You must have your Cobra license entered in EPM Security Administrator before 
verifying components otherwise the check will fail. 

To verify components, log into PM Compass and navigate to Administration » System Settings and 
click the Verify Components tab.  

 
If any errors are displayed, use exception tracing to identify the problem. 

Exception Tracing 
Exception tracing provides details when an error occurs. It is recommended that this be enabled in a 
development environment when you are testing new releases. If the error occurs, it will be logged, and 
you will not have to spend time recreating the error. 

Deltek offers two options to capture exception details: 

 The CobraTraces.svclog file 

 The IdeaBlade.ibconfig file 

If you encounter an error while processing a change request or accessing the Cobra Web Service, but no 
process log is generated, it is possible that there was an issue with connecting to or executing the Cobra 
Web Service. You can stop and restart the Cobra Web Service. After that, navigate to System Settings » 
Verify Components to confirm that the Cobra Web Service is functioning correctly. 

If the problem persists, consider utilizing the CobraTraces.svclog or the IdeaBlade.ibconfig file to 
capture exception details. 

Use the CobraTraces.svclog file to Capture Exception Details 

Follow this procedure to enable and disable tracing. 

Attention: For more information, see “Verify Components Tab” in the PM Compass Help System. 
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To enable tracing and send the resulting trace log to Deltek: 
1. On the PM Compass Application server, open Windows Services and look for the Cobra Web 

Service service. 

2. Stop the service. 

3. Note the location of the executable under "path to executable" and open that directory in 
Windows Explorer. 

4. Create a copy of the Cobra.WebService.Host.exe.config file. You will need this in step 11. 

5. Open the Cobra.WebService.Host.exe.config file using Notepad. 

6. Place your cursor at the end of the very first line (which is <configuration>) and press Enter to 
create a new line. 

7. Paste the lines below into the file and save the file. Make sure that the referenced directory in the 
text (highlighted below) exists on the server. 
<system.diagnostics> 

<sources> 

<source name="System.ServiceModel" 

switchValue="Information, ActivityTracing" 

propagateActivity="true"> 

<listeners> 

<add name="traceListener" 

type="System.Diagnostics.XmlWriterTraceListener" 

initializeData="E:\temp\CobraTraces.svclog" /> 

</listeners> 

</source> 

</sources> 

</system.diagnostics> 

8. Start Cobra Web Service. 

9. Reproduce the error. 

10. Stop Cobra Web Service. 

11. Replace the edited Cobra.WebService.Host.exe.config file with the copied file from step 4. 

12. Start Cobra Web Service again. 

13. Retrieve the CobraTraces.svclog file from the location in the above pasted text (step 7) and 
send it to a Deltek Customer Success analyst. 

To disable after sending the resulting trace log to Deltek: 
1. On the PM Compass Application server, open Windows Services and look for the Cobra Web 

Service service. 

2. Stop the service. 

Warning: Writing trace files may lock resources exclusively and may cause severe performance 
issues. Tracing should only be used to recreate an issue and should then be turned off. See steps 
further down to turn tracing off. 
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3. Note the location of the Executable under "path to executable" and open that directory in 
Windows Explorer. 

4. Replace the edited Cobra.WebService.Host.exe.config file with the copied version of the 
original. 

5. If you do not have the original copy, perform the following steps: 

a. Open the Cobra.WebService.Host.exe.config file using Notepad. 

b. Look for the entries that are the same as the text below (they should be at the beginning 
of the file). 

c. Place your cursor at the start of the line beginning with the first line below and select the 
contents that is the same as the lines below: 
<system.diagnostics> 

<sources> 

<source name="System.ServiceModel" 

switchValue="Information, ActivityTracing" 

propagateActivity="true"> 

<listeners> 

<add name="traceListener" 

type="System.Diagnostics.XmlWriterTraceListener" 

initializeData="E:\temp\CobraTraces.svclog" /> 

</listeners> 

</source> 

</sources> 

</system.diagnostics> 

d. Delete the selection. 

e. Save the file. 

6. Start Cobra Web Service. 

 

Use the IdeaBlade.ibconfig file to Capture Exception Details 

You can use this procedure to troubleshoot a Web Services crash, verify Cobra Web Services 
components (using the PM Compass Verify Components feature), and trace certain SQL calls. 

To view the current trace location and correct it if needed: 
1. Stop the Cobra Web Service in Windows Services (Control Panel » Administrative Tools » 

Services). 

2. Navigate to the CobraEngine folder located in the Deltek PM Compass installation folder. 

3. Create a backup of the IdeaBlade.ibconfig file and save it to a different folder. 

4. Launch Notepad as an Administrator. 

5. Using Notepad, navigate to the IdeaBlade.ibconfig.file and open it. 

Attention: For more information, see the Microsoft article Configuring Tracing. 

https://docs.microsoft.com/en-us/dotnet/framework/wcf/diagnostics/tracing/configuring-tracing
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6. Locate the <logging> section and delete the two <namespaceRejectFilter> lines. 

7. In the <logFile> section, enter “C:\<local server folder>\DebugLog.xml.”  

For example: <logFile>C:\temp\DebugLog.xml</logFile>. 

8. Save and close the file. 

9. Restart Cobra Web Service. 

10. After recreating the issue, send the file to Deltek Support and restore the original file. 

Cobra 8.7 SQL Server Certificate Errors 
If you are using Cobra 8.7 to integrate with PM Compass 8.5 on a SQL Server database, you may 
encounter SSL certificate validation errors.  

Error 1: A connection was successfully established with the server, but then an error occurred during the 
login process. (provider: SSL Provider; Error: 0 – The certificate chain was issued by an authority that is 
not trusted.) 

 
Cause 

The SQL Server database server does not have a trusted certificate. 

Workaround 

1. On the General tab of EPM Security Weblink, add the following entry in the Database Name field 
value. 
;TrustServerCertificate=True 

 
2. Restart the Cobra Web Service. 
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Error 2: A connection was successfully established with the server, but then an error occurred during the 
login process. (provider: SSL Provider, error: 0 – The target principal name is incorrect.) 

 
Cause 

The SQL Server Database certificate name is different from the server name in the data source. 

Workaround 

1. On the General tab of EPM Security Weblink, use the SQL Server Database Server name 
associated with the certificate in the data source. 

2. Restart the Cobra Web Service. 
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Appendix M: Integrating with Open Plan 
This chapter covers topics on integrating PM Compass with Open Plan. 

Unicode-Enabled, Case-Sensitive Indexes, and Unrotated 
Fields 
The Open Plan database must be Unicode-enabled and use case-insensitive (CI) indexes before 
installing PM Compass. The installer checks to see if these have been performed and, if not, it provides 
the necessary scripts (in the same location as the DeltekPMCompass<version>.exe file) and exit the 
installation. You will need to apply the scripts to your database and restart the installation. 

 
PM Compass requires the fields used to link the schedule to a control account and work package, as well 
as the fields used in the workflow, to be unrotated before they are used in PM Compass. PM Compass 
automatically unrotates these fields when they are added in User Defined Data (Area = Schedule). 
However, if your database is large, the user will be prompted to unrotate the fields using a SQL database. 
They will receive an email with the script, which they can forward to their database administrator to run. 

Database Compatibility 
If you have multiple copies of your Open Plan database that are different release versions, make sure 
that when you are doing the PM Compass installation, the database you select is the version of Open 
Plan that you will be using with PM Compass. 

Installing the Open Plan Add-In 
The Open Plan Add-In must be installed or upgraded on every Open Plan Professional client desktop or 
workstation (excluding the PM Compass server) that needs to use it. 

For a multi-user installation, the Open Plan Add-In must be installed on the file server where the Open 
Plan multi-user installation is located. 

For all other installation types (complete or Citrix, which is a complete installation), the Open Plan Add-In 
must be installed on the machine where the Open Plan client is installed. 

 

Troubleshooting Open Plan Integration Issues 
This section covers troubleshooting topics for Open Plan integration issues. 

 

Note: If you are not sure how to check your Open Plan database or need to convert it to enable 
Unicode and case-insensitive, see “Appendix H: Unicode and Case-Insensitive Prerequisites for 
Cobra and Open Plan Databases” in this guide for more information. 

Attention: To make sure that each desktop has the correct version of Open Plan installed before 
installing the PM Compass Change Request Add-In, see “Client Software Requirements” in this 
guide. 
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Verify Components 
To verify components, log into PM Compass and navigate to Administration » System Settings and 
click the Verify Components tab. If there are any errors displayed, click the hyperlinks for more 
information. 

 
If an Open Plan check fails, subsequent checks will also fail. For example, if the user login ID is missing, 
all following checks (such as this one) will fail because the system needs the user login ID to connect to 
the Integration to determine the version number and other details. If multiple checks fail, Deltek 
recommends resolving the first failed check and rerunning the verification process to see if it resolves all 
issues. 

Update the User Login ID to Connect to Open Plan 
If you are using Open Plan, the user you created in order to connect to it must have an Open Plan 
license. Follow this procedure to update the user login ID to connect to Open Plan. 

To update the user login ID: 
1. Log into Deltek EPM Security Administrator as a user with SYSADMIN rights. 

2. Click Configuration in the left navigation pane and click System Settings. 

3. In Credentials for PM Compass to connect to Open Plan, enter or edit a username and 
password that has SYSADMIN rights. 

4. Click Save. 

 

Verify the User Password 
The verification check fails if the password is invalid or if it cannot connect to the scheduling database. 
Follow this procedure confirm or correct the user password in EPM SA. 

To verify the user password: 
1. Log into Deltek EPM Security Administrator using an account with SYSADMIN privileges. 

2. In the left navigation pane, click Security and click Users. 

3. Use the Search field or the navigation arrows to locate the user that you have specified in the 
Credentials for PM Compass to connect to Open Plan field on the General tab of the System 
Settings form. 

4. On the Authentication tab, re-enter the password. 

5. Click Save. 

Attention: For more information, see “Verify Components Tab” in the PM Compass Help System. 

Attention: To assign the user to an Open Plan license in EPM SA, see “Add users to a Product” in 
this guide. 
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Open Plan Engine and Database Versions are Different 
The database selected when you started PM Compass must match the version of the Open Plan Engine 
installed on the application server. 

 

Enable Details Logs 
When Open Plan is used for the change management process or integration with Primavera P6 or 
Microsoft Project, you can configure settings to generate files with logging information. This allows you to 
view details about a failing process, which may help you resolve the issue. In Open Plan, the log file is 
named OPWIN.LOG. In PM Compass, you can name the file as desired by following this procedure. 

To enable details logs: 
1. Log into Open Plan as SYSADMIN (or a member of the SYSADMIN group). 

2. Click the product icon in the top left corner and click Preferences » Application Preferences. 

3. On the Advanced tab, click the Default button. 

4. In the System Preferences Defaults dialog box, add the following rows to the grid: 
LOGLEVEL=4 

_PMCTRACELOG = <a path and file name> 

For the path and file name, Deltek recommends using one of the paths defined in PM Compass 
» Administration » System Settings » File Folders, as the access rights should already be 
correctly set. 

5. Run the process that is failing. This generates a file in the folder indicated in the 
_PMCTRACELOG setting. 

6. To turn logging off, delete the _PMCTRACELOG row and set the LOGLEVEL to 1. 

Attention: For information about the Open Plan Engine versions and which DLL version to register 
on the server after installation is complete, see "Installing the Open Plan Add-In" in this guide and 
"Credentials for PM Compass to Connect to Open Plan Do Not Have Open Plan License" and 
"Cannot Connect to the Open Plan Engine" in the PM Compass Help System under 
Troubleshooting. 
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Appendix N: Integrating with Microsoft Project 
You can integrate your Microsoft Project Professional or Project Server scheduling system with PM 
Compass. After a .MPP file or Project Server project is associated with a PM Compass project, assignees 
and approvers can enter and approve progress directly within PM Compass. When progress has been 
submitted and approved, you can see the changes in the Schedule Analysis view. PM Compass then 
performs several steps to update the progress in the Microsoft Project file (.MPP) or Project Server 
project. 

 
PM Compass uses Open Plan server components to process the Microsoft Project .mpp files and Project 
Server integration. If you do not have  Open Plan, the PM Compass installation will install the Open Plan 
server components to manage the Microsoft Project .mpp files or the Project Server integration. 

If you do have Open Plan, run the MSPServerIntegrationForPMCompass85.exe file. You can download 
it from the PM Compass 8.5 Sub-Release DSM folder. You must run this on each of your Process Server 
and Web/Application server tiers. 

Install the Microsoft Project Integration File 
Follow this procedure to install the Microsoft Project Integration file. 

To install the Microsoft Project Integration file: 
1. Log into the server to run the installation as a Domain Service Account user.  

2. Double-click the MSPServerIntegrationForPMCompass85.exe file that you downloaded to run 
the installation.  

3. On the Welcome to the Deltek MSP Server Integration with Progressing Support PM Compass 
8.5 Installation Wizard screen, click Next. 

4. On the Database Platform screen, specify the database platform connection and click Next. 
5. The next screen depends on whether you selected Oracle or Microsoft SQL Server. See the 

section below that relates to your selected database. 

Oracle Database 
The setup process verifies the versions of the Oracle Client driver. If a supported version is detected, the 
setup proceeds. If no supported Oracle driver is found, a message is displayed indicating this, and the 
setup will exit when you click OK. To resolve this issue, install a supported version of the Oracle client 
driver and rerun the setup. 

On the Oracle Connection Information screen, enter the necessary information in the appropriate 
fields, and click Next. 
 Service name/SID: Enter the unique name of your Oracle database instance as defined in 

your tnsnames.ora file. 

 Username: Enter the Oracle user schema with rights to modify the tables in the Oracle 
database.  

 Password: Enter the password associated with the Oracle Username. 

Attention: For more information, see "Configure PM Compass for Microsoft Project Integration" in the 
PM Compass Help System. 
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Microsoft SQL Server Database 
On the Database Server (MSSQL) Setup Connection Information screen, enter the necessary 
information in the appropriate fields, and click Next. 
 Database Server: Enter the name of the Database Server and the instance. 

 Select Windows Integrated or enter the SQL Login/Password: 

 SQL Login: Enter a Microsoft SQL Database Server Login that is mapped to the 
db_owner role in the database. If you use the SQL Login and Password fields, make sure 
that server security is configured to support Mixed Mode Security. 

 
 SQL Password: Enter the password associated with this SQL Login 

 Database Name: Enter name of the database.  

6. On the Database Script Options screen, select a database script option and click Next. 

 Automatically run scripts during the installation: Select this option to apply the MSP 
Server Integration database table updates automatically during installation. If you select this 
option, you do not need to run any scripts manually after the installation. 

 Create batch file (UpdateForMSPServerIntegration.bat) to run scripts manually: Select 
this option to apply the MSP Server Integration database table updates manually after 
installation using a batch file. The batch file is named UpdateForMSPServerIntegration.bat 
and is located in the <PM Compass Installation Directory>\Databases\Scripts folder.  

For example: C:\Program Files\Deltek\PMCompass\Scripts. 

If you select this option, setup displays a message reminding you to run the batch file and 
pointing you to the location of the file. 

 I will manually run the scripts to update for MSP Server. No batch file will be created: 
Select this option to manually apply the MSP Server Integration table updates after 
installation using the appropriate batch file located in the <PM Compass Installation 
Directory>\Databases\Scripts folder. 

 If you have an Oracle database, run the RunOpenPlan81Upgrade_Oracle.bat file 
located in the <PM Compass Installation Directory>\Databases\Scripts\Oracle folder. 

 If you have a Microsoft SQL Server database, run the RunOpenPlan81Upgrade_Sql.bat 
file located in the <PM Compass Installation Directory>\Databases\Scripts|SQL folder. 

7. Click Install to begin the installation. 

8. Click Finish. 

Dedicated Process Queue 
The MSP Integration queue is a dedicated queue that processes the MSP integration jobs. It is 
automatically added to the PM Compass Process server’s list of default process queues during a 
complete or upgrade installation. Since Microsoft Project is a single-threaded application, the MSP 
integration needs to be single-threaded. This means that two integration processes cannot occur at the 
same time on the same server. If one process is running and it has an MSP file open, and another 
process tries to run on the same server, both the Process Server and MSP hang. To prevent this from 
happening, an MSP Integration queue is added to the Web/Application server. This queue has a 

Note: Deltek does not recommend using the default SYSADMIN account (sa) for your SQL 
Server connection. 
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maximum concurrent job setting of 1; only one process can run at a time. The queue does not have a 
dedicated server (you can specify one if you prefer) therefore the job runs on the next available server. 

 

Integrating with Microsoft Project Files (Not Using Project 
Server) After You Install PM Compass 
If you have installed PM Compass without choosing to integrate with Microsoft Project and now need to 
integrate, you will need to configure the MSP files and log folders from within PM Compass. 

 

Integrating with Microsoft Project Server After You Install 
PM Compass 
PM Compass uses Open Plan server components to manage the Microsoft Project .mpp files or Project 
Server integration. 

If you installed PM Compass and initially chose not to integrate with MSP, but now need to, you will have 
to download and run an integration file on your PM Compass Web/application servers and any dedicated 
Process servers. 

If you have Open Plan, run the .exe file that matches your Open Plan version. Download the 
OpenPlan<version>IntegrationForPMCompass85.exe file from the PM Compass 8.5 Sub-Release 
DSM folder and run it on each of your Process servers and the Web/Application server tiers. 

If you do not have Open Plan, run the MSPServerIntegrationForPMCompass85.exe file. Download it 
from the PM Compass 8.5 Sub-Release DSM folder and run it on each of your Process servers and 
Web/Application server tiers. 

 

Microsoft Project Server Integration 
This section covers topics on Microsoft Project Server integration. 

 

Note: Servers handling the MSP Integration queue jobs must have Microsoft Project Professional 
installed. 

Attention: For more information, see "File Folders Tab of the System Settings Form" in the PM 
Compass Help System. 

Attention: For more information, see “Project Server Integration with Progressing Support (Non-
Open Plan Users” in this guide. 

Warning: If you encounter any errors when running the Microsoft Project integration, you may need 
to modify the DCOM Config setting to specify the Windows Account used by the Process Server 
Windows service.  

For more information see "Configure Microsoft Project for Automation in DCOM" in this guide. 
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Microsoft Project Server (Project Web Application 2013, 2016) 
For PM Compass to integrate with Microsoft Project Server, you must install Microsoft Project 
Professional 2013 SP1 64-bit version with update from Nov 10, 2015 on the Application server. 

Do not install Microsoft Project Professional 2016 on the PM Compass Web/Application and Process 
servers. 

PM Compass does not support connection to Project Web Application 2019. For PM Compass to 
integrate with Microsoft Project Server, you must create accounts on the Project Web App setting menu 
by selecting the following: 

 Computer Account 

 Set as Default 

Configure the Enterprise Settings 
Follow this procedure to configure the Enterprise settings. 

To configure the Enterprise settings: 
1. Log onto your SharePoint/PWA server as the Server Admin and launch the PWA URL. 

2. When the page launches, click on the gear icon in the top right area of the window (to the left of 
the username) and select PWA Settings at the bottom of the list. 

3. In the Operational Policies section of the PWA Settings page, click Additional Server Settings. 

4. In the Enterprise Settings section of the Additional Server Settings page, select Allow projects 
to use local base calendars. 

Project Server Integration with Progressing Support (Non-Open Plan 
Users) 
If you want to enter progress into a Project Server project using PM Compass, you must download and 
run the MSP Server Integration for PM Compass integration file. The file installs the appropriate engine 
files on the PM Compass server, applies new database scripts, and upgrades tables to support the new 
feature. This file is located in DSM under the PM Compass 8.5 Sub-Release DSM folder. Until you run 
that file, you will need to use Project Web Access (PWA) to enter schedule progress. 

Sample Database 
You can use the PM Compass project titled Vessel (from the sample database) and the related sample 
.mpp file (vessel.mpp) to learn more about the MSP integration process. 

 

Attention: For more information about using the sample database with MSP integration, see “Use the 
Sample Database with MSP Integration” in this guide. 



Appendix N: Integrating with Microsoft Project 

Installation Guide 248 

 

Microsoft Project Integration and the PM Compass Process 
Server 
The Microsoft Project (Professional and Server) integration is executed using the PM Compass Process 
server. The Process server is used to schedule the running of reports, alerts, and sequence of jobs to run 
automatically and in the background.  

You can run the MSP integration process immediately or you can schedule the process to occur at a later 
date. The system uses a dedicated MSP Integration queue to process the jobs. Since Microsoft Project is 
a single-threaded application, the MSP integration needs to be single-threaded therefore this queue has a 
maximum concurrent job setting of 1; only one process can run at a time. The queue does not have a 
dedicated server (you can specify one if you prefer) therefore the job runs on the next available server. 

 
The PM Compass Process server is a Windows service installed by default during the PM Compass 
installation on any deployment option that has the Web/Application server. It can also be installed 
separately on another machine to be used as a dedicated Process server. 

Configure the PM Compass Process Server Account for MSP 
Integration 
The Windows account that runs the PM Compass Process Server Windows Service is used to perform 
the Microsoft Project integration processing. The account launches a copy of Microsoft Project installed 
on the server and performs the import/export of the .mpp files and makes the connection to the Microsoft 
Project Server. 

 
To integrate Microsoft Project and PM Compass correctly, certain configuration settings are required on 
the PM Compass Web/Application and/or dedicated Process servers. 

Configure or Edit the Windows Domain Account Running the PM 
Compass Process Server Service  
Configure the account that will be used to run the PM Compass Process Server service on each 
dedicated Process server and/or Web/Application Server (if your Web server is your Process server 
machine) with rights to the MSP files and logs folders.  

Attention:  
 For more information about the dedicated queue, see "The MSP Integration Queue in the PM 

Compass" in the PM Compass Help System under Projects » Progress » Integrate with 
Microsoft Project. 

 For more information about fully utilizing and managing the Process server, see "Process 
Server" in the PM Compass Help System under Administration. 

Note: If you plan to have multiple web servers and/or dedicated process servers, any server that is 
running the PM Compass Process Server service must have Microsoft Project Professional installed. 

If you schedule a job to a queue that is assigned to a server that does not have Microsoft Project 
Professional installed, an error will occur, and the integration will fail. In this scenario, the MSP 
Integration queue must be assigned to a server that has MSP installed. When scheduling any MSP 
integration to the process server, users must always select the MSP Integration queue. 
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To modify the account running the PM Compass Process Server Service: 
1. Create a local Windows user account or identify a Domain user account that will be used to run 

the Process Server service.  

For example, PMCompassProjectIntegration. 

2. Add the new Windows user account, or the Domain user account, to the local Administrators 
group on the machine. 

3. Log onto the machine using the new Windows account. 

A local profile for the account is created.  

4. Click Administrative Tools » Services to launch the Windows Services Applet.  

5. Right-click the Deltek PM Compass Process Server service and select Properties.  

6. On the Log On tab: 

 Select This account: to specify a user account to run the process.  

 Enter the Process Server username and password that you just created.  

 Click OK. 

 

 

Attention: For more information, see “Permissions Required for Installing PM Compass” in this 
guide. 

Note: The remaining steps are only applicable if you are using Microsoft Project Server. 



Appendix N: Integrating with Microsoft Project 

Installation Guide 250 

 

7. Launch Project Server 2013 Accounts. 

 
8. Add the user account (<DomainAccountName>) that you created in step 1, along with the URL, to 

PWA. Set the account as default. 

 
9. Launch Microsoft Project Server and open a sample project. 

Configure Microsoft Project on the Process Servers  
Certain settings in the Trust Center are required in order for the MSP integration with PM Compass to 
function correctly. 

 

To set the Trust Center settings:  
1. Log onto the Server Console as the Domain Account running the Process Server service.  

2. Install Microsoft Project Professional (64-bit).  

3. Launch Microsoft Project and let it perform the initial configuration for the account. 

4. In Microsoft Project, click the File tab. 

5. Click Options. 

6. Click Trust Center and then click Trust Center Settings. 

7. Click Macro Settings and select Disable all macros without notification. 

8. Click Legacy Formats and select Allow loading files with legacy or non-default file formats. 

9. Click OK to close the dialog box. 

Important: You must log on as the domain account running the process server service and configure 
default MSP settings on the Process servers otherwise the settings will not apply. The settings are 
user-profile specific. 
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10. Click OK to exit Project Options. 

11. Press ALT + F11 to initialize the Microsoft Visual Basic for Applications (VBA) editor. 

12. Exit project, including the VBA window. 

Configure Microsoft Project for Automation in DCOM 
Follow this procedure to configure Microsoft Project for automation in DCOM. 

To configure Microsoft Project for automation in DCOM: 
1. Log onto the Server Console as the Domain Account running the Process Server service. 

2. Launch a CMD prompt as an Administrator, or at the Run prompt type mmc to launch the 
Microsoft Management Console. 

3. Click File and select Add/Remove Snap-in… 

4. Select Component Services and click Add. 

5. Click OK. 
6. In the left pane, click on Component Services.  

7. Under Component Services, select Computers » My Computer » DCOM Config. 

8. Right-click Microsoft Project Basic and select Properties. 

9. On the Security tab: 

Launch and Activation Permissions 
a. In the Launch and Activation Permissions section, select Customize. 

b. Click Edit. 
c. In the Launch and Activation Permission dialog box, click Add.  

d. In the Select Users, Computers, Service Accounts, or Groups dialog box, enter the 
domain account you are using in the Enter the object names to select field. 

e. Click OK. 

f. In the Launch and Activation Permission dialog box, in the Group or usernames box, 
select the domain account you entered above and select Allow for each of the following 
permission settings: 

 Local Launch 
 Remote Launch 
 Local Activation 
 Remote Activation 

g. Click OK to save the changes and return to the Security tab. 

Access Permissions 
a. In the Access Permissions section, select Customize. 

b. Click Edit. 
c. In the Access Permission dialog box, click Add. 



Appendix N: Integrating with Microsoft Project 

Installation Guide 252 

 

d. In the Select Users, Computers, Service Accounts, or Groups dialog box, enter the 
domain account you are using in the Enter the object names to select field. 

e. Click OK. 

f. In the Access Permission dialog box, in the Group or usernames box, select the domain 
account you entered above, and select Allow for each of the following permission 
settings: 

 Local Access 
 Remote Access 

g. Click OK to save the changes and return to the Security tab. 

Configuration Permissions 
a. In the Configuration Permissions section, select Customize.  

b. Click Edit. 
c. In the Change Configuration Permission dialog box, click Add. 

d. In the Select Users, Computers, Service Accounts, or Groups dialog box, enter the 
domain account you are using in the Enter the object names to select field. 

e. Click OK. 

f. In the Change Configuration Permission dialog box, select the domain account you 
entered above, and select Allow for each of the following permission settings: 

 Full Control 
 Read 

g. Click OK to save the changes and return to the Security tab. 

10. On the Identity tab, in the Which account do you want to use to run this application? section, 
enable The launching user.  

11. Click OK to close the Microsoft Project Basic Properties dialog box. 

12. Exit the Microsoft Management Console. 

13. Click No when the system asks if you want to “Save console settings to Console1?” 

14. Restart the machine. 

Create the MSP Files and Log Folders and Configure the 
Security Settings 
Two folders are required for integration. In this guide, they will be referred to as the MSP Files and log 
folders. However, you can name them anything you like, as long as they are accessible to the account 
running the process server service and are located within the same local area network. 

The MSP Files folder is required for MS Project Professional. The log folder is required by both MS 
Project Professional and MS Project Server.  

To configure the security settings for sharing the MSP files and folders: 
1. Create the following folders: 

 A folder (for example, MSP Files) to store your Microsoft Project files that will be used for the 
PM Compass integration.  
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 A folder (for example, MSP Logs) to store the logs generated when the application processes 
the Microsoft Project files.  

These can be located anywhere that the account running the PM Compass Process Server 
service and the PM Compass Application Pool on the Web/Application server can access.  

2. Create a network share for the MSP Files and log folders.  

3. Grant write permissions to the folders for the Windows Domain Account running the Process 
Server service. 

4. Grant read permissions to the shared folder(s) for your authorized Users.  

In addition, the following NTFS permissions will automatically be added to the folder for the users:  

 Read & Execute 
 List Folder Contents 
 Read 

Add or Edit the MSP Integration Folder UNC Paths 
During the PM Compass installation, you can add the path to the network folders containing the .mpp files 
and log files used by the Microsoft Project integration. If you do not enter this information during the 
installation, or if you need to edit the path, follow the procedures in this section to manually add or edit the 
paths. 

Add or Edit the Default Location for Project Professional .MPP Files 
Follow this procedure to add or edit the MSP integration folder path. 

To add or edit the MSP integration folder UNC path: 
1. In PM Compass, click Administration » System Settings. 

2. Click the Microsoft Project tab. 

3. In the Microsoft Project (.MPP) Files field, enter or edit the path to the network folder containing 
the .MPP files.  

This folder must be shared a shared folder.  

 
4. Click Save. 

Add or Edit the Integration Process Logs Path 
Follow this procedure to add or edit the MSP integration process log path. 

To add or edit the MSP integration process log path: 
1. In PM Compass, click Administration » System Settings. 

2. Click the File Folders tab. 

3. In the Integration Process Logs field, enter or edit the path to the network folder containing the 
log files. 

Attention: For more information, see “UNC Shared Folders” in this guide. 
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This folder must be shared a shared folder. 

 
4. Click Save. 

Using a “Warm Up” Script to Address Long Project Server 
Startup Time 
Project Server is deeply integrated with Microsoft’s Sharepoint technology. One issue with this technology 
is that the first request to Sharepoint on any given day can take minutes to “warm up.” This problem 
affects Project Server and the integration with PM Compass which is directly affected by the performance 
of the Project Server web application.  

PM Compass uses the Microsoft Project client to open Project Server projects. When the PWA server is 
not responsive and takes several minutes to “warm up,” it can cause failures when integrating PM 
Compass with Project Server. This in turn can cause all subsequent attempts at integrating projects in PM 
Compass to fail until the Microsoft Project process has been halted, and the PWA profile has been 
recreated on the PM Compass application server. 

To alleviate the “warm up” problem, the Sharepoint community has created a “warm-up” script which you 
can execute as a Scheduled Windows Task. 

The warmup script is fully supported by a community on CodePlex. It can be downloaded here: 
http://spbestwarmup.codeplex.com/. The support for Project Server was added on 1/26/2016 and has not 
been officially published as a stable build, however you can download the newly added functionality for 
Project Server through the Source Files tab. At the time of this writing, you must specify the –
ProjectServer command when executing the script to enable Project Server support.  

Use A Warmup Script 
Follow this procedure to run a warmup script. 

To use the warmup script: 
1. Grant the appropriate rights to the logged in user. 

Deltek recommends using the same account used to run Process Server service to execute 
Sharepoint PowerShell commands. This is detailed on the CodePlex site. However, you can 
simply execute this PowerShell command to add rights to the user:  
foreach($db in Get-SPContentDatabase){Add-SPShellAdmin –Username <domain 
name>\<username> -Database $db.id}  

2. Log in as the user you granted rights to and install the script using PowerShell by running the 
following command:  
.\SPBestWarmup.ps1 -Install 

3. Test the script by running the following command from PowerShell:  
.\SPBestWarmup.ps1 –ProjectServer. 

4. Edit the scheduled task in Task Scheduler by editing the action and adding the  
–ProjectServer command to the existing action.  

This step may be only required until the Project Server functionality is officially added to the 
script.  

Attention: For more information, see “UNC Shared Folders” in this guide. 

http://spbestwarmup.codeplex.com/
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The argument text should read something similar to: 
-ExecutionPolicy Bypass "C:\Sharepoint\SPBestWarmUp.ps1 -ProjectServer" 

The script will execute every hour on the hour starting at 1am by default. This is generally the 
best setting; however, the Administrator can change the settings if needed.  

Configuring PM Compass for the MSP Integration 
After you have configured the Domain Account, MSP folders, and MSP on the Process servers, complete 
the configuration using EPM SA and PM Compass and begin the integration. 

Configure the EPM SA Credentials for PM Compass Integration 
In order for PM Compass to apply changes and run processes, such as time analysis, for projects being 
managed by PM Compass, a username and password is needed in EPM SA. This login information is 
only used for processing purposes and is not used for access control. 

 

To configure the EPM SA credentials: 
1. In EPM SA, click Configuration » System Settings. 

2. On the General tab, in the Credentials for PM Compass to connect to Open Plan group, note the 
Username and Password. 

Note: These credentials are needed whether or not you use Open Plan as your scheduling tool since 
PM Compass uses Open Plan functionality for all schedule changes and processes. 

If you do not have Open Plan, PM Compass automatically populates the username and password in 
EPM SA during installation. In this case, do not remove or edit the data in these fields as this will 
break the integration. 
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Configure the Project Server Credentials for PM Compass Integration 
If you are integrating with Microsoft Project Server, you must configure PM Compass with details for 
connecting to your Project Web Application (PWA) server. PM Compass uses this machine to look up 
project lists and details. The steps below are for entering the Project Server Credentials for the PM 
Compass Integration so that PM Compass is able to login into Microsoft’s PWA application. 

To configure the Project Server credentials: 
1. Log into PM Compass and navigate to Administration » System Settings. 

2. On the Microsoft Project tab, enter the necessary information in the appropriate fields. 

 Project Server URL: Enter or edit the UNC path for the location of the Project Server. 

 Domain\Username: Enter or edit the Project Server domain and username in the following 
format: domain\username. The username that you specify must be a domain account and a 
member of one of the following Project Web App (PWA) groups: 

 Administrators group 

 Project Managers group 

In addition, Deltek strongly recommends using the same user account for both starting up the 
Process server and the tasks specified here. This account is used to retrieve the list of projects 
that can be associated with the PM Compass project in Project Details. Using a different account 
for running the Process server may lead to inconsistent results, such as being able to view the 
project in Project Details but not being able to perform an import. 

This user is not necessarily the same as the logged-in PM Compass user. The PM Compass user 
can view all Project Server projects within PM Compass and does not need any access rights to 
PWA to see the scheduled projects 

3. Save the changes. 

Configure Microsoft Project in PM Compass 
There are several steps required to configure Microsoft Project in PM Compass.  

 

Troubleshooting Microsoft Project Integration Issues 
This section covers troubleshooting topics for Microsoft integration issues. 

Use Tracing to Capture Exception Details 
For troubleshooting integration, Deltek provides the capability to enable a trace flag to capture exception 
details.  

The tables below outline the steps to: 

 Confirm whether the trace log is enabled: Use these steps to check if the trace log is already 
enabled. 

 Enable the trace log: If the trace log is not enabled, follow these steps to enable it. 

Attention: For more information, see "Configure Progress for Microsoft Project" in the PM Compass 
Help System under Integration with Other Products » Microsoft Project Integration. 
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 Disable the trace log: After recreating the problem and capturing the logs, disable the trace log 
to prevent it from consuming disk space and impacting performance. 

Open Plan Users: Use Tracing to Capture Exception Details 

Follow these procedures to capture exception details by using tracing. 

Confirm Whether the Trace Log is Enabled 

To see the current trace location and correct it if needed: 
1. Log into Open Plan as a member of the SYSADMIN group. 

2. Click Tools » Options » Advanced.  

3. Click Defaults.  

4. Locate _PMCTRACELOG which includes the folder location. If this category is not listed, then 
trace is not enabled.  

5. If it is listed and the location is incorrect, you can edit the path in the Default Value column. 

 

Enable Tracing and Send Logs to Deltek  

To turn the trace log on: 
1. Log into Open Plan as a member of the SYSADMIN group. 

2. Click Tools » Options » Advanced.  

3. Click Defaults.  

4. In the Category column, double-click an empty line and enter _PMCTRACELOG. 

5. In the Default Value column, enter the path to the folder. Deltek recommends using the 
following path: \\<server>\<path to logs folder>\PMCTraceLog.log. The value must point to 
a valid location on the PM Compass Process Server. You can find the path to the logs folder in 
PM Compass (on the File Folders tab in Administration » System Settings). 

6. Click OK. 

7. Restart the Process server. 

8. Run the integration that was causing you problems. 

9. Send the logs to Deltek Customer Success. 

10. After you have run the trace and the logs have been created, Deltek recommends that you turn 
the trace log off because it will cause performance issues and use up disk space. See the next 
table for steps. 

 

Disable Tracing 

To turn the trace log off: 
1. Log into Open Plan. 
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Disable Tracing 
2. Click Tools » Options » Advanced.  

3. Click Defaults.  

4. Locate _PMCTRACELOG. 

5. Highlight the value in the Default Value column and delete it. 

6. Click OK. 

Non-Open Plan Users: Use Tracing to Capture Exception Details 

Follow these procedures to capture exception details and submit the information to Deltek Support. 

 

Confirm Whether the Trace Log is Enabled 

To see the current trace location and correct it if needed: 
1. Enter the following query to determine if the PMC Trace Log is enabled and click Execute: 

SELECT * from WST_UPD WHERE PRD_UID = '100' AND CATEGORY = '_PMCTRACELOG'; 

If you copy and paste the statement, first copy it into Notepad to remove any extra formatting 
(for example, curly quotes) before pasting into the SQL Statement box. 

2. If a record exists, review the query results and verify that the CAT_VALUE points to a valid 
location.  

If the record does not exist, this means that tracing is not enabled. See the next table for steps 
to enable tracing. 

 

Enable Tracing and Send Logs to Deltek  

To enable tracing and send logs to Deltek if the record does not exist: 
1. Enter the following query and click Execute (replace the value for: 

\\<PathToMSPLogFilesFolder>\PMCTRACELOG.log): 
INSERT INTO WST_UPD (CAT_VALUE, CATEGORY, PRD_UID) 
VALUES('<PathToMSPLogFilesFolder>\PMCTRACELOG.log’,'_PMCTRACELOG',100); 

For example:  
INSERT INTO WST_UPD (CAT_VALUE, CATEGORY, PRD_UID) 
VALUES('\\FileServer1\MSPLogFiles\PMCTRACELOG.log','_PMCTRACELOG',100); 

2. For Oracle users only: Issue a commit command to save the changes: 
Commit; 

3. Restart the Process server. 

4. Recreate the issue by performing the Change Management integration in PM Compass. 

5. Email the PMCTRACELOG.log file to Deltek Customer Success. 

Important: A Database Administrator must perform these procedures using a database query tool 
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Enable Tracing and Send Logs to Deltek  
6. Review the steps in the next table to disable the trace log. If you leave it enabled, it will cause 

performance issues and use up disk space.  

To enable tracing and send logs to Deltek, if the record exists but the CAT_VALUE is incorrect: 
1. Enter the following query and click Execute (replace the value for: 

\\<PathToMSPLogFilesFolder>\PMCTRACELOG.log): 

UPDATE WST_UPD SET CAT_VALUE = 
'<PathToMSPLogFilesFolder>\PMCTRACELOG.log’ WHERE PRD_UID = '100' AND 
CATEGORY = '_PMCTRACELOG'; 

For example:  
UPDATE dbo.WST_UPD SET CAT_VALUE = 
'\\FileServer1\MSPLogFiles\PMCTRACELOG.log'; 

2. For Oracle users only:  Issue a commit to save the changes. 
Commit; 

3. Restart the Process server. 

4. Recreate the issue by performing the Change Management integration in PM Compass. 

5. Email the PMCTRACELOG.log file to Deltek Customer Success. 

6. Review the steps in the next table to disable the trace log. If you leave it enabled, it will cause 
performance issues and use up disk space.  

 

Disable Tracing 

Enter the following query and click Execute: 
DELETE FROM WST_UPD WHERE PRD_UID = '100' AND CATEGORY = '_PMCTRACELOG'; 

Viewing Data that was Exported to MSP 
If you have a copy of Open Plan and you want to review the data that was exported to Microsoft Project 
Professional or Server, you can add a setting to the Open Plan System Preferences dialog box so that 
Open Plan creates .csv integration files. The files are saved to the Integration Progress Logs folder that 
you set up on the File Folders tab of the System Settings form. 

The generated .csv files remain in the folder until you delete them (disabling the setting does not delete 
accumulated files). You may want to periodically delete them to keep the folder size from becoming too 
large.  

Specify that Open Plan Creates a .csv Integration File 

Follow this procedure to specify that Open Plan creates a .csv integration file 

To specify that Open Plan creates a .csv integration file: 

1. In Open Plan, click  » File » Preferences » Application to display the Options dialog box. 

2. On the Advanced tab, click Defaults to display the System Preferences Defaults dialog box. 
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3. In the Category column, enter _KEEP_MSP_OUTPUT_FILES in a blank row. 

4. In the Default Value column, enter 1. 

5. Click OK. 

Password-Protected Microsoft Project File 
PM Compass does not support saving changes back to a password-protected Microsoft Project file. 

MSP-Related Errors Displayed in PM Compass 
This table lists MSP-related errors displayed in PM Compass. 

Issue or Error Message Solution 

CAM_SYSTEMSETTINGS.MSPFILEPATH 
has not been set or path does not exist. 

To resolve the issue: 
1. Ensure that the path entered for the MSP 

Project files and log files is valid and that the 
account running the services has the necessary 
permissions. 

To check the path, run the following query 
against your database: 
Select MSPFilePath, MSPLogPath from 
CAM_SystemSettings; 

 
2. If the path is correct, then check that the account 

running the services has the necessary 
permissions. 

Import failed with one of the following errors 
displayed in the Process Queue Detail 
dialog box » Termination Message: 

 RPC_E_SERVERFAULT 

 HRESULT E_FAIL 

This issue is usually encountered when: 

 The Process server is turned off.  

 The Microsoft Project Server is 
turned off or does not respond in a 
timely manner. 

 There is an invalid URL in the 
Project Web App account. 

To resolve this issue: 

1. Confirm that the URL in the Project Web App 
account is correct.  

 
2. Log into the Process Server as the Project 

Server account user. 

3. Terminate the WINPROJ.EXE session using 
Task Manager. 

4. If you open the Project Web App (PWA) 
accounts or Microsoft Project Professional on 
the PM Compass Web/Application or the 

Note: If there is no entry or the existing 
entry is incorrect, see “Add or Edit the 
MSP Integration Folder UNC Paths” in 
this guide. 

Attention: For more information, see 
“Configure PM Compass Process Server 
Account for MSP Integration” in this guide. 
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Issue or Error Message Solution 
Process server and you see an error message 
about Global Template, click OK and continue 
with the steps. 

5. Remove the existing PWA account. 

6. Add the account back again.  

7. Restart the machine. 

8. Use the “warm up” script to address long Project 
Server startup time. 

9. In PM Compass, run the import again. 

Login failed. Please check the Project 
Server settings in System Settings on the 
Microsoft Project tab. 

This issue is usually encountered when the 
Project Server URL is incorrect. 

To resolve this issue: 
1. In PM Compass, click Administration » 

System Settings. 

2. Click the Microsoft Project tab. 

3. Edit the URL in the Project Server URL field. 

4. Click Save. 

Your job has failed and the Termination 
Message is as follows: 

Class: interop.wpelib30.IWDEDataSource 

Function: SetTraceLogFileInfo 

FrameworkException: A disk error occurred 
during a write operation. (Exception from 
HRESULT: 0x8003001D 
(STG_E_WRITEFAULT)) 

This issue is usually encountered when 
tracing is enabled, and the PM Compass 
Process server does not have access to the 
folder location. 

To resolve the issue: 
 Do one of the following: 

 Disable the trace log. 

 Verify that the folder exists and is in a 
valid location on the PM Compass 
Process server. 

 

Password incorrect (or was changed) 

Exception from HRESULT: 0x8004F234 

To resolve this issue: 
 Log into EPM SA and re-enter the 

password. 

Exception from HRESULT: 0x80041ABF 

This issue is usually encountered when the 
version of Open Plan is not compatible with 
PM Compass or the Open Plan engine 
version is not compatible with the database. 

If you upgrade Open Plan after you install PM Compass 
8.5, see “Installing the Open Plan Add-In” in this guide. 

If you saved a custom view as the default 
for a project that is used for integration, it 
causes the service to hang and prevents 

To resolve this issue: 
1. Log into the Process server as the Project 

Server account user. 

Attention: For more information, see Use 
Tracing to Capture Exception Details in this 
guide. 
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Issue or Error Message Solution 
the project from being loaded into PM 
Compass. 

2. Terminate the WINPROJ.EXE session using 
Task Manager.  

3. Log out from the Process server. 

4. Open the .MPP file in Microsoft Project from any 
computer. 

5. On the Task command tab, click Gantt Chart. 
6. On the Gantt Chart field, select a view from the 

Built-In section, for example, Gantt Chart. 

7. Save the project. 

Activity % Complete is Incorrect 
If you are using Microsoft Project as your scheduling tool, one reason that your Activity % Complete 
may be incorrect is if you have the Updating Task status updates resource status option (Options » 
Schedule) checked in Microsoft Project. 

If you plan to update your resources, Deltek recommends clearing the Updating Task status updates 
resource status option. By default, this option is selected. 

When progress is submitted, PM Compass updates task data first followed by resource assignment data. 
When the option in Microsoft Project is selected and you edit resource assignment data in PM Compass 
and submit progress, the resource data (Resource % Complete) overwrites the task data (Activity % 
Complete).  

For example, if you enter 15% for task status and 30% for resource assignments, when progress is 
submitted, PM Compass overwrites the Activity % Complete value (15%) with the Resource % 
Complete value (30%). When the data is imported back into PM Compass, the task status is imported as 
30%.  

If you have a copy of Open Plan and you want to review the data that was exported to Microsoft Project 
Professional or Server, you can add a setting (_KEEP_MSP_OUTPUT_FILES) to the Open Plan System 
Preferences dialog box so that Open Plan creates temporary CSV integration files.  

 
Attention: For more information, see “Viewing Data that was Exported to MSP” in this guide. 
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Appendix O: Integrating with Primavera P6 
This chapter covers topics on integrating PM Compass with Primavera P6. 

Primavera P6 Schedule Integration 
PM Compass integrates with Primavera P6 to facilitate the entry and approval of schedule progress. This 
feature enables multiple users to input and approve schedule updates, which are then automatically 
synchronized with the P6 project through a scheduled, user-free process. 

During the installation of PM Compass, you can choose to use Primavera P6 as your scheduling tool. 
This selection configures the database with the necessary settings to support Primavera P6 integration. 

Benefits of Integrating Primavera P6 with PM Compass  
Integrating Primavera P6 with PM Compass offers a seamless and efficient way to manage project 
schedules. 

 The CAM or project manager can view and report schedule data in PM Compass related to their 
work.  

 You can identify users to enter and approve progress in PM Compass, and set scheduled alerts 
to create progress entries and send notifications, informing users that they need to enter or 
approve progress.  

 You can run schedule and resource traceability reports to help ensure alignment between your 
costs and schedule, and view a bar chart of the Primavera P6 schedule from within PM Compass. 

 

Using Primavera P6 Enterprise vs. Professional 
When deciding between Primavera P6 Enterprise Project Portfolio Management (P6 EPPM) and 
Primavera P6 Professional Project Management (P6 PPM), it is important to understand their integration 
capabilities with PM Compass.  

 Primavera P6 Enterprise Project Portfolio Management (P6 EPPM) requires installation of the 
P6 EPPM system to utilize web services, which are essential for integration with PM Compass.  

 Primavera P6 Professional Project Management (P6 PPM), on the other hand, does not 
support integration with PM Compass due to the absence of P6 Web Services.  

If you are currently using P6 PPM and want to integrate with PM Compass, you will need to upgrade to 
the Enterprise edition and migrate your database accordingly. Simply attaching your Professional 
database to the Enterprise Server is not sufficient. For assistance, contact Oracle Primavera Customer 
Care. 

Dedicated Process Queue 
The Primavera P6 Integration queue is a dedicated queue that processes the Primavera P6 integration 
jobs. It is automatically added to the PM Compass Process server’s list of default process queues during 
a complete or upgrade installation.  

Attention: For more information about Primavera P6 integration, including configuring PM Compass 
for the integration, see "Integrating with Oracle Primavera P6" in the PM Compass Help System 
under Integration with Other Products » Oracle Primavera P6 Integration. 
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Having a dedicated queue simplifies monitoring and identifying any process failures. It also allows 
processes to run on a different server and lets you specify the number of concurrent processes. For the 
Primavera P6 integration queue, the default and recommended maximum number of concurrent 
processes is set to 5. If you encounter connectivity issues with Primavera P6 integration processes, 
consider reducing this number. 

Servers that process the P6 Integration queue jobs must be able to connect to the P6 server's URL for 
web services at: http://<servername>:8206/p6ws.  

Integrating with Primavera P6 Server After You Install PM 
Compass 
PM Compass uses Open Plan server components to manage the Primavera P6 web service integration. 

If you installed PM Compass and initially chose not to integrate with Primavera P6, but now need to, you 
will have to download and run an integration file on your PM Compass Web/Application servers and any 
dedicated Process servers. 

If you have Open Plan, run the .exe file that matches your Open Plan version. Download the 
OpenPlan<version>IntegrationForPMCompass85.exe file from the PM Compass 8.5 Sub-Release 
DSM folder and run it on each of your Process server and Web/Application server tiers. 

If you do not have Open Plan, run the P6ServerIntegrationForPMCompass85.exe file. Download it from 
the PM Compass 8.5 Sub-Release DSM folder and run it on each of your Process server and 
Web/Application server tiers. To verify that the tables are the correct version to support Primavera P6 
integration, the installer must connect to your PM Compass database. Specify the connections to your 
PM Compass database. 

 

Untrusted Certificates 
If you choose to secure connections to your P6 server using HTTPS (for example, https://:8206/p6ws), 
and the certificate used to configure your Primavera P6 server is not trusted, the integration with PM 
Compass will fail. For instance, if you connect to your server using Edge and receive a message 
indicating an untrusted connection, the P6 integration will not function properly. 

Required Settings 
This section outlines the required settings required for the integration to work and the connection to be 
successful. 

Authentication Mode 
To ensure secure and proper communication between PM Compass and your Primavera P6 Server, you 
must configure the appropriate authentication mode based on your connection type.  

Note: If you decide to enable Primavera P6 integration after finishing the complete installation, the 
Primavera P6 Integration Installer will handle the necessary steps. For setups with multiple 
Web/Application servers, you will need to run the Primavera P6 Integration Installer on each server. 

Attention: For more information, see “Project Server Integration with Progressing Support (Non-
Open Plan Users” in this guide. 
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 If you are only using HTTP (not SSL) to connect to your Primavera P6 Server, you must configure 
the Primavera P6 Web Services with Cookies Authentication mode. 

 If you are using SSL (HTTPS) to connect to your Primavera P6 Server, you must configure the 
Primavera P6 Web Service with a Username Token Profile Authentication mode. 

You change these settings using the Primavera P6 Administrator Tool. Navigate to the Configurations tab 
and click Custom » <Your Primavera P6 Configuration> » Web Services » Security » 
Authentication. 

 

Message Protection Settings 
In order for the integration to work and the connection to be successful, you have to set Message 
Protection settings to the following: 

 Require Digital Signatures for Incoming Messages = False 

 Require Encryption for Incoming Messages = False 

 Encrypt Response = False 

You change these settings using the Primavera P6 Administrator Tool. Navigate to the Configurations tab 
and click Custom » <Your Primavera P6 Configuration> » Web Services » Security » Message 
Protection. 

 

Connection Information 
For the Primavera P6 integration to function properly, PM Compass requires the connection information. 

Configure the Connection Information 

Follow this procedure to configure the connection information. 
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To configure the connection information: 
1. In PM Compass, navigate to Administration » System Settings. 

2. On the Primavera P6 tab, perform the following steps: 

a. In the  Web Service URL field, enter or edit the web service URL for the Primavera P6 
connection. For example, http://<MyP6WebServer>:8206/p6ws. If you require a secure 
connection to the P6 server, an https connection is required. 

b. In the Username field, enter the Primavera P6 application username related to the 
selected database. The login identified here must have access to all projects. This is the 
login that PM Compass will use to access Primavera P6 web services when reading and 
writing to Primavera P6 projects. This user is not necessarily the same as the logged in 
PM Compass user. The PM Compass user can view all Primavera P6 projects in PM 
Compass and does not need any access rights to Primavera P6 order to see the 
schedule projects. 

c. In the Password field, enter the Primavera P6 application password related to the 
selected database. 

d. In the Database field, select the Primavera P6 database to which you want to connect. If 
this list is blank, click Get Databases to refresh the list. PM Compass uses cookies for the 
authentication type. 

e. Click the Get Databases button to refresh the list of databases in the Database field. 

f. Click the Test Connection button to check that the username and password are valid for 
the selected database. 

3. Save the changes. 

Recommended Settings 
This section outlines the recommended settings required for the integration to work and the connection to 
be successful. 

Database Connection Pool Settings 
The Primavera P6 integration supports up to 5 concurrent jobs. When submitting a large batch, a 
significant number of P6 database connections may be quickly consumed. 

Deltek recommends increasing the default values for the connection pools for each Primavera P6 
database used in the integration. There are three types of connection pools: PMR, PML, and PMT. 

 

Attention: For more information, see the following documents on the Oracle Support Site: 

 How Database Connection Pools Are Managed in P6 Web Access And Integration API (Doc 
ID 909861.1) 

 How To Change the Connection Pool Settings for P6 Web Access (Doc ID 1484704.1) 

The following Oracle help topic explains what the different values mean: 
https://docs.oracle.com/cd/E25030_01/English/Install_and_Config/Manual_Install_and_Config/helpm
ain.htm?toc.htm?51557.htm 

https://docs.oracle.com/cd/E25030_01/English/Install_and_Config/Manual_Install_and_Config/helpmain.htm?toc.htm?51557.htm
https://docs.oracle.com/cd/E25030_01/English/Install_and_Config/Manual_Install_and_Config/helpmain.htm?toc.htm?51557.htm
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Java Memory 
Increase the Java memory allocation for both the Primavera P6 Server and Primavera P6 Web Services 
on the managed server to a minimum of 4GB. 

Increase the Java Memory 

Follow this procedure to increase the P6 Server and P6 Web Services Java memory to 4GB. 

To increase the Java memory: 

1. Log into the Weblogic Console. 

2. Click Environment » Servers » P6. 

3. On the Server Start tab, click Lock & Edit. 
4. In Arguments, change Xms512m -Xmx1024m to -Xms4096m -Xmx4096m and click Save. 

5. Click Activate Changes. 

6. Click Environment » Servers » P6WebServices. 

7. On the Server Start tab, click Lock & Edit. 
8. In Arguments, change Xms512m -Xmx1024m to -Xms4096m -Xmx4096m and click Save. 

9. Click Activate Changes. 

10. Restart the P6 managed server. 

Troubleshooting Primavera P6 Integration Issues 
This section covers troubleshooting topics for Primavera P6 integration issues. 

Use Tracing to Capture Exception Details 
For troubleshooting integration, Deltek provides the capability to enable a trace flag to capture exception 
details.  

The tables below outline the steps to: 

 Confirm whether the trace log is enabled: Use these steps to check if the trace log is already 
enabled. 

 Enable the trace log: If the trace log is not enabled, follow these steps to enable it. 

 Disable the trace log: After recreating the problem and capturing the logs, disable the trace log 
to prevent it from consuming disk space and impacting performance. 

Open Plan Users: Use Tracing to Capture Exception Details 

Follow these procedures to capture exception details by using tracing. 

Confirm Whether the Trace Log is Enabled 

To see the current trace location and correct it if needed: 
1. Log into Open Plan as a member of the SYSADMIN group. 

2. Click Tools » Options » Advanced.  
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Confirm Whether the Trace Log is Enabled 
3. Click Defaults.  

4. Locate _PMCTRACELOG which includes the folder location. If this category is not listed, then 
trace is not enabled.  

5. If it is listed and the location is incorrect, you can edit the path in the Default Value column. 

 

Enable Tracing and Send Logs to Deltek  

To turn the trace log on: 
1. Log into Open Plan as a member of the SYSADMIN group. 

2. Click Tools » Options » Advanced.  

3. Click Defaults.  

4. In the Category column, double-click an empty line and enter _PMCTRACELOG. 

5. In the Default Value column, enter the path to the folder. Deltek recommends using the 
following path: \\<server>\<path to logs folder>\PMCTraceLog.log. The value must point to 
a valid location on the PM Compass Process Server. You can find the path to the logs folder in 
PM Compass (on the File Folders tab in Administration » System Settings). 

6. Click OK. 

7. Restart the Process server. 

8. Run the integration that was causing you problems. 

9. Send the logs to Deltek Customer Success. 

10. After you have run the trace and the logs have been created, Deltek recommends that you turn 
the trace log off because it will cause performance issues and use up disk space. See the next 
table for steps. 

 

Disable Tracing 

To turn the trace log off: 
1. Log into Open Plan. 

2. Click Tools » Options » Advanced.  

3. Click Defaults.  

4. Locate _PMCTRACELOG. 

5. Highlight the value in the Default Value column and delete it. 

6. Click OK. 

Non-Open Plan Users: Use Tracing to Capture Exception Details 

Follow these procedures to capture exception details and submit the information to Deltek Support. 
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Confirm Whether the Trace Log is Enabled 

To see the current trace location and correct it if needed: 
1. Enter the following query to determine if the PMC Trace Log is enabled and click Execute: 

SELECT * from WST_UPD WHERE PRD_UID = '100' AND CATEGORY = '_PMCTRACELOG'; 

If you copy and paste the statement, first copy it into Notepad to remove any extra formatting 
(for example, curly quotes) before pasting into the SQL Statement box. 

2. If a record exists, review the query results and verify that the CAT_VALUE points to a valid 
location.  

If the record does not exist, this means that tracing is not enabled. See the next table for steps 
to enable tracing. 

 

Enable Tracing and Send Logs to Deltek  

To enable tracing and send logs to Deltek if the record does not exist: 
1. Enter the following query and click Execute (replace the value for: 

\\<PathToMSPLogFilesFolder>\PMCTRACELOG.log): 
INSERT INTO WST_UPD (CAT_VALUE, CATEGORY, PRD_UID) 
VALUES('<PathToMSPLogFilesFolder>\PMCTRACELOG.log’,'_PMCTRACELOG',100); 

For example:  
INSERT INTO WST_UPD (CAT_VALUE, CATEGORY, PRD_UID) 
VALUES('\\FileServer1\MSPLogFiles\PMCTRACELOG.log','_PMCTRACELOG',100); 

2. For Oracle users only: Issue a commit command to save the changes: 
Commit; 

3. Restart the Process server. 

4. Recreate the issue by performing the Change Management integration in PM Compass. 

5. Email the PMCTRACELOG.log file to Deltek Customer Success. 

6. Review the steps in the next table to disable the trace log. If you leave it enabled, it will cause 
performance issues and use up disk space.  

To enable tracing and send logs to Deltek if the record exists but the CAT_VALUE is incorrect: 
1. Enter the following query and click Execute (replace the value for: 

\\<PathToMSPLogFilesFolder>\PMCTRACELOG.log): 

UPDATE WST_UPD SET CAT_VALUE = 
'<PathToMSPLogFilesFolder>\PMCTRACELOG.log’ WHERE PRD_UID = '100' AND 
CATEGORY = '_PMCTRACELOG'; 

For example:  
UPDATE dbo.WST_UPD SET CAT_VALUE = 
'\\FileServer1\MSPLogFiles\PMCTRACELOG.log'; 

Important: A Database Administrator must perform these procedures using a database query tool 
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Enable Tracing and Send Logs to Deltek  
2. For Oracle users only:  Issue a commit to save the changes. 

Commit; 

3. Restart the Process server. 

4. Recreate the issue by performing the Change Management integration in PM Compass. 

5. Email the PMCTRACELOG.log file to Deltek Customer Success. 

6. Review the steps in the next table to disable the trace log. If you leave it enabled, it will cause 
performance issues and use up disk space.  

 

Disable Tracing 

Enter the following query and click Execute: 
DELETE FROM WST_UPD WHERE PRD_UID = '100' AND CATEGORY = '_PMCTRACELOG'; 

Changing the Number of Batches Sent to Primavera P6 During Export 
When exporting data to Primavera, record sets are sent in batches, with a default size of 250 records. If 
you encounter connection errors, Deltek recommends increasing the number of records sent in each 
batch. 

Change the Number of Batches Sent 

Follow this procedure to change the number of batches sent to the Primavera P6 Server. 

To change the number of batches sent: 
1. In Open Plan, click File » Preferences » Application to display the Options dialog box. 

2. On the Advanced tab, click Defaults to display the System Preferences Defaults dialog box. 

3. In the Category column, enter _MAX_P6_BATCH_UPDATE_RECS in a blank row. 

4. In the Default Value column, enter a value between 250 and 500. 

5. Click OK. 

To see how many records were transferred, check the Export log file for this specific message. 
Starting activity transfer... 

Info   Sending out batch with 250 records. 

Info   Sending out batch with 250 records. 

Primavera P6 Has Trouble Connecting to the Database 
The Primavera P6 Integration queue is specifically designed to handle P6 integration jobs. By default, the 
number of concurrent processes is set to 5, which is also the recommended maximum. If you encounter 
connectivity issues with P6 integration processes, consider reducing this number. 

Servers that process the P6 Integration queue jobs must be able to connect to the P6 server's URL for 
web services at: http://<servername>:8206/p6ws. 
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Viewing Data that was Exported to Primavera P6 
If you have a copy of Open Plan and you want to review the data that was exported to Primavera P6, you 
can add a setting to the Open Plan System Preferences dialog box so that Open Plan creates .csv 
integration files. The files are saved to the Integration Progress Logs folder that you set up on the File 
Folders tab of the System Settings form. 

The generated .csv files remain in the folder until you delete them (disabling the setting does not delete 
accumulated files). You may want to periodically delete them to keep the folder size from becoming too 
large.  

Specify that Open Plan Creates a .csv Integration File 

Follow this procedure to specify that Open Plan creates a .csv integration file 

To specify that Open Plan creates a .csv integration file: 

1. In Open Plan, click  » File » Preferences » Application to display the Options dialog box. 

2. On the Advanced tab, click Defaults to display the System Preferences Defaults dialog box. 

3. In the Category column, enter _KEEP_P6_OUTPUT_FILES in a blank row. 

4. In the Default Value column, enter 1. 

5. Click OK. 
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Appendix P: Configure a Dedicated Process 
Server 
You can configure a Process server to pick and process jobs only from a specific queue defined in the 
Process Queues pane on the Servers tab of the System Settings form in EPM Security Administrator. 
This is helpful when you want to configure a Process server to handle a specific type of job. For example, 
you can assign a Process server that is dedicated to processing Cobra concurrency jobs only. This 
Process server will only pick Cobra concurrency jobs and ignore the jobs assigned to queues, such as the 
PM Compass system queues or the scheduled processes queues. 

To implement this behavior, you must update the ListenToOnlyMyQueues setting, which defaults to 
False (N), in the web.config file located in the PM Compass installation directory.  

If the ListenToOnlyMyQueues setting with a value of Y is present in the configuration file, the Process 
server will only pick jobs assigned to a queue where the current server’s name is assigned as the 
dedicated server. If the ListenToOnlyMyQueues setting is not present in the configuration file, or if its 
value is set to N, the Process server will retain its current behavior. This means that the Process server 
will pick jobs from a queue where the queue has been defined with the current server’s name as the 
dedicated server name, or where the job is assigned to a queue with no dedicated server name. 

Enable the ListenToOnlyMyQueues Setting 
Follow this procedure to enable the ListenToOnlyMyQueues setting. 

To enable this setting: 
1. Launch Notepad using the Run as Administrator command. 

2. Navigate to the <PM Compass Installation Directory>\PMCompass\Web folder. 

3. Open the web.config file. 

4. Locate ListenToOnlyMyQueues in the <appSettings> section and set the value to Y. 
<appSettings> 

<add key="OpenPlanSQLServerProviderType" value="SQLNCLI11" /> 

<add key="OpenPlanOracleProviderType" value="ORAOLEDB.Oracle.1" /> 

<add key="SqlLogDirectory" value="C:\metric" /> 

<add key="SqlLogging" value="Y" /> 

<add key="ListenToOnlyMyQueues" value="Y" /> 

</appSettings> 

In this example, server ASHV0279 would traditionally pick jobs from all queues (P6 Integration, MSP 
Integration, System Queue, and Scheduled Processes). A process server installed elsewhere would only 
pick up jobs from System Queue and Scheduled Processes. With this enhancement, server ASHV0279 
will pick and process jobs only from the MSP Integration and P6 Integration queues, and not from System 
Queue or Scheduled Processes queues. 
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Appendix Q: Performing Silent 
Installation/Uninstallation  
Silent installation and uninstallation allow you to perform the process without the wizard's prompts. 

Performing the silent installation and uninstallation comprises two steps. 

 Step 1: Creating the response file: Running the installer file with the -r parameter on a server and 
specifying every configuration setting that will be applied to every PM Compass server produces 
the response file. All configuration settings are saved at this step into the response file, which is 
subsequently automatically implemented by the installer on the new servers without user 
intervention. 

 Step 2: Running the installer: Running the installer file with the -s parameter through the 
Command Prompt enables the installer to use saved configuration settings from Step 1 and apply 
them to the additional servers. 

 
This chapter provides procedures to perform silent installation and uninstallation for new installs and 
upgrades of the following files: 

 PM Compass  

 PM Compass Cumulative Updates 

 Open Plan Add-in 

File, Executable Filename, and GUID Table 
The following table provides information on the files, their executable filenames, and their corresponding 
GUIDs.  

Refer to this table when performing the procedures provided below. For example, if you are running a 
new install of PM Compass 8.5, use the information provided for Deltek PM Compass 8.5. In the step to 
create the response file and run the installer, use DeltekPMCompass85.exe in the command. In the step 
to uninstall the file, use {76679E07-94CE-4F3B-B2AD-9B3423A08D74} in the InstallShield Installation 
Information\{<GUID}> folder. 

File Executable Filename GUID 

Deltek PM 
Compass 8.5 

DeltekPMCompass85.exe {76679E07-94CE-4F3B-
B2AD-9B3423A08D74} 

Deltek PM 
Compass 8.5 
Cumulative 
Update <version> 
(for example, 8.5 
CU01) 

DeltekPMCompass85CumulativeUpdate<version>.exe {76679E07-94CE-4F3B-
B2AD-9B3423A08D74} 

Important: During silent installation, database server information is captured and saved in the silent 
install file. Make sure the silent install file is securely stored or deleted after the silent install 
completes. 
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File Executable Filename GUID 

Deltek Open Plan 
Add-in for PM 
Compass 8.5 1 

DeltekOpenPlanAddinForPMC85.exe {1996E048-D4A3-4E98-
87A8-14894BC6E2A0} 

 

Silent Installation for New Installs 
Follow this procedure to run a silent installation for new installations. 

To perform a silent installation for new installations: 
1. Copy the installation files to a drive on the server. 

For example:  
E:\85\main\build8.5.0700.2370\ 

2. Launch the Command Prompt and select Run as administrator. 
3. Enter the following command to create the response file: 

<full path of the executable file on the server> -r -f1<full path to save the 
response file> 

For example:  
E:\85\main\build8.5.0700.2370\DeltekPMCompass85.exe -r -
f1E:\Script\Newinstall.iss 

 
4. Enter the following command to run the installer. 

<full path of the executable file on the server> -s -f1<full path to the 
response file> 

For example:  
E:\85\main\build8.5.0700.2370\DeltekPMCompass85.exe -s -
f1E:\Script\Newinstall.iss 

 
The silent installation runs and completes without wizard’s prompts. 

Silent Installation for Upgrade Installs 
Follow this procedure to run a silent installation for upgrade installs. 

Note:  
 1 You must install the Open Plan Add-in only on servers running the Open Plan client application. 

Note: The -r parameter records the configuration settings to the response file. There is no 
space between -f1 and the path of the response file. 

Note: The -s parameter installs the file. There is no space between -f1 and the path of the 
response file. 



Appendix Q: Performing Silent Installation/Uninstallation 

Installation Guide 276 

 

To perform a silent installation for upgrade installations: 
1. Copy the installation files to a drive on the server. 

For example: 
E:\85\main\build8.5.0700.2370\ 

2. Launch the Command Prompt and select Run as administrator. 
3. Enter the following command to create the response file: 

<full path of the executable file on the server> -r -f1<full path to save the 
response file> 

For example:  
E:\85\main\build8.5.0700.2370\DeltekPMCompass85.exe -r -
f1E:\Script\Upgradeinstall.iss 

 
4. Enter the following command to run the installer. 

<full path of the executable file on the server> -s -f1<full path to the 
response file> 

For example:  
E:\85\main\build8.5.0700.2370\DeltekPMCompass85.exe -s -
f1E:\Script\Upgradeinstall.iss 

 
The silent installation runs and completes without wizard’s prompts.  

Silent Uninstallation 
Follow this procedure to run a silent uninstallation. 

To perform a silent uninstallation: 
1. On the machine where the file is installed, display Windows Explorer, and navigate to the 

C:\Program Files (x86)\ folder. 

2. On the Windows Explorer toolbar, make sure Hidden Items is selected. 

3. Navigate to the InstallShield Installation Information\{<GUID}> folder and make sure the 
setup.exe file and other related files are there. 

For example, if you are uninstalling PM Compass, navigate to InstallShield Installation 
Information\{76679E07-94CE-4F3B-B2AD-9B3423A08D74}. 

Note: The -r parameter records the configuration settings to the response file. There is no 
space between -f1 and the path of the response file. 

Note: The -s parameter installs the file. There is no space between -f1 and the path of the 
response file. 
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4. Launch the Command Prompt and select Run as administrator. 
5. Enter the following command to create the response file to uninstall the file. 

“C:\Program Files (x86)\InstallShield Installation 
Information\<{GUID}>\setup.exe” -r -f1<full path to save the response 
>\Uninstall.iss 

For example:  
“C:\Program Files (x86)\InstallShield Installation Information\{76679E07-94CE-
4F3B-B2AD-9B3423A08D74}\setup.exe” -r -f1E:\Script\Uninstall.iss 

 
6. Enter the following command to uninstall the file: 

“C:\Program Files (x86)\InstallShield Installation 
Information\<{GUID}>\setup.exe” -s -f1<full path to the response 
file>\Uninstall.iss 

For example:  
“C:\Program Files (x86)\InstallShield Installation Information\{76679E07-94CE-
4F3B-B2AD-9B3423A08D74}\setup.exe” -s -f1E:\Script\Uninstall.iss 

 
The silent uninstallation runs and completes without wizard’s prompts. 

 

Important: If the \<{GUID}> folder or the setup.exe file and other related files do not exist, 
contact Deltek Customer Success. 

Note: The -r parameter records the configuration settings to the response file. There is no 
space between -f1 and the path of the response file. 

Note: The -s parameter installs the file. There is no space between -f1 and the path of the 
response file. 
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Appendix R: PPM Encryption Conversion Utility 
The PPM Encryption Conversion Utility is designed to scan a computer for all copies of installed PPM 
products and validate if the PPM products have been upgraded to compatible versions that support the 
new protocols. It also validates any configuration files and databases that are shared by the PPM 
products are eligible to be upgraded to support the new protocols.  

These validations are designed to ensure that the upgrade is only performed when all installed PPM 
products are compatible with the new protocols, which guarantees that environments with a mix of new 
PPM products and older PPM products will continue to function properly until all installed versions of PPM 
products are compatible with the new protocols. 

If configuration files and databases that are shared by PPM products are eligible to be upgraded, the 
PPM Encryption Conversion Utility performs the necessary upgrades to the configuration files and 
databases to enable the use of the new protocols. 

 

 

Upgrading from Older Versions 
When upgrading from older versions of PPM Products to new versions, PPM Products will continue to use 
the previous protocols by default to ensure compatibility with older versions of PPM Products. Therefore, 
a separate conversion process is required to upgrade existing PPM Product configuration files and data 
sources to enable the use of the new protocols.  

To support the conversion process, PPM products include a new PPM Encryption Conversion Utility 
application that is designed to perform the upgrade of existing PPM Product configuration files and data 
sources to enable the use of the new protocols. 

 

 

Run the PPM Encryption Conversion Utility  
You need to run this tool under the following conditions: 

 You have an environment with existing PPM products. 

 All PPM products have been upgraded to a version that supports the new hashing and encryption 
protocols. 

Note: The PPM Encryption Conversion Utility must be run on all computers that have PPM Product 
configuration files on them to upgrade the configuration files to support 

Note: Each PPM product is shipped with this tool (PPMEncryptionConverter.exe) and its location may 
vary per product. For more information, see the “Run the PPM Encryption Conversion Utility” section 
in this guide. 

Note: Deltek strongly recommends that you run the new PPM Encryption Conversion Utility 
application to upgrade existing PPM Product configuration files and data sources to enable the use of 
the new protocols. 

Note: New installations of PPM Products and data sources are pre-configured to use the new 
protocols by default. New installations do not need to run the PPM Encryption Conversion Utility. 
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To run the conversion utility tool: 
1. Navigate to the location of the PPM Encryption Conversion Utility.  

C:\Program Files\Deltek\EPMSA\ 

or 

On the Start menu, click Deltek PM Compass» PPM Encryption Conversion Utility. 

2. Double-click PPMEncryptionConverter.exe or click the corresponding shortcut from the Start 
menu. 

It automatically detects all installed PPM products in your machine and determines whether the 
installed products are compatible to determine if their files and databases are eligible for upgrade. 

 
3. On the first screen of the PPM Encryption Conversion Utility dialog box, click Next. 

 
4. On the second screen, select the database configuration files and data sources you need to 

upgrade. 

Selecting a configuration file in the Files grid displays all the databases in the Datasources grid 
and checks whether they can be converted. Alternatively, you can click the Check all 
datasources button to verify the status of all data sources in all of the files instead of selecting 
the files one by one. 

Note: You do not need to run the tool when all files and databases have already been converted. 

 The UserID and Password value in each data source are encrypted with AES1 protocol (the 
value starts with 000001). 

 All configuration files and data sources on the details screen are disabled and the Errors 
column displays "File/Datasource has already been converted." 

 The WST_UPD table in the database contains the _PASSWORDHASHPROTOCOL = 1 and 
_ENCRYPTIONPROTOCOL = 4 categories. 

Note: Upon launching the conversion utility, it creates the PPM Encryption Converter folder 
for the backup files in the C:\Users\<User Name>\Documents\Deltek. This folder contains 
<Backup> folders using the yyyymmdd_hhmmss name format, which refers to the date and 
time when the conversion utility is launched (for example, 20221116-194029). Each 
<Backup> folder contains the Backup sub-folder and the PPMEncryptionConverter.log (which 
is created after the conversion process). 

Note: This screen contains the Products grid, which displays all installed PPM products in 
your server. The grid is read-only. 

 The corresponding version and compatibility status of each installed product also 
display. Products with the Compatible column set to Yes indicate that they meet the 
minimum compatible version. 

 When you hover your mouse cursor over a product in the list, it displays the 
installation location of the that product. 
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If you need to add more encrypted files to convert, click Add. 

 
5. Click Process. 

 

Updated Files and Data 
PPM products use different files to store encrypted and hashed data. 

For PM Compass, the updated files are Datasources.dat, Databases.enc, and SQL Databases. 

 

Change Passwords 
After a PPM data source has been upgraded by the PPM Encryption Conversion Utility, users are 
prompted to update their password the very first time they log on to the converted data source using a 
PPM product. This is a necessary step to update the users stored password to use the new password 
protocol for storing user passwords. 

The first time the users log on to the converted data source with a PPM product, the product displays the 
Change Password dialog box to allow them to enter their existing password again or create a new 
password.  

Note: You cannot select and upgrade the configuration files and data sources of those PPM 
products that do not meet the minimum compatible version. 

Attention: Different icons display beside the available files and data sources to indicate their 
conversion status. For more information, see the “Conversion Status Icons” section of the 
Deltek PPM Encryption Conversion Utility Guide. 

Attention: PPM products have different locations (or containers) where encrypted and 
hashed data is stored. For more information, see the “Updated Files and Data” section in this 
guide. 

Note: During the conversion process, the PPM Encryption Conversion Utility creates a copy 
of the database configuration file in the Backup folder. The backup name has the 
<n>.<filename> format, where <n> represents a number starting from 1 to make the backup 
files unique (such as, 1.datasources.dat, 2.ideablade.ibconfig, and 3.databases.enc). 

It also creates a file named FileMapping.txt, which contains the mappings of both the backup 
and original files. The mapping follows the <backup file> (<original file>) format. For 
example, 1.datasources.dat (C:\Program Files (x86)\Deltek\Cobra\datasources.dat). 

After the conversion process, the WST_UPD (for all products), WST_CFG (for Cobra and 
Open Plan), and WST_UPF (for Acumen Touchstone and Open Plan) tables are updated. 

Attention: For more information, see the “Updated Files and Data” section of the Deltek PPM 
Encryption Conversion Utility Guide. 
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Data Tool 
When the Data Tool encrypted the Data Tool password using the old protocol, the password was not 
case-sensitive, and it was stored in uppercase. When users entered their password in the Data Tool 
Login dialog box, the Data Tool converted the entered password to uppercase and then compared it with 
the stored password. 

When the PPM Encryption Conversion Utility converts the stored password, it still stores the password in 
uppercase. The Data Tool now recognizes that the stored password is using the new protocol. As a 
result, it no longer converts the entered password to uppercase before comparing it to the stored 
password. 

 

Note: Users are permitted to enter their existing password again if desired. It is not necessary to 
create an entirely new password. 

Note: Users must complete the Change Password step to use the PPM product with the converted 
data source. If they choose to cancel the Change Password step, they return to the Login dialog box. 

Note: During the conversion of Cobra and Open Plan, the Data Tool password is changed to all 
uppercase characters. You should log on to the Data Tool using the prior password in uppercase. 
Deltek recommends that you change your password to the Data Tool after the encryption. 
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Appendix S: Secure Transport Layer Security 
(TLS) 
Transport Layer Security (TLS), and its predecessor, Secure Sockets Layer (SSL), are protocols that use 
cryptographic algorithms to provide secure communications between machines. Although there are 
several versions of TLS and SSL, only TLS 1.2 and TLS 1.3 are considered secure. Since TLS 1.3 is still 
relatively new and not fully implemented throughout the industry, best practices recommend using TLS 
1.2 for secure communication between machines. Using the older protocols is considered a security risk. 
The industry standard is to enable TLS 1.2 and disable TLS 1.1, 1.0, and disable SSL 3.0, 2.0, 1.0. 

For the Deltek application to communicate correctly between all tiers (Database, Application/Web, Report, 
and Client), the Operating System (OS) on all machines in the deployment must share the same TLS 
configuration. In addition, any components used by the application (the .NET Framework and database 
client drivers) must support the TLS version implemented on the OS. 

If your company implements the secure TLS by enabling TLS 1.2 and disabling the older protocols on the 
machines in your environment, ensure the following are performed: 

 The TLS configuration on all machines (servers and clients) must be the same. 

 The Operating System must support TLS 1.2. 

 
 The version of Microsoft .NET Framework in use must support TLS 1.2. 

  
 If you are using load balancing, ensure that it is configured to support the hardened TLS settings. 

 If you use Oracle, TLS 1.2 is supported with Oracle client versions supported by PM Compass. 

 If you use SQL Server, the default Microsoft OLE DB Provider only supports TLS 1.0. The 
following Microsoft drivers support TLS 1.2: 

 SQL Server Native Client 11.0 

 Microsoft OLE DB Driver  

 Microsoft OLE DB Provider for SQL Server 

 Supported on Windows 10 (Open Plan client)  

 Supported on Windows Server 2019 with this specific Windows update applied: October 
20, 2020—KB4580390 (OS Build 17763.1554) 

 

 

 

 

Attention: For more information, see https://docs.microsoft.com/en-us/security/solving-tls1-
problem#ensuring-support-for-tls-12-across-deployed-operating-systems. 

Attention: For more information, see https://docs.microsoft.com/en-
us/dotnet/framework/network-programming/tls#support-for-tls-12. 

https://docs.microsoft.com/en-us/security/solving-tls1-problem%23ensuring-support-for-tls-12-across-deployed-operating-systems
https://docs.microsoft.com/en-us/security/solving-tls1-problem%23ensuring-support-for-tls-12-across-deployed-operating-systems
https://docs.microsoft.com/en-us/dotnet/framework/network-programming/tls#support-for-tls-12
https://docs.microsoft.com/en-us/dotnet/framework/network-programming/tls#support-for-tls-12
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